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About This Document
Purpose
This document guides you through the upgrade, rollback, and troubleshooting procedures for the UltraPath and provides answers to frequently asked questions (FAQs).
Intended Audience
This document is intended for the personnel who perform the upgrade. The personnel must:
· Be familiar with the current networking and version information of related network elements (NEs).
· Be experienced in operation and maintenance (O&M).
Symbol Conventions
The symbols that may be found in this document are defined as follows:
	Symbol
	Description
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	Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.

	[image: image5.png]



	Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.
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	Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury.
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	Indicates a potentially hazardous situation which, if not avoided, could result in equipment damage, data loss, performance deterioration, or unanticipated results.
NOTICE is used to address practices not related to personal injury.
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	Calls attention to important information, best practices and tips.
NOTE is used to address information not related to personal injury, equipment damage, and environment deterioration.
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1  Before You Start
1.1  Upgrade Schemes
1.2  Version Requirements Before the Upgrade
1.3  Impact of the Upgrade
1.4  Precautions
1.1  Upgrade Schemes
1.1.1  UltraPath for AIX
UltraPath for AIX can be upgraded in two schemes(Online upgrade is recommended):
· Offline upgrade: applicable to UltraPath V100R003C00 or later.
· Online upgrade: applicable to UltraPath V100R008C20SPC100 or later.
1.1.2  UltraPath for Windows
UltraPath for Windows can be upgraded in two schemes(Online upgrade is recommended):
· Offline upgrade:
· Indirect upgrade: Uninstall UltraPath of existing version and then install that of the new version.
· Direct upgrade: Use an installation package to upgrade UltraPath directly. This schemes is applicable to UltraPath V100R005C00 or later (excluding V100R005C00SPC001).
· Online upgrade: applicable to UltraPath V100R008C00 or later.
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UltraPath for Windows does not support a direct upgrade on Itanium-based system. You need to uninstall UltraPath first and then install it after rebooting the host.
1.1.3  UltraPath for Solaris
UltraPath for Solaris can only be upgraded offline, which includes the following two schemes(Direct upgrade is recommended):
· Direct upgrading: Uninstall UltraPath of existing version and then install that of the new version.
· Indirect upgrading: Run an upgrade script to upgrade UltraPath to a later version, without the need to uninstall UltraPath of existing version.
1.1.4  UltraPath for Linux
There are two schemes(Online upgrade is recommended):
· Offline upgrade: applicable to UltraPath V100R001C00 or later.
· Online upgrade: It applies an upgrade from V100R008C00 and following versions.
1.1.5  UltraPath for vSphere
There are two schemes about UltraPath for ESXi(Online upgrade is recommended):
· Offline upgrade: applicable to UltraPath V100R008C00 or later.
· Online upgrade: It applies an upgrade from V100R008C20 (just on the ESXi5.x operating system) and V100R008C30 and following versions.
1.2  Version Requirements Before the Upgrade
1.2.1  UltraPath for AIX
Table 1-1 Version requirements before the upgrade
	Version
	Description

	V100R003C00
	Offline upgrade to this version.

	V100R005C00
	Offline upgrade to this version.

	V100R005C01
	Offline upgrade to this version.

	V100R006C00
	Offline upgrade to this version.

	V100R008C00
	Offline upgrade to this version.

	V100R008C20(Versions earlier than V100R008C20SPC100)
	Offline upgrade to this version.

	V100R008C20(V100R008C20SPC100 and later versions)
	Offline upgrade or online upgrade to this version.

	V100R008C30
	Offline upgrade or online upgrade to this version.

	V100R008C50
	Offline upgrade or online upgrade to this version.

	21.0.1
	Offline upgrade or online upgrade to this version.

	21.0.2
	Offline upgrade or online upgrade to this version.

	21.1.0
	Offline upgrade or online upgrade to this version.

	21.2.0
	Offline upgrade or online upgrade to this version.
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You must use the install.sh script contailed in the UltraPath for AIX software pack for installation and upgrade. When running the sh install.sh command to upgrade UltraPath, you will be asked whether to uninstall the earlier version of UltraPath, If you input yes, the earlier version of UltraPath will be uninstalled and the lastest version will be installed.
1.2.2  UltraPath for Windows
Table 1-2 Version requirements before the upgrade
	Version
	Description

	V100R001C00
	Indirect offline upgrade to this version.

	V100R002C00
	Indirect offline upgrade to this version.

	V100R003C00
	Indirect offline upgrade to this version.

	V100R005C00
(excluding V100R005C00SPC001)
	Offline upgrade to this version.

	V100R005C00SPC001
	Indirect offline upgrade to this version.

	V100R005C01
	Offline upgrade to this version.

	V100R006C00
	Offline upgrade to this version.

	V100R008C00
	Offline upgrade or online upgrade to this version.

	V100R008C20
	Offline upgrade or online upgrade to this version.

	V100R008C30
	Offline upgrade or online upgrade to this version.

	V100R008C50
	Offline upgrade or online upgrade to this version.

	21.0.1
	Offline upgrade or online upgrade to this version.

	21.0.2
	Offline upgrade or online upgrade to this version.

	21.1.0
	Offline upgrade or online upgrade to this version.

	21.2.0
	Offline upgrade or online upgrade to this version.


1.2.3  UltraPath for Solaris
Table 1-3 Version requirements before the upgrade
	Version
	Description

	V100R003C00
	Indirect offline upgrade to this version.

	V100R005C00
	Offline upgrade to this version.

	V100R005C01
	Offline upgrade to this version.

	V100R006C00
	Offline upgrade to this version.

	V100R008C00
	Offline upgrade to this version.

	V100R008C20
	Offline upgrade to this version.

	V100R008C30
	Offline upgrade to this version.

	V100R008C50
	Offline upgrade to this version.

	21.0.1
	Offline upgrade to this version.

	21.0.2
	Offline upgrade to this version.

	21.1.0
	Offline upgrade to this version.

	21.2.0
	Offline upgrade to this version.


1.2.4  UltraPath for Linux
Table 1-4 Version requirements before the upgrade
	Version
	Description

	V100R001C00
	Offline upgrade to this version.

	V100R002C00
	Offline upgrade to this version.

	V100R003C00
	Offline upgrade to this version.

	V100R005C00
	Offline upgrade to this version.

	V100R005C01
	Offline upgrade to this version.

	V100R006C00
	Offline upgrade to this version.

	V100R008C00
	Offline upgrade or online upgrade to this version.

	V100R008C20
	Offline upgrade or online upgrade to this version.

	V100R008C30
	Offline upgrade or online upgrade to this version.

	V100R008C50
	Offline upgrade or online upgrade to this version

	21.0.1
	Offline upgrade or online upgrade to this version.

	21.0.2
	Offline upgrade or online upgrade to this version.

	21.1.0
	Offline upgrade or online upgrade to this version.

	21.2.0
	Offline upgrade or online upgrade to this version.


1.2.5  UltraPath for vSphere
Table 1-5 Version requirements before the upgrade about UltraPath for ESXi
	Version
	Description

	V100R008C00
	Offline upgrade to this version.

	V100R008C20
	On the ESXi5.x operating system can be upgraded to this version in offline or online mode, but on the ESXi6.0 operating system can only be upgraded to this version in offline mode.

	V100R008C30
	Offline upgrade or online upgrade to this version.

	V100R008C50
	Offline upgrade or online upgrade to this version.

	21.0.1
	Offline upgrade or online upgrade to this version.

	21.0.2
	Offline upgrade or online upgrade to this version.

	21.1.0
	Offline upgrade or online upgrade to this version.

	21.2.0
	Offline upgrade or online upgrade to this version.


1.3  Impact of the Upgrade
1.3.1  UltraPath for AIX
1.3.1.2  Impact on the System During the Upgrade
If you need to perform an offline upgrade from a version to this version or an online upgrade from V100R008C20SPC100 to this version, read this chapter to learn the possible impact the upgrade may have on the system.
1.3.1.2.2  Impact on Services
The system will restart during an offline upgrade of the UltraPath. Therefore, stop services or migrate them to another server before performing an offline upgrade.
1.3.1.2.3  Impact on Network Communication
Offline Upgrade: None.
Online upgrade: None.
1.3.1.3  Impact on the System After the Upgrade
· Offline upgrade: In an upgrade from a version lower than V100R005 to the current version, if the disk before upgrading is updiskX, and LVM or VxVM is not used, you need to modify the service configuration after the upgrade to fit the new drive letter hdiskX.
· If not in SAN Boot situation, the OceanStor UltraPath for AIX upgraded from a lower version to the current version takes effect without the need to restart the operating system.
· If in SAN Boot situation, upgrade from a lower version to the current version takes effect only after the operating system is restarted.
Online upgrade: None.
1.3.2  UltraPath for Windows
1.3.2.4  Impact on the System During the Upgrade
1.3.2.4.4  Impact on Services
· When the first scheme is used, the host restarts twice. As a result, services running on the host are suspended for about ten minutes.
· If the second scheme is used, there are two scenarios. First, services running on the host are interrupted for 5 minutes when the user selects an offline upgrade. If Second, services running on the host are not interrupted when the user selects a non-disruptive upgrade.
1.3.2.4.5  Impact on Network Communication
When the host needs to be restarted, all network communications to the host are suspended for 3 minutes.
1.3.2.5  Impact on the System After the Upgrade
After the upgrade, the system loads a new kernel driver. This does not affect service running or modify the user-defined configuration file.
1.3.3  UltraPath for Solaris
1.3.3.6  Impact on the System During the Upgrade
1.3.3.6.6  Impact on Services
The system will restart during an offline upgrade of the UltraPath. Therefore, stop services or migrate them to another server before performing an offline upgrade.
1.3.3.6.7  Impact on Network Communication
When the host needs to be restarted, all links to the host will be interrupted.
1.3.3.7  Impact on the System After the Upgrade
After the upgrade, the system loads a new kernel driver. This does not affect service running or modify the user-defined configuration file.
1.3.4  UltraPath for Linux
1.3.4.8  Impact on the System During the Upgrade
1.3.4.8.8  Impact on Services
The system or UltraPath service will restart during an offline upgrade of the UltraPath. Therefore, stop services or migrate them to another server before performing an offline upgrade. The system will not restart during an online upgrade of the UltraPath. No need to stop services.
1.3.4.8.9  Impact on Network Communication
· If the host is restarted to enable UltraPath to take effect after the offline upgrade, all links to the host will be interrupted.
· If UltraPath is restarted to enable it to take effect after the offline upgrade, all links to the host will not be interrupted.
· If the system is not restarted after the online upgrade, all links to the host will not be interrupted.
1.3.4.9  Impact on the System After the Upgrade
After the upgrade, the system loads a new kernel driver. This does not affect service running or modify the user-defined configuration file.
1.3.5  UltraPath for vSphere
1.3.5.10  Impact on the System During the Upgrade
1.3.5.10.10  Impact on Services
UltraPath for ESXi:
· Offline upgrade：
An offline upgrade can be performed using the command-line interface (CLI) or scripts.
If you use the CLI to perform an offline upgrade, UltraPath will be restarted. Before performing the offline upgrade,you must stop services or migrate the services to another server.
If you use scripts to perform an offline upgrade not in SAN Boot situation, UltraPath will not be restarted.However, you must stop services because the hostd service on the host will be restarted and the services such as clone, migration, and snapshot on vCenter will be interrupted. You must upgrade vCenter in offline mode. Then multiple paths of the ESXi host can be managed.If in SAN Boot situation,you must reboot your system.
· Online upgrade:
An online upgrade will restart hostd service on the host and interrupt ongoing services like clone, migration, and snapshot on vCenter.
If the ESXi is 5.5 and the VMware ESXi 5.5, Patch Release ESXi550-201312001 (2063795) patch is not installed, vCenter VM console may fail to be accessed after the hostd service is restarted due to known issues of ESXi 5.5. An error "Unable to connect to the MKS : the operation is not allowed in the current state" is displayed. For details, see section 6.2.7 
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Checking the Pre-upgrade Environment.
UltraPath for vCenter:
During an offline upgrade:
The VMware VirtualCenter Server service must be restarted for UltraPath for vCenter 5.x
The VMware  vSphere Web Client service for vCenter 6.x must be restarted if the UltraPath for vCenter is downgrade to an older version.
The VMware  vSphere Web Client service for vCenter 6.5 must be restarted .
When the service is being restarted, the vCenter can not be used.
For scenarios where platform service controllers (PSCs) are configured externally and manage multiple vCenter servers. For vCenter 6.x, restart VMware vSphere Web Client after UltraPath for vCenter is upgraded.When the service is being restarted, the vCenter can not be used.
UltraPath for vCenter can only be upgraded offline so that UltraPath for ESXi can be upgraded online.
1.3.5.10.11  Impact on Network Communication
UltraPath for ESXi:
Use the CLI to perform an offline upgrade: The service will be stopped during the upgrade, and all communications with hosts are interrupted.
Perform an online upgrade or use scripts to perform an offline upgrade: The hostd service restarts during the upgrade, which interrupts the connections between vClient and ESXi hosts.
UltraPath for vCenter:
If you restart the vCenter service, the connection between the browser and vCenter will be interrupted, and users cannot log in to vCenter as a result.
1.3.5.11  Impact on the System After the Upgrade
UltraPath for ESXi:
Use the CLI to perform an offline upgrade: The system loads a new kernel driver. This does not affect service running or modify the user-defined configuration file.
Perform an online upgrade or use scripts to perform an offline upgrade: The upgrade does not affect system running or modify the user-defined configuration file. Output of the esxcli software vib list command displays the old UltraPath version rather than the new one.
1.4  Precautions
1.4.1  UltraPath for AIX
1.4.1.12  Data Consistency
Offline upgrade: Before an upgrade, ask the customer engineer to stop services and uninstall the file system created by Huawei storage.
Online upgrade: None.
1.4.1.13  Others
Offline upgrade:
· Query the version of UltraPath for AIX installed on the AIX operating system.
Run the lslpp -l U*.*.rte command to view the version of existing UltraPath for AIX and obtain its name. For example, run the following command:
 -bash-3.00# lslpp -l U*.*.rte  
  Fileset                      Level  State      Description          
  ----------------------------------------------------------------------------  
Path: /usr/lib/objrepos  
  UltraPath.AIX.ppc_64.rte   6.1.6.1  COMMITTED  Multipath for Array  
                                                 disk devices
· An upgrade of UltraPath for AIX is classified into two cases:
· An upgrade from a version earlier than V100R008 to this version, for example, from V100R005C01 to this version
· An upgrade from a version later than V100R008, for example, from V100R008C20 to this version
In the scenario of upgrading UltraPath for AIX from a version later than V100R008, upgraded from V100R008C00, V100R008C10 or V100R008C20 to this version, not support  SAN Boot situation, ensure that all virtual disks are set to the Defined state. Upgraded from V100R008C30 or a later version to this version, if not in SAN Boot situation, ensure that all virtual disks are set to the Defined state, if in SAN Boot situation, ensure that all virtual disks are set to the Defined state except rootvg. For details about how to set virtual disks to the Defined state, see section 2.3.1 
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Setting Virtual Disks to the Defined State.
· In the scenario of upgrading UltraPath for AIX from a version earlier than V100R008 to this version, ensure that all virtual disks are deleted. For details about how to delete virtual disks, see section 2.4.1 

REF _EN-US_TOPIC_0120429268-chtext \h
Deleting Virtual Disks.
· In the scenario of upgrading UltraPath for AIX from an earlier version to V100R008C50, ensure that the /opt directory on the server has at least 200 MB of free space, the /usr directory has at least 30 MB of free space, the /tmp directory has at least 250 MB of free space, and the / directory has at least 20 MB of free space.
· Upgrade from V100R008C00 or V100R008C20 to this version, the UltraPath will not support to be changed into SAN Boot situation by methods such as migrate rootvg or extend rootvg, etc.
-bash-3.00# df -m  
Filesystem    MB blocks    Free    %Used   Iused %Iused  Mounted on  
/dev/hd4       10752.00   1028.62   91%   135898    36% / 
/dev/hd2        3840.00   1681.39   57%    39508    10% /usr 
/dev/hd3        5120.00    991.02   81%      870     1% /tmp 
/dev/hd10opt    2176.00   1548.43   29%     3060     1% /opt
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If the free space is insufficient, run the chfs -a size=+200M /opt command to expand the capacity of the /opt directory, run the chfs -a size=+30M /usr command to expand the capacity of the /usr directory, run the chfs -a size=+250M /tmp command to expand the capacity of the /tmp directory, and the chfs -a size=+20M /command to expand the capacity of the /directory.
· Ensure that the correct UltraPath for AIX upgrade package is ready for use.
· Before upgrading UltraPath for AIX, stop all I/O applications.
· In some case, drive letters might change after the offline upgrade, back up related information for virtual disks before the upgrade, and see the related steps in section 2.5.3 

REF _EN-US_TOPIC_0120429230-chtext \h
Checking Whether Virtual Disks and Paths Remain the Same After the Upgrade to recover.
· After upgrading UltraPath for AIX, restore properties of virtual disks.
· In a cluster environment, after upgrading UltraPath for AIX, restore virtual disk reservation policies to the previous ones. For details, see the related step in section 2.2.8 

REF _EN-US_TOPIC_0120429429-chtext \h
Backing Up Information About UltraPath for AIX Before the Upgrade. In a SAN networking scenario, check whether the fc_err_recov property of the Fibre Channel HBA is fast_fail and the dyntrk property of the Fibre Channel HBA is yes. If not, change the property values. For details about how to change the property values, see the related steps in sections 2.3.2 
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Upgrading UltraPath for AIX Offline and 2.4.2 

REF _EN-US_TOPIC_0120429418-chtext \h
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Online upgrade:
· During the upgrade, do not run system commands such as cfgmgr, rmdev, rmpath, chdev, and chpath. If you executed the cfgmgr command, the new added disk can not read or write in the online upgrade process.
· Online upgrade is not recommended in a scenario where there are limited resources available (few memory resources, 100% CPU usage, or insufficient free space on disks).
· During an upgrade, do not terminate an online upgrade using kill -9 or Ctrl+C.
· Online upgrade is supported since V100R008C20SPC100 versions.
· Do not copy the UltraPath installation package to a directory that contains a space in its name, such as /home/Dad Dir/. Otherwise, the install.sh may not be executed properly.
· If UltraPath was installed on the host and the old UltraPath installation package directory still exists, do not copy the new UltraPath installation package to this directory, or you may find it difficult to distinguish the two packages.
· The new UltraPath version takes effect immediately after the upgrade. You can run a system command or UltraPath command to check the new version.
· The takeover-online environment cannot support the online upgrade.
· Online upgrade from V100R008C20 to this version, the UltraPath will not support to be changed into SAN Boot situation by methods such as migrate rootvg or extend rootvg, etc.
· Before an online upgrade for a version earlier than 21.1.0, run the upadm show path command to check the number of paths. If the number of paths exceeds 4096, contact the R&D personnel for help.
· In AIX 7.2 TL1 and later versions, if you need to reclaim thin LUNs, perform the following steps after upgrading the version earlier than 21.3.0 to the current version. Otherwise, skip the following steps.
(1) After the upgrade is complete, ask the customer engineers to stop services on the disks corresponding to thin LUNs.
(2) Reconfigure disks by using either of the following methods:
Method 1: Run the rmdev -l hdiskname command (hdiskname indicates the corresponding disk) to set the disk status to Defined, and then run the mkdev -l hdiskname command to set the disk status to Available.
Method 2: Run the rmdev -l hdiskname command to set the disk status to Defined, and then run the cfgmgr command to scan for disks.
To protect the configuration database, the preceding commands cannot be interrupted, because interrupting the commands may damage the configuration database.
1.4.2  UltraPath for Windows
1.4.2.14  Rights of an Upgrade Performer
The user who upgrades the UltraPath must have administrative permissions.
1.4.2.15  Host Restarting
· After the offline upgrade, restart the host so that UltraPath can take effect.
· It is not necessary to restart the host after the online upgrade.
· A drive letter change refers to a disk ID change after the host is restarted or the disk devices are enumerated again. The Windows system cannot prevent a drive letter (disk ID) change.After disks are formatted, a file system is established, and volumes are created, the Windows system maintains the mapping relationship between the logical volumes and drive letters (such as D, E, and F) to ensure that the drive letters are not affected by the change of disk IDs.
1.4.2.16  UltraPath Direct Upgrade
V100R003 cannot be directly upgraded to this version. Uninstall V100R003, restart the host, install this version, and restart the host.
1.4.3  UltraPath for Solaris
1.4.3.17  Rights of an Upgrade Performer
The user who upgrades the UltraPath must use user root and must be the one predefined in the system instead of being created by users.
1.4.3.18  Host Restarting
After the upgrade, restart the host so that UltraPath can take effect.
1.4.4  UltraPath for Linux
1.4.4.19  Rights of an Upgrade Performer
The user who upgrades the UltraPath must use user root.
1.4.4.20  Host Restarting
· For an offline upgrade of UltraPath in SAN Boot mode, you must restart the host to enable UltraPath to take effect.
· For an offline upgrade of UltraPath in non-SAN Boot mode, you can restart the UltraPath service to enable it to take effect instead of restarting the host.
· It is not necessary to restart the host after the online upgrade.
1.4.5  UltraPath for vSphere
1.4.5.21  Rights of an Upgrade Performer
UltraPath for ESXi:
The user who upgrades the UltraPath must use user root.
UltraPath for vCenter:
· UltraPath for vCenter 5.x :Users must use the delivery-attached administrator account to upgrade UltraPath software, instead of creating a new administrator account.
· UltraPath for vCenter 6.x deployed on Windows :Users must use the delivery-attached administrator account to upgrade UltraPath software, instead of creating a new administrator account.
· UltraPath for vCenter 6.x for VCSA 6.x :Users must use the delivery-attached root account to upgrade UltraPath software.
1.4.5.22  Host Restarting
UltraPath for ESXi:
· Offline upgrade: For the CLI-based upgrade, you must restart the host.
· For the script-based upgrade, if there is not PE LUN managed by UltraPath or in SAN Boot situation, you can upgrade UltraPath without restring the host. If not, you must restart the host.
· Online upgrade: UltraPath for ESXi takes effect immediately after the upgrade is complete.
UltraPath for vCenter:
It is not necessary to restart the host after the upgrade.
2  UltraPath for AIX Upgrade Guide
2.1  Upgrade Process Overview
2.2  Preparations for the Upgrade
2.3  Upgrading UltraPath for AIX from a version later than V100R008
2.4  Upgrading UltraPath for AIX from a version earlier than V100R008
2.5  Verifying the Upgrade
2.6  Rolling Back to the Source Version
2.7  Troubleshooting
2.1  Upgrade Process Overview
2.1.1  Upgrade Flowchart
Offline upgrade:
Figure 2-1 Flowchart of upgrading UltraPath for AIX offline
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Online upgrade:
Figure 2-2 Flowchart of upgrading UltraPath for AIX online
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2.1.2  Upgrade Steps and Time Required
Offline upgrade:
Table 2-1 Steps and time required for upgrading UltraPath for AIX offline
	No.
	Upgrade Step
	Time Required
	Impact
	Remarks

	1
	Prepare for the upgrade.
	About 20 minutes
	None
	Mandatory

	2
	Delete and set virtual disks.
	Depending on the total number of virtual disks, where 5 second is needed per virtual disk
	None
	Mandatory

	3
	Upgrade UltraPath for AIX.
	About 5 minutes
	None
	Mandatory

	4
	Restart the host.
	About 8 to 20 minutes
	None
	Optional

	5
	Verify the upgrade.
	About 5 minutes
	None
	Mandatory


Online upgrade:
Table 2-2 Steps and time required for upgrading UltraPath for AIX online
	No.
	Upgrade Step
	Time Required
	Impact
	Remarks

	1
	Perform the pre-upgrade check.
	About one minute or longer if disks are not reported.
	None
	Mandatory

	2
	Upgrade UltraPath for AIX.
	About 10 minutes. If there are a large number of disks or faults occurred during the upgrade, users are notified of the errors and are asked to confirm whether they want to continue the online upgrade.
	None
	Mandatory


2.2  Preparations for the Upgrade
2.2.1  Prerequisites
· The engineer who will perform the upgrade has experience in using AIX operating systems.
· The engineer who will perform the upgrade has logged in as user root to the AIX operating system.
· Services are stopped. For details about how to check whether services are stopped, see section 2.2.9 
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Checking the Environment Before the Upgrade.
2.2.2  Obtaining Upgrade Tools
The following table lists the tools required for upgrading UltraPath.
	Name
	Remarks

	Secure Shell (SSH)
	You can use this tool to remotely log in to the server on which you want to upgrade UltraPath.

	Secure File Transfer Protocol (SFTP) tool
	You can use this tool to upload the UltraPath software package.
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If copyright is involved, obtain tools by yourself. For details, contact Huawei technical support engineers.
2.2.3  Obtaining Upgrade Reference Documents
Table 2-3 Reference document
	Document
	Description

	OceanStor UltraPath 21.3.0 Release Notes
	Adjust the document based on site condition and deliver the document to the customer.


You can obtain the document by logging in to http://support.huawei.com/enterprise/ and choosing Support > Software Download > Cloud Storage > Tools and Platform > UltraPath.
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You must apply for the permission to obtain documentation from the website. If you are using  http://support.huawei.com/enterprise/ for the first time, first register with the website. For details, see the website and FAQs.
2.2.4  Obtaining Upgrade Software
· Log in to http://support.huawei.com/enterprise/ to obtain the UltraPath installation package.
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Log in to http://support.huawei.com/enterprise/ and choose Support > Document Center > IT > Cloud Storage > Tools and Platform > UltraPath > Downloads to obtain the installation package.
· Use a digital signature verification tool to verify the integrity of the installation package.
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To ensure the integrity of the software you obtained, use a software digital signature validation tool to verify it. To obtain the tool, log in to http://support.huawei.com/enterprise and choose Support > Tools. Search for software digital signature validation tool. Download the tool and start the verification. For details about how to verify software, see the guides released with the tool.
2.2.5  Obtaining the Version Number of UltraPath for AIX
Task Description
Obtain the version number of UltraPath for AIX in use and determine whether an upgrade is needed.
Procedure
Offline upgrade:
On the CLI, run the upadm show version command and collect the version number of UltraPath for AIX displayed in command output. Then, determine whether the UltraPath needs to be upgraded from a version earlier than V100R008 (V100R003, V100R005 or V100R006) to this version or from a version later than V100R008 to 21.3.0. If the version in the command output is 3.xx.xxx, 5.xx.xxx or 6.xx.xxx, you need to perform an upgrade from a version earlier than V100R008 to this version. If the version in the command output is 8.01.xxx, 8.03.xxx, 8.05.xxx, 8.06.xxx, 21.01.xxx, 21.02.xxx, 21.03.xxx or 21.05.xxx, you need to perform an upgrade from a version later than V100R008 to this version.You can run upadm show version verbose to query product version about V100R008C50 and later versions.
Online upgrade:
On the CLI, run the upadm show version command. Check the version displayed in the output. If the version is not newer than 8.03.028, do not perform an online upgrade.
Verification
The following are two examples:
1.   -bash-3.00# upadm show version    
Software Version : 8.06.001    
Driver Version   : 8.06.001
Refer to section 2.3 

REF _EN-US_TOPIC_0120429133-chtext \h
Upgrading UltraPath for AIX from a version later than V100R008 for details about the steps of the offline upgrade and the steps of the online upgrade.
2.   -bash-3.00# upadm show version verbose 
Software Version   : 8.06.063 
Driver   Version   : 8.06.063 
Product  Version   : V100R008C50SPC500
Refer to section 2.3 

REF _EN-US_TOPIC_0120429133-chtext \h
Upgrading UltraPath for AIX from a version later than V100R008 for details about the steps of the offline upgrade and the steps of the online upgrade.
3.   -bash-3.00# upadm show version    
Software Version : 6.01.041 
Driver Version   : 6.01.041
For details about the steps of upgrading an early version to this version offline, see section 2.4 
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Upgrading UltraPath for AIX from a version earlier than V100R008. Online upgrade can be performed to upgrade to this version only since V100R008C20SPC100.
2.2.6  Obtaining the Rollback Package
Offline upgrade:
Prepare the installation package of the UltraPath that has been installed before the upgrade. If the upgrade fails, roll back to the previous version and quickly recover services.
Online upgrade:
None.
2.2.7  Backing Up Service Information
Task Description
This section applies to an offline upgrade only.
Before stopping services, back up service-related information for service restoration after the upgrade, including information about the activated volume groups (VGs), imported disk groups (DGs), and mounted file systems.
Precautions
Back up service information with the assistance of the customer's service engineers.
Procedure
Step 1 Run the vxdisk list command and check whether the VxVM is installed.
· If command not found is displayed, the VxVM is not installed. In this case, go to step 2.
· If the command is executed successfully, the VxVM is installed. In this case, perform the following operations:
1. Run the vxdisk -e list command and save the command output, which includes the status of DGs on virtual disks and information about online virtual disks. The command output is used for service restoration after the upgrade. In the following example, DG001 and DG002 exist on virtual disks hdisk1, hdisk2, and hdisk3. Virtual disk hdisk4 is only in the online state.
bash-3.00# vxdisk -e list  
DEVICE     TYPE     DISK     GROUP     STATUS   OS_NATIVE_NAME     
Disk_0     auto      -          -        LVM        hdisk0        
Disk_1     auto     Disk_1    DG001     online      hdisk3         
Disk_2     auto     Disk_2    DG002     online      hdisk1         
Disk_3     auto     Disk_3    DG002     online      hdisk2         
Disk_4     auto      -          -       online      hdisk4        
Disk_5     auto      -          -        LVM        hdisk5
[image: image18.png]



· In the preceding command output, the DEVICE column lists the names of disks managed by the VxVM, and the OS_NATIVE_NAME column lists the corresponding names of the disks displayed on the AIX operating system.
· The GROUP column lists the names of DGs.
· hdisk0 is a local disk. hdisk5 is a virtual disk managed by the LVM.
2. Run the mount command and save the command output.
The command output lists all mounted file systems. The following is an example:
bash-3.00# mount   
  node      mounted       mounted over    vfs   date   options      
-------- ---------------  ---------------  ------ ------------ --------------- 
         /dev/hd4         /                jfs2   Nov 24 19:18 rw,log=/dev/hd8    
         /dev/hd2         /usr             jfs2   Nov 24 19:18 rw,log=/dev/hd8    
         /dev/hd9var      /var             jfs2   Nov 24 19:18 rw,log=/dev/hd8    
         /dev/hd3         /tmp             jfs2   Nov 24 19:18 rw,log=/dev/hd8    
         /dev/fwdump      /var/adm/ras/platform jfs2   Nov 24 19:18 rw,log=/dev/hd8    
         /dev/hd1         /home            jfs2   Nov 24 19:18 rw,log=/dev/hd8    
         /proc            /proc            procfs Nov 24 19:18 rw           /dev/hd10opt     /opt             jfs2   Nov 24 19:18 rw,log=/dev/hd8    
         /dev/lv00        /var/adm/csd     jfs    Nov 24 19:18 rw,log=/dev/loglv00   
         /dev/vx/dsk/DG01/LV02 /home/vxfs02     vxfs   Nov 25 14:21 rw,delaylog,suid,ioerror=mwdisable,largefiles   
         /dev/vx/dsk/DG02/LV02 /home/vxfs03     vxfs   Nov 25 14:21 rw,delaylog,suid,ioerror=mwdisable,largefiles   
         /dev/fslv00      /home/compareMountDir0 jfs2   Nov 25 14:28 rw,log=INLINE  
[image: image19.png]



Pay attention to the VxFS file systems in the preceding command output.
Step 2 Back up service information managed by the LVM.
3. Run the lspv command and save the current VG status.
The following example indicates that on virtual disks, only vg001 is activated.
bash-3.00# lspv     
hdisk0         0001fa696441ac6d                None                
hdisk1         0001f090dc830ea9                rootvg          active  
hdisk2         0001f0906c346eb8                vg001           active  
hdisk3         0001f0908c629de6                vg001           active  
hdisk4         00f6e0743a973991                datavg              
hdisk5         0001f0908d097431                datavg
4. Run the mount command and save the command output.
The command output lists all mounted file systems. The following is an example:
bash-3.00# mount    
node       mounted        mounted over    vfs       date       option -------- ---------------  ---------------  ------ ------------ -------           /dev/hd4         /                jfs2   Nov 25 11:01 rw,log=/dev/hd8             
           /dev/hd2         /usr             jfs2   Nov 25 11:01 rw,log=/dev/hd8             
           /dev/hd9var      /var             jfs2   Nov 25 11:01 rw,log=/dev/hd8              
           /dev/hd3         /tmp             jfs2   Nov 25 11:01 rw,log=/dev/hd8              
           /dev/fwdump      /var/adm/ras/platform jfs2   Nov 25 11:02 rw,log=/dev/hd8              
           /dev/hd1         /home            jfs2   Nov 25 11:02 rw,log=/dev/hd8              
           /dev/hd11admin   /admin           jfs2   Nov 25 11:02 rw,log=/dev/hd8              
           /proc            /proc            procfs Nov 25 11:02 rw              /dev/hd10opt     /opt             jfs2   Nov 25 11:02 rw,log=/dev/hd8              
           /dev/livedump    /var/adm/ras/livedump jfs2   Nov 25 11:02 rw,log=/dev/hd8              
           /dev/fslv00      /home/compareMountDir0 jfs2   Nov 25 16:06 rw,log=INLINE               
           /dev/fslv03      /home/compareMountDir3 jfs2   Nov 25 16:08 rw,log=INLINE 
----End
Verification
None.
Troubleshooting
None.
2.2.8  Backing Up Information About UltraPath for AIX Before the Upgrade
Task Description
This section applies to an offline upgrade only.
Before upgrading UltraPath for AIX, back up information about virtual disks and paths. Verify the information after the upgrade.
Precautions
None.
Procedure
Step 1 Run the lsdev -Cc disk command to distinguish between local disks and virtual disks.
bash-3.00# lsdev -Cc disk   
hdisk0  Available 04-08-01-5,0 16 Bit LVD SCSI Disk Drive         
hdisk1  Available 04-08-01-8,0 16 Bit LVD SCSI Disk Drive        
hdisk2  Available 07-08-01    Huawei S5500T FC Disk Drive        
hdisk3  Available 07-08-01    Huawei S5500T FC Disk Drive        
hdisk4  Available 07-08-01    Huawei S5500T FC Disk Drive
Disks with the Huawei S5500T string are virtual disks.
Step 2 Run the ls -l /dev/diskname and ls -l /dev/rhdiskname commands to back up the disk permission.
Where diskname indicates the disk, and rhdiskname indicates the character device related to the disk, for example:
bash-3.00# ls -l /dev/hdisk2 
brw-------1 root system 25,3 Aug 27 14:52 /dev/hdisk2 
bash-3.00# ls -l /dev/rhdisk2 
crw-------1 root system 25,3 Aug 27 14:52 /dev/rhdisk2
Step 3 Run the lspv command. Information similar to the following is displayed. Save the information.
bash-3.00# lspv    
hdisk0          0001fa696441ac6d               rootvg       active    
hdisk1          0001f090dc830ea9               None               
hdisk2          0001f0906c346eb8               datavg              
hdisk3          00f6e0743a9738c3               datavg             
hdisk4          00f6e0743a973991               datavg         
Step 4 Run the lspath command. Information similar to the following is displayed. Save the information.
· Run the lspath -F "name status path_id parent connection" command to back up information on paths:
bash-3.00# lspath -F "name status path_id parent connection" 
hdisk0 Enabled 0 scsi15,0 
hdisk1 Enabled 0 scsi18,0 
hdisk2 Enabled 0 fscsi0 20080022a10bb2d5,1000000000000 
hdisk3 Enabled 0 fscsi0 20080022a10bb2d5,2000000000000 
hdisk4 Enabled 0 fscsi0 20080022a10bb2d5,3000000000000 
hdisk2 Enabled 1 fscsi0 20090022a10bb2d5,1000000000000 
hdisk3 Enabled 1 fscsi0 20090022a10bb2d5,2000000000000 
hdisk4 Enabled 1 fscsi0 20090022a10bb2d5,3000000000000 
hdisk2 Enabled 2 fscsi0 20180022a10bb2d5,1000000000000 
hdisk3 Enabled 2 fscsi0 20180022a10bb2d5,2000000000000 
hdisk4 Enabled 2 fscsi0 20180022a10bb2d5,3000000000000 
hdisk2 Enabled 3 fscsi0 20190022a10bb2d5,1000000000000 
hdisk3 Enabled 3 fscsi0 20190022a10bb2d5,2000000000000 
hdisk4 Enabled 3 fscsi0 20190022a10bb2d5,3000000000000 
· Run the lspath -l hdiskname -p parent -w connection -a priority -F value command to back up the priority of each path.
Where hdiskname indicates the device name, parent indicates the logical device name of a path's parent device, and connection indicates information about the connection. The following is an example: In hdisk2 Enabled 0 fscsi0 20080022a10bb2d5,1000000000000, fscsi0 is parent, 20080022a10bb2d5,1000000000000 is connection. If you want to query the priority of the path, run the lspath -l hdisk2 -p fscsi0 -w 20080022a10bb2d5,1000000000000 -a priority -F value command.
-bash-3.00# lspath -l hdisk2 -p fscsi0 -w 20080022a10bb2d5,1000000000000 -a priority -F value 
1
Note: You can run the following script to collect the path information and query the priority.
#!/bin/sh 
 
Check_String="huawei|huasy|symantec|ultrapath" 
echo "name status path_id parent connection priority" 
lsdev -Cc disk | grep -E -i "$Check_String" | awk '{print $1}' | while read diskline 
do 
lspath -F "name status path_id parent connection" -l $diskline | while read pathline 
do 
parent=`echo $pathline | awk '{print $4}'` 
connection=`echo $pathline | awk '{print $5}'` 
priority=`lspath -l $diskline -p $parent -w $connection -a priority -F value` 
echo "$pathline $priority" 
done 
done
The command output is as follows:
name status path_id parent connection priority 
hdisk2 Enabled 0 fscsi0 20080022a10bb2d5,1000000000000 3 
hdisk2 Enabled 1 fscsi0 20090022a10bb2d5,1000000000000 1 
hdisk2 Enabled 2 fscsi0 20180022a10bb2d5,1000000000000 1 
hdisk2 Enabled 3 fscsi0 20190022a10bb2d5,1000000000000 1 
hdisk3 Enabled 0 fscsi0 20080022a10bb2d5,2000000000000 1 
hdisk3 Enabled 1 fscsi0 20090022a10bb2d5,2000000000000 1 
hdisk3 Enabled 2 fscsi0 20180022a10bb2d5,2000000000000 1 
hdisk3 Enabled 3 fscsi0 20190022a10bb2d5,2000000000000 1
In the command output, the last line indicates the priority of the path.
Step 5 Run the upadm show lun or upadm show vlun command. Information similar to the following is displayed. Save the information.
· Use upadm show lun for V100R005 and earlier version.
bash-3.00# upadm show lun    
-----------------------------------------------------------------------------------------------------------------    
Device Name:        Lun Name:                     Vendor ID:  Type:          Serial Number:  Device WWN:              
-----------------------------------------------------------------------------------------------------------------   
/dev/hdisk2        LUN001_10                     HUAWEI      S5300          1T50214955      6001882100552bcf000ad6a70000000d      
/dev/hdisk3        LUN001_14                     HUAWEI      S5300          1T50214955      6001882100552bcf000b027100000011      
/dev/hdisk4        LUN_4                         HUAWEI      S5300          1T50214955      6001882100552bcf0039697300000003
· Use upadm show vlun for V100R006 and later version. Command output for UltraPath V100R006 is used as an example.
bash-3.00# upadm show vlun 
--------------------------------------------------------------------------------------------------------------------------------------------------------------------- 
 Vlun ID  Host Lun ID  Disk Name  Vlun Name              Vlun WWN               Status    In Use  Capacity  Controller(Own/Work)    Array Name          Array SN        
    2          1        hdisk2     Lun_001   60022A11000BB2D5002A757700000000  Available    No     1.00GB          0A/0A          Huawei.Storage  210235G6GSZ0C4000008  
    3          2        hdisk3     Lun_002   60022A11000BB2D5002A762800000001  Available    No     2.00GB          0B/0B          Huawei.Storage  210235G6GSZ0C4000008 
    4          3        hdisk4     Lun_003   60022A11000BB2D5002A766400000002  Available    No     10.00GB         0A/0A          Huawei.Storage  210235G6GSZ0C4000008
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In the event that drive letters are changed after the upgrade, perform the following operations:
· If a volume manager is used to manage virtual disks, directly import VGs or DGs. The volume manager prevents the impact of drive letter change. For details about how to import VGs or DGs, see section 2.5.4 

REF _EN-US_TOPIC_0120429466-chtext \h
Restoring Services.
· If no volume manager is used, delete virtual disks on the host side and change host LUN IDs of LUNs on the ISM to make the ascending order of host LUN IDs identical to the sequence of LUNs corresponding to the virtual disks before the upgrade. This ensures that the LUN sequence queried by running the upadm show lun(for V100R005 and earlier version) or upadm show vlun (for V100R006 and later version) command before the upgrade and that queried after the upgrade are the same. If host LUN IDs cannot be changed on a storage device, delete mappings on the storage device, add mappings again (when adding a mapping, you are allowed to select a LUN ID), and run the cfgmgr command to scan for disks.
Step 6 Save desired attribute information of virtual disks in one-to-one relationship with PVIDs.
The information is used to restore attributes of virtual disks to the previous ones after the upgrade. Attribute information includes the path selection algorithm, the queue depth, and the reserve policy of virtual disks.Run the lsattr -El hdiskX command and save the command output.
-bash-3.00# lsattr -El hdisk1   
PCM             PCM/friend/UPpcm_S5500T          Path Control Module              False   
PR_key_value    none                             Persistant Reserve Key Value     True   
algorithm       round_robin                   Algorithm                        True   
clr_q           no                               Device CLEARS its Queue on error True   
dist_err_pcnt   0                                Distributed Error Percentage     True   
dist_tw_width   50                               Distributed Error Sample Time    True   
hcheck_cmd      test_unit_rdy                    Health Check Command             True   
hcheck_interval 10                               Health Check Interval            True   
hcheck_mode     nonactive                        Health Check Mode                True   
location                                         Location Label                   True   
lun_id          0x0                              Logical Unit Number ID           False   
lun_reset_spt   yes                              LUN Level Reset                  True   
max_transfer    0x100000                         Maximum TRANSFER Size            True   
node_name       0x21000022a1073fdd               FC Node Name                     False   
pvid           00007e1daedaaa2f0000000000000000 Physical volume identifier     False   
q_err           yes                              Use QERR bit                     True   
q_type          simple                          Queuing TYPE                     True   
queue_depth     32                               Queue DEPTH                      True   
reassign_to     120                              REASSIGN time out value          True   
reserve_policy  no_reserve                      Reserve Policy                   True   
rw_timeout      30                               READ/WRITE time out value        True   
scsi_id         0x10600                          SCSI ID                          False   
start_timeout   60                              START unit time out value        True   
ww_name         0x20180022a1073fdd               FC World Wide Name               False
Alternatively, run the lsattr -E -a attr_name -F value -l hdiskX command to query a specific property of a virtual disk each time, and save the command output. In the command, attr_name indicates the property name that you want to query.
Table 2-4 Querying and modifying virtual disk attributes
	Operation
	Command
	Parameter Description
	Example

	Query virtual disk properties.
	lsattr -E -a attr_name -F value -l Name
	attr_name: indicates the name of a virtual disk's property, for example, reserve_policy and algorithm.
Name: indicates the device name of a virtual disk.
	lsattr -E -a reserve_policy -F value -l hdisk2 (used to query the reservation policy configured for hdisk2)

	Modify the reservation policy for a virtual disk.
	chdev -a attr_name=attr_value -l Name
	attr_name: indicates the name of a virtual disk's property.
attr_value: indicates the value that you want to specify.
Name: indicates the device name of a virtual disk.
	chdev -a reserve_policy=single_path -l hdisk2
NOTE
· If hdisk2 changed is displayed, the reservation policy is successfully modified.
· Do not interrupt the execution of the chdev command. Otherwise, the configuration database may be damaged. (Only user root and members of the security group are allowed to run this command.)


In a cluster environment, you must restore virtual disk reservation policies to the previous ones after the upgrade. The following reservation policies are supported: single_path, no_reserve, PR_exclusive, and PR_shared. The following information is an example:
bash-3.00# lsattr -E -a reserve_policy -F value -l hdisk2     
no_reserve    
bash-3.00# lsattr -E -a reserve_policy -F value -l hdisk3     
single_path   
no_reserve is the default value. Therefore, only reservation policies except no_reserve need to be saved. Local disks do not need to be considered.
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· The network environment is complex. It is difficult to determine whether LUNs work in active-active or active-standby mode. The reservation configuration after the upgrade must remain the same as that before the upgrade. However, upgrading UltraPath for AIX causes reservation policies of virtual disks to change to no_reserve. Therefore, before upgrading UltraPath for AIX and deleting virtual disks, you must back up reservation policies of virtual disks. After the upgrade, restore reservation policies according to the backup information.
· After the upgrade, you must reset reservation policies of virtual disks for all nodes.
· Before the upgrade, save reservation policies of all virtual disks in one-to-one relationship with PVIDs to prevent the impact of drive letter change.
· If the output of the lspv command indicates that the VG status is concurrent, the reservation policy should be no_reserve. If reservation policy is changed after the upgrade, change the reservation policy back to no_reserve.
diskName: PVID: VGname: VGstatus:   
hdisk4 00c0bf6016fc6aa3 datavg concurrent;
----End
Verification
None.
2.2.9  Checking the Environment Before the Upgrade
Task Description
This section applies to an offline upgrade only.
Verify that file systems on the virtual disks are uninstalled, VGs are disabled, and DGs are removed.
Precautions
Perform operations with the assistance of the customer's service engineers.
Procedure
Step 1 Run the vxdisk list command and check whether the VxVM is installed.
· If command not found is displayed, the VxVM is not installed. In this case, go to step 2.
· If the VxVM is installed, perform the following operations:
5. Run the vxdisk -e list command and check that DGs are removed from virtual disks and virtual disks are in the offline state. Pay attention only to the virtual disks in the online state.
In the following example, virtual disk hdisk4 is in the offline state, and virtual disks hdisk1, hdisk2, and hdisk3 are in the online state. Virtual disks hdisk1 and hdisk2 belong to DG DG002, and the DG to which virtual disk hdisk3 belongs has been removed.
bash-3.00# vxdisk -e list   
DEVICE     TYPE      DISK      GROUP    STATUS OS_NATIVE_NAME      
Disk_0     auto      -            -       LVM       hdisk0       
Disk_1     auto      -            -      online     hdisk3       
Disk_2     auto      Disk_2     DG002    online     hdisk1        
Disk_3     auto      Disk_3     DG002    online     hdisk2         
Disk_4     auto      -            -      offline    hdisk4       
Disk_5     auto      -            -       LVM       hdisk5
[image: image22.png]



· If execution of the vxdisk -e list command fails, the VxVM is not installed.
· In the preceding command output, the DEVICE column lists the names of disks managed by the VxVM, and the OS_NATIVE_NAME column lists the corresponding names of the disks displayed on the AIX operating system.
· The GROUP column lists the names of DGs.
· hdisk0 is a local disk. hdisk5 is a virtual disk managed by the LVM. For details about operations related to the LVM, see Step 2.
6. Check whether the file system mounted on the DG is identified. If yes, go to sub-step 3. If no, perform the following operations:
· Run the vxinfo -g DgName command. The logical volume of the DG is displayed. The logical volume contains the file system information. In the following example, the logical volume of DG002 is testlv.
bash-3.00# vxinfo -g DG002    
testlv         fsgen    Started
· Run the vxprint -g DgName -l LvName | grep path command to obtain the path to the logical volume. In the following example, the path to logical volume testlv of DG002 is /dev/vx/dsk/DG002/testlv.
bash-3.00# vxprint -g DG002 -l testlv|grep path    device:   minor=42000 bdev=62/42000 cdev=62/42000 path=/dev/vx/dsk/DG002/testlv
· Run the mount |grep "LvPath" command to obtain the mount point of the file system. In the following example, /home/vxfs002 is the mount point of the file system in the logical volume that is saved to /dev/vx/dsk/DG002/testlv.
bash-3.00# mount |grep "/dev/vx/dsk/DG002/testlv"    /dev/vx/dsk/DG002/testlv /home/vxfs002    vxfs   Nov 24 09:38 rw,delaylog,suid,ioerror=mwdisable,largefiles
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If no command output is displayed, no file system is mounted on the logical volume.
7. After obtaining the mount point of the file system mounted on the DG, run the umount mountPoint command to uninstall the file system, the vxdg deport DgName command to remove the DG, and the vxdisk offline DeviceName command to get the virtual disks offline.
The following is an example:
bash-3.00# umount /home/vxfs002   
bash-3.00# vxdg deport DG002   
bash-3.00# vxdisk offline Disk_1   
bash-3.00# vxdisk offline Disk_2   
bash-3.00# vxdisk offline Disk_3
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· If no file system is mounted, directly remove the DG.
· DeviceName of an offline disk is a device name used by the VxVM, not a disk name displayed on the AIX operating system.
8. Run the vxdisk -e list command and check that the DG is removed and that virtual disks are in the offline state.
In the following example, the DG is removed, and virtual disks are in the offline state.
bash-3.00# vxdisk -e list
DEVICE     TYPE    DISK     GROUP     STATUS    S_NATIVE_NAME    Disk_0     auto     -         -         LVM         hdisk0         
Disk_1     auto     -         -       offline       hdisk3        
Disk_2     auto     -         -       offline       hdisk1        
Disk_3     auto     -         -       offline       hdisk2        
Disk_4     auto     -         -       offline       hdisk4        
Disk_5     auto     -         -         LVM         hdisk5
Step 2 Deactivate virtual disks managed by the LVM.
9. Run the lspv command and check that VGs on virtual disks are disabled.
In the following example, vg001 is in the active state. datavg is disabled.
bash-3.00# lspv     
hdisk0         0001fa696441ac6d            None                
hdisk1         0001f090dc830ea9            rootvg        active    
hdisk2         0001f0906c346eb8            vg001         active    
hdisk3         0001f0908c629de6            vg001         active    
hdisk4         00f6e0743a973991            datavg              
hdisk5         0001f0908d097431            datavg
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The preceding command output contains four columns, indicating the disk name, PVID, VG name, and VG status.
10. If a VG is in the active state, run the lsvg -l vgName command to identify the file system on the VG and run the mount command and check whether the file system is mounted.
The following is an example:
bash-3.00# lsvg -l vg001   
vg001:   
LV NAME       TYPE       LPs   PPs   PVs  LV STATE    MOUNT POINT  
lv001         jfs       2     2     1    closed/syncd  N/A   
loglv00       jfs2log    1     1     1    open/syncd    N/A   
fslv00        jfs2       5     5     1    open/syncd    /home/fs001 
bash-3.00# mount   
node       mounted        mounted over    vfs    date     options   
-------- ------------  ---------------  ------ --------- -------- 
/dev/hd4         /                jfs2   Nov 10 04:25 rw,log=/dev/hd8   
/dev/hd2         /usr             jfs2   Nov 10 04:25 rw,log=/dev/hd8   
/dev/hd9var      /var             jfs2   Nov 10 04:25 rw,log=/dev/hd8   
/dev/hd3         /tmp             jfs2   Nov 10 04:25 rw,log=/dev/hd8   
/dev/fwdump      /var/adm/ras/platform jfs2   Nov 10 04:26 rw,log=/dev/hd8   
/dev/hd1         /home            jfs2   Nov 10 04:26 rw,log=/dev/hd8   
/proc            /proc            procfs Nov 10 04:26 rw   
/dev/hd10opt     /opt             jfs2   Nov 10 04:26 rw,log=/dev/hd8   
/dev/fslv00      /home/fs001      jfs2   Nov 10 04:57 rw,log=/dev/loglv00
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In the preceding command output, file system fslv00 is mounted on vg001, and the mount point is /home/fs001.
11. Run the umount mountPoint command to uninstall the file system.
The following is an example:
bash-3.00# umount /home/fs001
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If busy is returned, ask the customer's engineers to confirm that services have been stopped.
12. After all file systems are uninstalled, run the varyoffvg vgName command to disable VGs.
bash-3.00# varyoffvg vg001
13. Run the lspv command and check that all VGs are disabled.
bash-3.00# lspv      
 hdisk0         0001fa696441ac6d            None               
 hdisk1         0001f090dc830ea9            rootvg        active   
 hdisk2         0001f0906c346eb8            vg001              
 hdisk3         0001f0908c629de6            vg001              
 hdisk4         00f6e0743a973991            datavg
Step 3 Ensure that the /opt directory on the server has at least 200 MB of free space, the /usr directory has at least 30 MB of free space, the /tmp directory has at least 250 MB of free space, the / directory has at least 20 MB of free space.
# df -m  
Filesystem    MB blocks    Free    %Used   Iused %Iused  Mounted on  
/dev/hd4       10752.00   1028.62   91%   135898    36% / 
/dev/hd2        3840.00   1681.39   57%    39508    10% /usr 
/dev/hd3        5120.00    991.02   81%      870     1% /tmp 
/dev/hd10opt    2176.00   1548.43   29%     3060     1% /opt
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If the free space is insufficient, run the chfs -a size=+200M /opt command to expand the capacity of the /opt directory, run the chfs -a size=+30M /usr command to expand the capacity of the /usr directory, run the chfs -a size=+250M /tmp command to expand the capacity of the /tmp directory, and the chfs -a size=+20M /command to expand the capacity of the /directory.
----End
Verification
If the output of the mount command executed in Step 1 and Step 2 does not include any file systems created on virtual disks, the file system has been uninstalled. Otherwise, run the umount command to uninstall the file system.
In the output of the lspv command executed in Step 2, if the VG status is not active, the VG is disabled. Otherwise, run the varyoffvg VGname command to disable the VG.
2.3  Upgrading UltraPath for AIX from a version later than V100R008
For details about how to determine whether a version later than V100R008, see section 2.2.5 

REF _EN-US_TOPIC_0120429075-chtext \h
Obtaining the Version Number of UltraPath for AIX.
2.3.1  Setting Virtual Disks to the Defined State
Task Description
This section applies to an offline upgrade only.
If not in SAN Boot situation, set virtual disks to the Defined state.
If in SAN Boot situation, set virtual disks to the Defined state except rootvg.
Precautions
None.
Prerequisites
None.
Procedure
Step 1 Run the lsdev -Cc disk command to query the status of virtual disks. If no virtual disk exists or all virtual disks are in the Defined state, skip step 2.
bash-3.00# lsdev -Cc disk    
hdisk0 Available 03-08-00-5,0 16 Bit LVD SCSI Disk Drive     
hdisk1 Available 00-08-02     Huawei S5500T FC Disk Drive     
Step 2 Run the rmdev -l diskName command to set all virtual disks to the Defined state.The following is an example:
bash-3.00# rmdev -l hdisk1    
hdisk1 Defined 
----End
Verification
Run the lsdev -Cc disk command to confirm that virtual disks have been set to the Defined state.
-bash-3.00# lsdev -Cc disk    
hdisk0 Available 03-08-00-5,0 16 Bit LVD SCSI Disk Drive    
hdisk1 Defined   00-08-02     Huawei S5500T FC Disk Drive
Troubleshooting
Step 1 If the rmdev command fails to be executed and the busy error is displayed, confirm that file systems are uninstalled, VGs are disabled, and DGs are removed. For details, see section 2.2.9 

REF _EN-US_TOPIC_0120429301-chtext \h
Checking the Environment Before the Upgrade.
Step 2 If virtual disks cannot be set to the Defined state after all services are stopped, VGs are disabled, and DGs are removed, run the fuser -kxuc /dev/hdiskX command to stop all processes that are accessing hdiskX, and then run the rmdev -l diskName command to set all virtual disks to the Defined state.
Step 3 If other error information is displayed, proceed as prompted.
----End
2.3.2  Upgrading UltraPath for AIX Offline
Task Description
Upgrade UltraPath for AIX offline.
Precautions
See section 1.4.1.2 

REF _EN-US_TOPIC_0120429262-chtext \h
Others.
Prerequisites
· Services are stopped.
· File systems are uninstalled.
· All users have quit the upadm mode.
· If not in SAN Boot situation, all virtual disks are deleted or set to the Defined state.
· If in SAN Boot situation, all virtual disks are deleted or set to the Defined state except rootvg.
Procedure
Step 1 Copy the UltraPath for AIX upgrade package to any directory. Do not change the structure of the upgrade package. For example, if the upgrade package is copied to the /ultrapath directory, ensure that the directory contains three folders Docs, Packages, Tools, one compressed script install.tar and one configuration file unattend_install.conf .
Figure 2-3 Structure of the UltraPath for AIX upgrade package
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Figure 2-4 Contents in the Packages folder
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-bash-3.00# ls -l   
total 312 
drwxr-xr-x   2 root     system          256 Mar 08 07:19 Docs 
drwxr-xr-x   3 root     system          256 Mar 08 07:19 Packages 
drwxr-xr-x   2 root     system          256 Mar 08 07:19 Tools 
-rw-r--r--   1 root     system       153600 Mar 08 07:19 install.tar 
-rw-r--r--   1 root     system          899 Mar 08 07:19 unattend_install.conf
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If you use an FTP tool to copy the upgrade package to the target host, set the transmission mode to automatic, not binary transmission.
Step 2 Run the cd /ultrapath command to go to the directory where the upgrade package resides.
Step 3 Run the tar -xvf install.tar command to decompress the .tar file. The install.sh is obtained.
Step 4 Run the chmod +x install.sh command to modify the file execution permission.
Step 5 Run the sh install.sh command to upgrade UltraPath for AIX.
If the upgrade is successful, the following information is displayed. If the Result column shows Failed, the upgrade fails. In this case, proceed as prompted.
-bash-3.00# sh install.sh  
The os is AIX 5.3 
        NOTICE : UltraPath software UltraPath.AIX.ppc_64.rte 8.1.803.28 has already exist in the system. 
                Before update software,please make sure there are no disks or disks are defined status! update it(Y/y)or(N/n)? : -->  
y 
Begin to update UltraPath... 
+-----------------------------------------------------------------------------+ 
                    Pre-installation Verification... 
+-----------------------------------------------------------------------------+ 
Verifying selections...done 
Verifying requisites...done 
Results... 
 
SUCCESSES 
--------- 
  Filesets listed in this section passed pre-installation verification 
  and will be installed. 
 
  Selected Filesets 
  ----------------- 
  UltraPath.AIX.ppc_64.rte 8.1.2105.31          # UltraPath for AIX 
 
  << End of Success Section >> 
 
FILESET STATISTICS  
------------------ 
    1  Selected to be installed, of which: 
        1  Passed pre-installation verification 
  ---- 
    1  Total to be installed 
 
+-----------------------------------------------------------------------------+ 
                         Installing Software... 
+-----------------------------------------------------------------------------+ 
 
installp:  APPLYING software for: 
        UltraPath.AIX.ppc_64.rte 8.1.2105.31 
 
------------------------------------------------------------------------- 
Warning: Check the status of disks. If the status of a disk is not 
         'Defined', set the status of all disks to Defined and scan for 
         the disks again to enable the new version to take effect 
------------------------------------------------------------------------- 
Add smit for ultrapath success. 
Finished processing all filesets.  (Total time:  15 secs). 
 
+-----------------------------------------------------------------------------+ 
                        Pre-commit Verification... 
+-----------------------------------------------------------------------------+ 
Verifying requisites...done 
Results... 
 
SUCCESSES 
--------- 
  Filesets listed in this section passed pre-commit verification 
  and will be committed. 
 
  Selected Filesets 
  ----------------- 
  UltraPath.AIX.ppc_64.rte 8.1.2105.31          # UltraPath for AIX 
 
  << End of Success Section >> 
 
+-----------------------------------------------------------------------------+ 
                          Committing Software... 
+-----------------------------------------------------------------------------+ 
 
installp:  COMMITTING software for: 
        UltraPath.AIX.ppc_64.rte 8.1.2105.31 
 
Finished processing all filesets.  (Total time:  15 secs). 
 
+-----------------------------------------------------------------------------+ 
                                Summaries: 
+-----------------------------------------------------------------------------+ 
 
Installation Summary 
-------------------- 
Name                        Level           Part        Event       Result 
------------------------------------------------------------------------------- 
UltraPath.AIX.ppc_64.rte    8.1.2105.31      USR         APPLY       SUCCESS     
UltraPath.AIX.ppc_64.rte    8.1.2105.31      USR         COMMIT      SUCCESS 
Step 6 Optional：
UltraPath automatically sets the fc_err_recov and dyntrk attributes of the FC HBA.
If the following information is displayed during the upgrade, restart the host to enable the settings to take effect. (This is the Fibre Channel networking configuration requirement of the IBM system.) The time for restarting the host must be determined by the customer based on the actual situation.
The HBA port attributes dyntrk and fc_err_recov are successfully modified and the modifications take effect after a host restart.
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· UltraPath does not depend on the attribute settings. It works properly even if the attribute settings do not take effect.
If the following information is displayed during the upgrade, UltraPath fails to set the attributes. In this case, perform the following steps to complete the manual configuration.
Manually modify the HBA port attributes dyntrk and fc_err_recov by referring to the UltraPath user guide.
Check whether the fc_err_recov property of the Fibre Channel HBA is fast_fail and the dyntrk property of the Fibre Channel HBA is yes. If not, delete subdevices on fscsi devices, and change the property values.
14. Run the lsdev -Cc driver|grep fscsi command to list existing fscsi devices.
-bash-3.00# lsdev -Cc driver|grep fscsi 
fscsi0 Available 06-08-01 FC SCSI I/O Controller Protocol Device 
fscsi1 Available 0B-08-01 FC SCSI I/O Controller Protocol Device
15. Run the lsdev -p fscsiX command to query whether fscsi devices have subdevices.
-bash-3.00# lsdev -p fscsi0 
sfwcomm0 Available 06-08-01-FF Fibre Channel Storage Framework Comm
16. Run the rmdev -l subDevice command to set subdevices to the Defined state if there are any.
-bash-3.00# rmdev -l sfwcomm0 
sfwcomm0 Defined
17. Modify the properties of the Fibre Channel HBA.
-bash-3.00# chdev -l fscsi0 -a fc_err_recov=fast_fail   fscsi0 changed    -bash-3.00# chdev -l fscsi0 -a dyntrk=yes    fscsi0 changed
Table 2-6 describes the command used to modify the properties of the Fibre Channel HBA.
Table 2-5 Modifying the properties of the Fibre Channel HBA in a SAN networking scenario
	Operation
	Command
	Parameter Description
	Example

	Modify the properties of the Fibre Channel HBA.
	chdev -l Name -a fc_err_recov=fast_fail
chdev -l Name -a dyntrk=yes
	Name: indicates the logical name of a customized device whose property names or values need to be displayed.
fc_err_recov: indicates fast error recovery.
dyntrk: indicates dynamic tracking.
	# chdev -l fscsi0 -a fc_err_recov=fast_fail
fscsi0 changed
# chdev -l fscsi0 -a dyntrk=yes
fscsi0 changed
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· Before changing the properties of the Fibre Channel HBA, query subdevices and set subdevices to the Defined state.
· In a direct-connection environment, if the values of fc_err_recov and dyntrk are fast_fail and yes respectively, set fc_err_recov to delayed_fail and dyntrk to no.
Table 2-6 Querying subdevices and setting subdevices to the Defined state
	Operation
	Command
	Parameter Description
	Example

	Querying subdevices
	lsdev -p parent
	-p: lists subdevices of a parent device.
	#lsdev -p fscsi0

	Setting subdevices to the Defined state
	rmdev -l hdiskX
	-l: followed by a disk name.
	#rmdev -l hdisk2


Step 7 Run the cfgmgr command to scan for disks.
Step 8 Run the lspv command and check whether virtual disks are generated.
bash-3.00# lspv    
hdisk0         0001fa696441ac6d              None               
hdisk1         0001f090dc830ea9              rootvg          active    
hdisk2          0001f0906c346eb8             vg001              
hdisk3          0001f0908c629de6             vg001              
hdisk4          00f6e0743a973991             datavg             
hdisk5          0001f0908d097431             datavg        
If all virtual disks are deleted before the upgrade, perform the following step:
Step 9 Run the chdev -a attr_name=attr_value -l hdiskX command to restore properties of virtual disks to those saved before the upgrade. In the command, attr_name indicates a property name, and attr_value indicates the property value to be set.
For example, run the chdev -a reserve_policy=single_path -l hdiskX command to restore virtual disk's reservation polices by using the reservation polices saved before the upgrade. Note the mappings between the reservation polices before the upgrade and the PVIDs.
bash-3.00# chdev -a reserve_policy=single_path -l hdisk2    
hdisk2 changed
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· If a reservation policy is changed to single_path, change the path selection algorithm to fail_over for the virtual disk.
· After the upgrade is complete, do not run the upkill up_restart_warn command.
----End
Verification
Run the lslpp -l U*.*.rte command to obtain the name of the installed UltraPath for AIX and check that the version is the target version.
Troubleshooting
Proceed as prompted.
2.3.3  Upgrading UltraPath for AIX Online
Task Description
Upgrade UltraPath for AIX from an earlier version to the latest version without interrupting services. UltraPath for AIX takes effect immediately after the upgrade is complete.
Precautions
See section 1.4.1 

REF _EN-US_TOPIC_0120429119-chtext \h
UltraPath for AIX.
Procedure
Step 1 Copy the UltraPath installation package to the host.
Figure 2-5 UltraPath for AIX installation package directories
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Step 2 Run the following commands to upgrade UltraPath for AIX online. Table 2-8 lists the parameters that can be specified by users:
~ # tar -xvf install.tar 
~ # sh install.sh -ndu [ndu_free_mem_size=xxx] [ndu_used_cpu_percent=yyy] [ndu_free_disk_space=zzz]
Table 2-7 Parameters that can be specified by users during the online upgrade
	Parameter
	Function
	Description

	ndu_free_mem_size
	Minimum available memory size required to check the UltraPath before the upgrade.
	Unit: MB.
Default value:200

	ndu_used_cpu_percent
	Maximum CPU usage percentage allowed by the pre-upgrade check.
	The value ranges between 0 and 100.
Default value:80

	ndu_free_disk_space
	Free space in the root directory required by the online upgrade check.
	Unit: MB.
Default value:200


Step 3 Perform the pre-upgrade check. If the pre-upgrade check fails, the system will quit the online upgrade. If the pre-upgrade check succeeds, the latest UltraPath will be installed, and you will be asked not to report or delete disks. Entering N will roll back UltraPath for AIX and quit the online upgrade. Entering Y will continue the upgrade.
+-----------------------------------------------------------------------------+ 
                    Pre-installation Verification... 
+-----------------------------------------------------------------------------+ 
Verifying selections...done 
Verifying requisites...done 
Results... 
 
SUCCESSES 
--------- 
  Filesets listed in this section passed pre-installation verification 
  and will be installed. 
 
  Selected Filesets 
  ----------------- 
  UltraPath.AIX.ppc_64.rte 8.1.2105.31          # UltraPath for AIX 
 
  << End of Success Section >> 
 
FILESET STATISTICS  
------------------ 
    1  Selected to be installed, of which: 
        1  Passed pre-installation verification 
  ---- 
    1  Total to be installed 
 
+-----------------------------------------------------------------------------+ 
                         Installing Software... 
+-----------------------------------------------------------------------------+ 
 
installp:  APPLYING software for: 
        UltraPath.AIX.ppc_64.rte 8.1.2105.31 
 
 
 
Broadcast message from root@AIX196 (tty) at 16:10:34 ...  
 
Add smit for ultrapath success. 
Finished processing all filesets.  (Total time:  5 secs). 
 
+-----------------------------------------------------------------------------+ 
                                Summaries: 
+-----------------------------------------------------------------------------+ 
 
Installation Summary 
-------------------- 
Name                        Level           Part        Event       Result 
------------------------------------------------------------------------------- 
UltraPath.AIX.ppc_64.rte    8.1.2105.31      USR         APPLY       SUCCESS     
During the non-disruptive upgrade, do not run the cfgmgr, rmdev, rmpath, chdev, and chpath commands. Otherwise, the non-disruptive upgrade may fail. Are you sure you want to continue? 
<Y|N>:
If there are a large number of disks, no message will be displayed temporarily. After a maximum of 10 minutes, you will be asked whether to continue the online upgrade.
Step 4 After the upgrade is successful, the following messages are displayed:
+-----------------------------------------------------------------------------+ 
                        Pre-commit Verification... 
+-----------------------------------------------------------------------------+ 
Verifying selections...done 
Verifying requisites...done 
Results... 
 
SUCCESSES 
--------- 
  Filesets listed in this section passed pre-commit verification 
  and will be committed. 
 
  Selected Filesets 
  ----------------- 
  UltraPath.AIX.ppc_64.rte 8.1.2105.31          # UltraPath for AIX 
 
  << End of Success Section >> 
 
FILESET STATISTICS  
------------------ 
    1  Selected to be committed, of which: 
        1  Passed pre-installation verification 
  ---- 
    1  Total to be committed 
 
+-----------------------------------------------------------------------------+ 
                          Committing Software... 
+-----------------------------------------------------------------------------+ 
 
installp:  COMMITTING software for: 
        UltraPath.AIX.ppc_64.rte 8.1.2105.31 
 
Finished processing all filesets.  (Total time:  0 secs). 
 
+-----------------------------------------------------------------------------+ 
                                Summaries: 
+-----------------------------------------------------------------------------+ 
 
Installation Summary 
-------------------- 
Name                        Level           Part        Event       Result 
------------------------------------------------------------------------------- 
UltraPath.AIX.ppc_64.rte    8.1.2105.31      USR         COMMIT      SUCCESS     
 
bosboot: Boot image is 24413 512 byte blocks. 
The non-disruptive upgrade is complete.
----End
Verification
Step 1 Run the upadm show version command to check whether the UltraPath version is the latest.
Step 2 Run the genkex | grep Ultra command to check whether the UltraPath module is loaded properly.
For example, the module before the upgrade is:
~ # genkex | grep Ultra
44da000   3f08a8 /usr/lib/drivers/UltraPath_pcmextA
44c1000    186d0 /usr/lib/drivers/UltraPath_pcmke
The module after the upgrade is:
~ # genkex | grep Ultra
44db000   3f07a8 /usr/lib/drivers/UltraPath_pcmextB
44c1000    186d0 /usr/lib/drivers/UltraPath_pcmke
Step 3 Check whether services are running normally.
----End
Troubleshooting
If faults occur during the upgrade, contact Huawei R&D engineers for troubleshooting.
2.4  Upgrading UltraPath for AIX from a version earlier than V100R008
This section applies to an offline upgrade only.
This section describes how to upgrade from a version earlier than V100R008 to this version see section 2.3 

REF _EN-US_TOPIC_0120429133-chtext \h
Upgrading UltraPath for AIX from a version later than V100R008. (For details about how to determine whether an upgrade from a version earlier than V100R008, see section 2.2.5 

REF _EN-US_TOPIC_0120429075-chtext \h
Obtaining the Version Number of UltraPath for AIX.)
2.4.1  Deleting Virtual Disks
Task Description
Delete all virtual disks.
Precautions
None.
Prerequisites
None.
Procedure
Step 1 Run the lsdev -Cc disk command to query whether virtual disks exist. If no virtual disk exists, go to step 2.
bash-3.00# lsdev -Cc disk       
hdisk0 Available 03-08-00-5,0 16 Bit LVD SCSI Disk Drive    
hdisk1 Available 00-08-02     Huawei S5500T FC Disk Drive    
Step 2 Run the rmdev -dl diskName command to delete all virtual disks.
The following is an example:
bash-3.00# rmdev -dl hdisk1    
hdisk1 deleted  
----End
Verification
Run the lsdev -Cc disk command and check that virtual disks do not exist.
bash-3.00# lsdev -Cc disk    
hdisk0 Available 03-08-00-5,0 16 Bit LVD SCSI Disk Drive
Troubleshooting
Step 1 If the rmdev command fails to be executed and the busy error is displayed, confirm that file systems are uninstalled, VGs are disabled, and DGs are removed. For details, see section 2.2.9 

REF _EN-US_TOPIC_0120429301-chtext \h
Checking the Environment Before the Upgrade.
Step 2 If virtual disks cannot be deleted after all services are stopped, VGs are disabled, and DGs are removed, run the fuser -kxuc /dev/hdiskX command to stop all processes that are operating hdiskX, and then delete all virtual disks again.
Step 3 If other error information is displayed, proceed as prompted.
----End
2.4.2  Upgrading UltraPath for AIX Offline
Task Description
Upgrade UltraPath for AIX offline.
Precautions
None.
Prerequisites
Services are stopped, service information and multipathing information have been backed up, file systems are uninstalled, all virtual disks have been deleted, and all users have quit the upadm mode.
Procedure
Step 1 Run the lsdev -Cc disk command and check that virtual disks do not exist.
Step 2 Copy the UltraPath for AIX upgrade package to any directory.
Do not change the structure of the upgrade package. For example, if the upgrade package is copied to the /ultrapath directory, ensure that the directory contains three folders Docs, Packages, Tools, one compressed script install.tar and one configuration file unattend_install.conf. In addition, ensure that the upgrade package resides in the Packages folder.
Figure 2-6 Structure of the UltraPath for AIX upgrade package
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Figure 2-7 Contents in the Packages folder
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-bash-3.00# ls -l   
total 312 
drwxr-xr-x   2 root     system          256 Mar 08 07:19 Docs 
drwxr-xr-x   3 root     system          256 Mar 08 07:19 Packages 
drwxr-xr-x   2 root     system          256 Mar 08 07:19 Tools 
-rw-r--r--   1 root     system       153600 Mar 08 07:19 install.tar 
-rw-r--r--   1 root     system          899 Mar 08 07:19 unattend_install.conf
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If you use an FTP tool to copy the upgrade package to the target host, set the transmission mode to automatic, not binary transmission.
Step 3 Run the cd /ultrapath command to go to the directory where the upgrade package resides.
Step 4 Run the tar -xvf install.tar command to decompress the .tar file. The install.sh is obtained.
Step 5 Run the chmod +x install.sh command to modify the file execution permission.
Step 6 Run the sh install.sh command to upgrade UltraPath for AIX.If the upgrade is successful, the following information is displayed:
-bash-3.00# sh install.sh  
The os is AIX 5.3 
 
        NOTICE :UltraPath software UltraPath.AIX.ppc_64.rte has already exist in the system. 
        Before uninstall the old version, please make sure storage device disks have been deleted! Uninstall it(Y/y)or(N/n)? : -->  
y 
The UltraPath of the old version is being uninstalled. Please wait ......... 
Uninstallation completed. 
The UltraPath of the new version is being installed. Please wait ......... 
Install UltraPath For AIX Success.
Step 7 Optional：
UltraPath automatically sets the fc_err_recov and dyntrk attributes of the FC HBA.
If the following information is displayed during the upgrade, restart the host to enable the settings to take effect. (This is the Fibre Channel networking configuration requirement of the IBM system.) The time for restarting the host must be determined by the customer based on the actual situation.
The HBA port attributes dyntrk and fc_err_recov are successfully modified and the modifications take effect after a host restart.
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· UltraPath does not depend on the attribute settings. It works properly even if the attribute settings do not take effect.
If the following information is displayed during the upgrade, UltraPath fails to set the attributes. In this case, perform the following steps to complete the manual configuration.
Manually modify the HBA port attributes dyntrk and fc_err_recov by referring to the UltraPath user guide.
Check whether the fc_err_recov property of the Fibre Channel HBA is fast_fail and the dyntrk property of the Fibre Channel HBA is yes. If not, delete subdevices on fscsi devices, and change the property values.
18. Run the lsdev -Cc driver|grep fscsi command to list existing fscsi devices.
-bash-3.00# lsdev -Cc driver|grep fscsi  
fscsi0 Available 06-08-01 FC SCSI I/O Controller Protocol Device  
fscsi1 Available 0B-08-01 FC SCSI I/O Controller Protocol Device
19. Run the lsdev -p fscsiX command to query whether fscsi devices have subdevices.
-bash-3.00# lsdev -p fscsi0  
sfwcomm0 Available 06-08-01-FF Fibre Channel Storage Framework Comm
20. Run the rmdev -dl subDevice command to delete subdevices if any.
-bash-3.00# rmdev -dl sfwcomm0  
sfwcomm0 deleted
21. Modify the properties of the Fibre Channel HBA.
-bash-3.00# chdev -l fscsi0 -a fc_err_recov=fast_fail  
fscsi0 changed  
-bash-3.00# chdev -l fscsi0 -a dyntrk=yes  
fscsi0 changed
Table 2-9 describes the command used to modify the properties of the Fibre Channel HBA.
Table 2-8 Modifying the properties of the Fibre Channel HBA in a SAN networking scenario
	Operation
	Command
	Parameter Description
	Example

	Modify the properties of the Fibre Channel HBA.
	chdev -l Name -a fc_err_recov=fast_fail
chdev -l Name -a dyntrk=yes
	Name: indicates the logical name of a customized device whose property names or values need to be displayed.
fc_err_recov: indicates fast error recovery.
dyntrk: indicates dynamic tracking.
	# chdev -l fscsi0 -a fc_err_recov=fast_fail
fscsi0 changed
# chdev -l fscsi0 -a dyntrk=yes
fscsi0 changed
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· Before changing the properties of a Fibre Channel HBA, query and delete subdevices.
· In a direct-connection environment, if the values of fc_err_recov and dyntrk are fast_fail and yes respectively, set fc_err_recov to delayed_fail and dyntrk to no.
· When the chdev command is executed to change properties of a Fibre Channel HBA, some of the cfgmgr functions are invoked, and new virtual disk data is generated in the ODM. Therefore, if you change properties of a Fibre Channel HBA before uninstalling the UltraPath, you must also delete the virtual disks.
Table 2-9 Querying and deleting subdevices
	Operation
	Command
	Parameter Description
	Example

	Query subdevices.
	lsdev -p parent
	-p: lists subdevices of a parent device.
	#lsdev -p fscsi0

	Delete subdevices.
	rmdev -dl hdiskX
	-d: deletes related information in the ODM library.
-l: followed by a disk name.
	#rmdev -dl hdisk2


Step 8 In a cluster environment, run the cfgmgr command to scan for disks.
Step 9 Run the lspv command and check whether virtual disks are generated.
bash-3.00# lspv     
hdisk0         0001fa696441ac6d             None                
hdisk1         0001f090dc830ea9             rootvg          active     
hdisk2         0001f0906c346eb8             vg001               
hdisk3         0001f0908c629de6             vg001               
hdisk4         00f6e0743a973991             datavg              
hdisk5         0001f0908d097431             datavg        
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If no virtual disk is generated, run the lsdev -Cc disk command and check whether there are disks in the Defined state. If yes, delete these disks and run the cfgmgr command again.
Step 10 Run the chdev -a attr_name=attr_value -l hdiskX command to restore properties of virtual disks to those saved before the upgrade. In the command, attr_name indicates a property name, and attr_value indicates the property value to be set.
For example, run the chdev -a reserve_policy=single_path -l hdiskX command to restore virtual disk's reservation polices by using the reservation polices saved before the upgrade. Note the mappings between the reservation polices and the PVIDs before the upgrade.
bash-3.00# chdev -a reserve_policy=single_path -l hdisk2     
hdisk2 changed
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Before changing a virtual disk's reservation policy to single_path, change the path selection algorithm to fail_over for the virtual disk.
----End
Verification
Run the lslpp -l U*.*.rte command to obtain the name of the installed UltraPath for AIX and check that the version is the target version.
Troubleshooting
If the installation fails, proceed as prompted.
· A bosboot error occurs, causing the installation to fail. The following information is displayed:
0503-497 installp:  An error occurred during bosboot verification processing.
For details about the solution, see section 2.7.1 

REF _EN-US_TOPIC_0120429448-chtext \h
Uninstallation or Installation Fails Because of a bosboot Error.
· Absence of the bin user causes the installation to fail. The following information is displayed:
sysck: 3001-037 The name bin is not a known user for file /usr/lib/nls/msg/en_US.  sysck: 3001-003 A value must be specified for owner for entry /usr/lib/nls/msg/en_US.  sysck: 3001-017 Errors were detected validating the files
For details about the solution, see section 2.7.2 

REF _EN-US_TOPIC_0120429163-chtext \h
Installation Fails Because of Absence of the bin User.
· The upgrade package is damaged. As a result, the installation fails. The following information is displayed:
tar: A flag requires a parameter: f  Usage: tar -{c|r|t|u|x} [ -BdDEFhilmopRUsvw ] [ -Number ] [ -f TarFile ]            [ -b Blocks ] [ -S [ Feet ] | [ Feet@Density ] | [ Blocksb ] ]            [ -L InputList ] [-X ExcludeFile] [ -N Blocks ] [ -C Directory ] File ...  ERROR:NO corresponding UltraPath for AIX5.3 install package!  Or:  restore: 0511-119 There is a missing header block.  restore: 0511-137 Trying to find the next header. Data may be lost.
Set the transmission mode of the FTP tool in use to automatic, delete the damaged upgrade package, and upload an upgrade package again. If the problem persists after the transmission mode is set to automatic, use another FTP tool.
2.5  Verifying the Upgrade
This section applies to an offline upgrade only.
2.5.1  Verification Check
Table 2-10 UltraPath for AIX verification checklist
	No.
	Task
	Criteria
	Expected Result

	1
	Check the version of UltraPath for AIX.
	Whether the version is the target version
	The version is the target version.

	2
	Check whether virtual disks and paths remain the same after the upgrade.
	Whether virtual disks and paths remain the same after the upgrade
	Virtual disks and paths remain the same after the upgrade.


2.5.2  Version Verification
Task Description
Check whether the version of the upgraded UltraPath for AIX is the target version.
Precautions
None.
Procedure
Step 1 Run the upadm show version command.
Step 2 Check that the version displayed in the command output is the target version.
----End
Verification
The returned UltraPath version is the desired one.
Troubleshooting
If version information is not returned, UltraPath for AIX may be installed unsuccessfully. In this case, run the lslpp -l U*.*.rte command to query the version.
2.5.3  Checking Whether Virtual Disks and Paths Remain the Same After the Upgrade
Task Description
Check whether the virtual disk and the path configurations are the same as those before the upgrade, including the number of virtual disks and paths, the queue depth, the path selection algorithm, the reserve policy, and the path priority.
Precautions
Back up service information with the assistance of the customer's service engineers.
Procedure
Step 1 Run the lspv command and check whether the number of virtual disks is the same as that before the upgrade and whether VG names are correct.
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If the drive letter of a virtual disk is hdisk, run the lsdev -Cc disk command to distinguish between local disks and virtual disks.
Step 2 Run the lspath command and check whether the number of paths is the same as that before the upgrade.
Step 3 Run the chown and chmod commands to restore the disk permission.
Run the ls -l command to view the disk permission. If the permission displayed is different from that before the upgrade, run the chown and chmod commands to restore the disk permission to the status before the upgrade.
For example, run the chown command to modify the configuration of a disk user group:
bash-3.00# chown grid:asmadmin /dev/rhdisk2
For example, run the chmod command to modify the configuration of the disk permission:
bash-3.00# chmod 660 /dev/rhdisk2
Step 4 Run the chdev command to restore the disk queue depth.
Run the lsattr -El command to view the disk queue depth. If the disk queue depth is different from that before the upgrade, run the chdev command to restore the attributes of the disk queue depth to the status before the upgrade.
bash-3.00# chdev -l hdisk2 -a queue_depth=32 
hdisk2 changed
Step 5 Run the chpath command to restore the disk path priority.
Run the following command to check the path priority of each disk (see step 4 in section 2.2.8 

REF _EN-US_TOPIC_0120429429-chtext \h
Backing Up Information About UltraPath for AIX Before the Upgrade). If the path priority displayed is different from that before the upgrade, run the chpath command to restore the disk path priority to the status before the upgrade.
bash-3.00# chpath -l hdisk2 -p fscsi0 -w 20180022a1073fdd,2000000000000 -a priority=2 
path Changed
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If you have deleted a disk before the upgrade by running the rmdev -dl command, the default value of the path priority is 1 when data is flushed to the disk and the upgrade is completed.
Step 6 Run the set loadbalancemode command (see the OceanStor UltraPath for AIX XXX User Guide 01) to restore the path selection algorithm of the disk.
Run the lsattr -El command to view the path selection algorithm. If the path selection algorithm displayed is different from that before the upgrade, run the set loadbalancemode command to restore the path selection algorithm to the status before the upgrade.
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For V100R008C20 and later versions, you can modify the path selection algorithm only by using the set loadbalancemode command provided by the UltraPath, but not the chdev command.
Step 7 Run the chdev command to restore the reserve policy of the disk.
Run the lsattr -El command to check the reserve policy. If the reserve policy is different from that before the upgrade, run the chdev command to restore it to the status before the upgrade.
----End
Verification
After the upgrade, check the backup items one by one to verify whether they are consistent with those before the upgrade.
Troubleshooting
· If there are fewer virtual disks after the upgrade than before the upgrade, run the cfgmgr command to scan for disks. After that, if some virtual disks are still missing, run the upadm show lun command, compare the command output with that saved before the upgrade to identity missed LUNs, and notify Huawei R&D engineers.
· In the event that drive letters are changed after the upgrade, perform the following operations:
· If a volume manager is used to manage virtual disks, directly import VGs or DGs. The volume manager prevents the impact of drive letter change. For details about how to import VGs or DGs, see section 2.5.4 

REF _EN-US_TOPIC_0120429466-chtext \h
Restoring Services.
· If no volume manager is used, delete virtual disks on the host side and change host LUN IDs of LUNs on the ISM to make the ascending order of host LUN IDs identical to the sequence of LUNs corresponding to the virtual disks before the upgrade. This ensures that the LUN sequence queried by running the upadm show lun command before the upgrade and that queried after the upgrade are the same. If host LUN IDs cannot be changed on a storage device, delete mappings on the storage device, add mappings again (when adding a mapping, you are allowed to select a LUN ID), and run the cfgmgr command to scan for disks.
2.5.4  Restoring Services
Task Description
After the upgrade is complete, restore services to the status before the upgrade. For example, activate VGs in the LVM, import DGs in the VxVM, and mount file systems.
Precautions
· Perform operations with the assistance of the customer's service engineers.
· In an active/standby cluster environment, a standby host cannot activate VGs, import DGs, or mount file systems.
Procedure
Step 1 Activate VGs on virtual disks managed by the LVM.
22. If VGs are exported before the upgrade, run the importvg -y VGName hdiskX command to import VGs.
bash-3.00# importvg –y testvg hdisk2 
testvg
23. Run the lspv command to query activated VGs on the current virtual disks. In the following example, vg001 and datavg are not activated.
bash-3.00# lspv     
hdisk0        0001fa696441ac6d             None                
hdisk1        0001f090dc830ea9             rootvg        active    
hdisk2        0001f0906c346eb8             vg001               
hdisk3        0001f0908c629de6             vg001               
hdisk4        00f6e0743a973991             datavg              
hdisk5        0001f0908d097431             datavg
24. Run the varyonvg VgName command to activate the VGs that are in the active state before the upgrade.
bash-3.00# varyonvg vg001
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In the preceding example, datavg is not in the active state before the upgrade. Therefore, it does not need to be activated.
25. Run the lspv command and check that activated VGs on the virtual disks are the same as those before the upgrade.
bash-3.00# lspv      
hdisk0        0001fa696441ac6d             None                
hdisk1        0001f090dc830ea9             rootvg       active     
hdisk2        0001f0906c346eb8             vg001        active     
hdisk3        0001f0908c629de6             vg001        active     
hdisk4        00f6e0743a973991             datavg     
hdisk5        0001f0908d097431             datavg
Step 2 Import DGs on virtual disks managed by the VxVM.
26. Run the vxdisk -e list command to query virtual disks managed by the VxVM. In the following example, virtual disks in the offline state are not managed by the LVM.
bash-3.00# vxdisk -e list     
DEVICE     TYPE    DISK     GROUP      STATUS   OS_NATIVE_NAME     
Disk_0     auto     -         -          LVM         hdisk0        
Disk_1     auto     -         -        offline       hdisk3        
Disk_2     auto     -         -        offline       hdisk1        
Disk_3     auto     -         -        offline       hdisk2       
Disk_4     auto     -         -        offline       hdisk4        
Disk_5     auto     -         -          LVM         hdisk5
27. Run the vxdisk online DeviceName command to activate the virtual disks managed by the VxVM. Ensure that the activated virtual disks are the same as those before the upgrade.
bash-3.00# vxdisk online Disk_1   
bash-3.00# vxdisk online Disk_2   
bash-3.00# vxdisk online Disk_3   
bash-3.00# vxdisk online Disk_4
28. Run the vxdisk -o alldgs list command to list the DGs that are not imported.
In the following example, DGs in parentheses in the GROUP column are not imported, that is, DG001, DG002, and DG003.
bash-3.00# vxdisk -o alldgs list     
DEVICE       TYPE            DISK         GROUP        STATUS     
Disk_0       auto:LVM         -            -             LVM     
Disk_1       auto:cdsdisk     -           (DG001)       online     
Disk_2       auto:cdsdisk     -           (DG002)       online     
Disk_3       auto:cdsdisk     -           (DG002)       online     
Disk_4       auto:cdsdisk     -            -            online     
Disk_5       auto:LVM         -            -              LVM
29. Run the vxdg import DgName command to import DGs. Ensure that the imported DGs are the same as those before the upgrade.
bash-3.00# vxdg import DG001   
bash-3.00# vxdg import DG002
30. Run the vxvol -g DgName startall command to enable the logical volumes on the DGs.
bash-3.00# vxvol -g DG001 startall     
bash-3.00# vxvol -g DG002 startall
Step 3 Run the mount MountPoint command to mount file systems saved before the upgrade.
bash-3.00# mount /home/vxfs001
----End
Verification
Services start correctly.
Troubleshooting
None.
2.6  Rolling Back to the Source Version
This section applies to an offline upgrade only.
The rollback procedure of the UltraPath is identical with the upgrade procedure.
2.6.1  Uninstalling UltraPath for AIX of the Target Version
Task Description
If UltraPath for AIX of the target version fails to work properly, uninstall it and install UltraPath for AIX of the source version.
Procedure
Step 1 Run the lslpp -l U*.*.rte command to query the name of the existing UltraPath for AIX.
The following is an example:
-bash-3.00# lslpp -l U*.*.rte 
  Fileset                      Level  State      Description          
  ----------------------------------------------------------------------------  
Path: /usr/lib/objrepos  
  UltraPath.AIX.ppc_64.rte   8.1.2101.3  COMMITTED  UltraPath for AIX 
Step 2 Run the installp -u UltraPath.AIX.ppc_64.rte command to uninstall UltraPath for AIX.
After UltraPath for AIX is successfully uninstalled, the following information is displayed:
+-----------------------------------------------------------------------------+  
                             Summaries:  
+-----------------------------------------------------------------------------+  
  
Installation Summary  
--------------------  
Name                       Level     Part     Event      Result  
-------------------------------------------------------------------------------  
UltraPath.AIX.ppc_64.rte  8.1.2101.3    USR    DEINSTALL   SUCCESS
----End
Verification
Run the lslpp -l U*.*.rte command and confirm that UltraPath for AIX does not exist.
Troubleshooting
If the uninstallation fails, proceed as prompted.
A bosboot error occurs, causing the installation to fail. The following information is displayed:
0503-497 installp:  An error occurred during bosboot verification processing.
For details about the solution, see section 2.7.1 

REF _EN-US_TOPIC_0120429448-chtext \h
Uninstallation or Installation Fails Because of a bosboot Error.
2.6.2  Installing UltraPath for AIX of the Source Version
Task Description
Install UltraPath for AIX of the source version.
Procedure
According to the UltraPath for AIX User Guide of the source version, use the rollback package mentioned in section 2.2.6 

REF _EN-US_TOPIC_0120429114-chtext \h
Obtaining the Rollback Package to install UltraPath for AIX of the source version.
Verification
UltraPath for AIX of the source version is installed successfully.
Troubleshooting
If the rollback fails, immediately ask the R&D contact to assist in problem analysis and handling.
2.7  Troubleshooting
This section applies to an offline upgrade only.
2.7.1  Uninstallation or Installation Fails Because of a bosboot Error
2.7.1.2  Possible Cause
Possible causes are as follows:
· /unix and /usr/lib/boot/unix point to different kernel files.
· The bosboot command has bugs.
2.7.1.3  Solution
The following solution is applicable to both of the preceding cases.
Step 1 Back up the bosboot file.
cp /usr/sbin/bosboot /usr/sbin/bosboot.bak
Step 2 Skip the bosboot verification.
Add exit 0 to the second line in the bosboot file, as shown in the following figure:
[image: image47.png]bash-3.00# vi /usr/sbin/bosboot
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#1/usr/bin/ksh

exit 0
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Step 3 Uninstall or install UltraPath for AIX. For details, see the UltraPath for AIX User Guide.
Step 4 Restore the bosboot file.
   cp /usr/sbin/bosboot.bak /usr/sbin/bosboot
Step 5 Save the device configuration data.
   bosboot -a
[image: image48.png]



The bosboot –a command is executed to ensure restoration of the bosboot file. However, errors may occur because the links to the kernel file are incorrect. You can ignore the errors.
----End
2.7.2  Installation Fails Because of Absence of the bin User
2.7.2.4  Possible Cause
A file needs to be written to the /usr/lib/nls/msg/en_US directory during the installation of UltraPath for AIX, and this operation can be performed only by the bin user. After the lsuser bin command is executed on the host, however, 3004-687 User "bin" does not exist is displayed.
2.7.2.5  Solution
Step 1 Check the /etc/passwd file. If #bin:*:8:2::/bin:/usr/bin/ksh is displayed, the bin user is shielded. In this case, delete #.
Step 2 If the bin user does not exist, create a bin user, Run the smit user command, select Add a User, and create a bin user as shown in the following figure.Then reinstall UltraPath for AIX.
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----End
3  UltraPath for Windows Upgrade Guide
This section introduces how UltraPath for Windows is upgraded. Different versions vary in upgrade modes. For details, see the corresponding chapters.
3.1  UltraPath for Windows V100R003 Upgrade Guide
3.2  UltraPath for Windows V100R005 and Following Versions Upgrade Guide
3.1  UltraPath for Windows V100R003 Upgrade Guide
3.1.1  Upgrade Process Overview
1.Upgrade flowchart of UltraPath for Windows
Figure 3-1 Upgrade flowchart of UltraPath for Windows
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2.Procedure and required time for upgrading UltraPath for Windows
Table 3-1 Procedure and required time for upgrading UltraPath for Windows
	No.
	Upgrade Procedure
	Required Time
	Impact
	Remarks

	1
	Check whether the upgrade conditions are met.
	System services
	About 2 minutes
	None
	Mandatory

	
	
	Environment variables
	About 1 minute
	None
	Mandatory

	
	
	Running programs
	About 1 minute
	None
	Mandatory

	
	
	User account
	
	None
	Mandatory

	
	
	Installation files
	
	None
	Mandatory

	
	
	Rollback versions
	
	None
	Mandatory

	2
	Uninstall UltraPath software.
	About 3minutes
	None
	Mandatory

	3
	Install UltraPath software.
	About 3 minutes
	None
	Mandatory

	4
	Verify the upgrade.
	About 1 minute
	None
	Mandatory


The upgrade takes about 11 minutes.
3.1.2  Preparing for the Upgrade
3.1.2.2  Prerequisites
· The operator has the Windows operation experience.
· The operator has the administrator account and password of Windows.
· The hardware that runs the server program meets the basic requirements on UltraPath software (128 MB memory and 600 MB available disk space).
3.1.2.3  Obtaining the Installation Package of the UltraPath Software
· Log in to http://support.huawei.com/enterprise/ to obtain the UltraPath installation package.
[image: image51.png]



Log in to http://support.huawei.com/enterprise/ and choose Support > Software Download > Cloud Storage > Tools and Platform > UltraPath to obtain the installation package.
· Use a digital signature verification tool to verify the integrity of the installation package.
[image: image52.png]



To ensure the integrity of the software you obtained, use a software digital signature validation tool to verify it. To obtain the tool, log in to http://support.huawei.com/enterprise and choose Support > Tools. Search for software digital signature validation tool. Download the tool and start the verification. For details about how to verify software, see the guides released with the tool.
3.1.2.4  Obtaining the Installation Documents of the UltraPath Software
Table 3-2 Reference document
	Document
	Description

	OceanStor UltraPath 21.3.0 Release Notes
	Adjust the document based on site condition and deliver the document to the customer.


You can obtain the document by logging in to http://support.huawei.com/enterprise/ and choosing Support > Software Download > Cloud Storage > Tools and Platform > UltraPath.
[image: image53.png]



You must apply for the permission to obtain documentation from the website. If you are using http://support.huawei.com/enterprise/ for the first time, first register with the website. For details, see the website and FAQs.
3.1.2.5  Obtaining the Version Number of UltraPath for Windows
Double-click  [image: image54.png]Plensger



 on the desktop. The UltraPath for Windows Manager graphical user interface (GUI) is displayed. Click the Version tab. For example, as shown in the following figure, 3.01.016 is the version number.
Figure 3-2 UltraPath  V100R003 Version
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3.1.2.6  Preparing the Installation Package for Version Rollback
Prepare the installation package of the UltraPath that has been installed before the upgrade. If the upgrade fails, roll back to the previous version and quickly recover services.
3.1.2.7  Checking Windows Service Pack
For Windows Server 2003, Service Pack 2 has been installed.
Right-click My computer and choose Properties to check whether the system is 2003 SP2.
Figure 3-3 Windows 2003 Service Pack
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You are not required to check Service Pack for other system versions.
3.1.2.8  Checking Environment Variables
Variable name: Path
The variable must contain the following: %SystemRoot%\system32 or C:\windows\system32.
3.1.2.9  Checking HBA Models (Only Applicableto FC SAN)
For a Fibre Channel environment, make sure that the HBAs installed on one server are with the same model and are from the same manufacturer.
Choose Device Manager > SCSI and RAID controllers, and double-click the corresponding HBA to check its model information:
Figure 3-4 HBA Model
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3.1.2.10  Disable HBA's Failover Feature (Only Applicable to FC SAN)
For a Fibre Channel environment, make sure that the functions of failover and failback on HBA are disabled.
Use the management software provided by HBA manufacturer to check the status of the two functions. For example, use SANsurfer to check the QLogic that supports failover function (Please log on to the QLogic website, download the corresponding software based on your operating system), and choose Fibre Channel Configuration > File to check the function status. (If the HBA does not support the failover function, the Enable Failover Configuration option does not exist.)
Figure 3-5 Disabling the HBA failover feature
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3.1.2.11  Checking iSCSI Initiator (Only Applicable to iSCSI SAN)
For an iSCSI environment and in Windows Server 2003, make sure that the iSCSI initiator is installed. For Windows Server 2008 or later versions, the system is equipped with an iSCSI initiator by default. This check is not necessary.
Choose Uninstall or Remove Programs in Control Panel.
Figure 3-6 Checking iSCSI Initiator
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3.1.2.12  Checking iSCSI Initiator Version (Only Applicable to iSCSI SAN)
For an iSCSI environment, make sure that the version of the iSCSI initiator is 2.08 or later. (Please log on to the Microsoft website, choose the corresponding version based on your operating system.)
Choose Start > All Programs > Microsoft iSCSI Initiator > Release Notes, as shown in the following Figure 3-7.
Figure 3-7 Obtaining the information about the version of the iSCSI initiator
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In the text that is displayed, you can check the iSCSI version information, as shown in the following Figure 3-8.
Figure 3-8 Checking iSCSI Initiator Version
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If the iSCSI initiator version is not 2.08, the iSCSI initiator must be uninstalled and version 2.08 should be installed. During the installation process, do not select Microsoft MPIO MultiPathing Support for iSCSI, as shown in the following Figure 3-9.
Figure 3-9 Reinstalling New iSCSI Initiator
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For Windows Server 2008 (R2) or later versions, the preceding operation is not necessary.
3.1.2.13  Check the iSCSI-resident multipathing software (Only Applicable to iSCSI SAN).
In Windows Server 2003:
Go to Computer Management, and click Device Manager in the navigation tree. If iSCSI Multi-Path Device Specific Module can be found in the system device list on the right, the iSCSI-resident multipathing software has been installed and been enabled, as shown in the following Figure 3-10.
Figure 3-10 Checking iSCSI-resident multipathing software
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In this case, choose Start > Control Panel > Change or Remove Programs to uninstall the iSCSI initiator (make sure the corresponding installation package is available in the local computer, or download the installation package from the Microsoft website). Then reinstall the iSCSI Initiator.
Figure 3-11 Uninstall the iSCSI Initiator
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For Windows Server 2008 (R2) or later versions, skip this operation.
3.1.2.14  Stop Applications
Ask the customer engineer to stop all applications (such as database) on the server.
3.1.2.15  Transferring Cluster Resources (Only Applicable to SCSI-2 Cluster)
The Microsoft Clustering Service delivered with Windows Server 2003 is SCSI-2 cluster and that delivered with Windows Server 2008 or later is SCSi-3 cluster. In addition, there are other clusters. For details about cluster types, refer to their respective documents.
In an SCSI-2 cluster environment, before uninstalling UltraPath, transfer the disk resources on the node that you want to upgrade to the peer node in either of the following two fashions:
31. Obtain the customer's approval. Restart the local node (all disk resources on this node will be transferred to the peer node), and upgrade UltraPath on the local node. After that, restart the peer node (all disks resources will be transferred back to the local node), and then upgrade UltraPath on the remote node.
32. Ask the customer's engineers to transfer all the disk resources on the local node to the peer node in the cluster using cluster management software, and then upgrade UltraPath on the local end. Before uninstalling UltraPath on the peer node, transfer all the disk resources on the peer node to the local end. When transferring resources using cluster management software, you are advised to stop the cluster service on the local end first, wait the disk resources to be transferred to the remote peer node, start the cluster service on the local end again, and then upgrade UltraPath. This can ensure that all disk resources including quorum disks can be transferred to the peer node.
[image: image65.png]



In an SCSI-2 cluster environment, if you uninstall UltraPath without transferring cluster resources first, after uninstalling UltraPath, you need to run the clear persistent reserve command on the storage device so that the cluster service can work normally.
3.1.2.16  Recording LUN Information
33. Record the quantity of LUNs in the disk drive. 
Click the Server Manager icon on the taskbar, and click Device Manager in the navigation tree. In the View menu, click Show hidden devices, and record the quantity of virtual disks and physical disks in Disk Drives. (Disks with the word Multi-Path in their names are virtual disks.).
Figure 3-12 LUNs in Device Manager
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34. Record the quantity of LUNs in the UltraPath.
Double-click the [image: image67.png]Plensger



 icon on the desktop to start UPManager, and the following dialog box is displayed. Record the quantity of virtual disks and the quantity of their corresponding paths on the MPIOList tab page.
Figure 3-13 LUNs in UltraPath Console
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3.1.2.17  Closing Running Programs
Close all related programs before uninstall the UltraPath.
3.1.2.18  Recording CHAP Information (Only Applicable to iSCSI SAN)
In Windows Server 2003, start the ISCSI initiator, go to the ISCSI Initiator Property window, select a target connection, click the LogOn button, go to the Log On to Target window, and click the Advanced button. The following window is displayed. If CHAP logon information is selected, record the CHAP user name.
Figure 3-14 CHAP information on Windows Server 2003
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Operate in Windows Server 2008 R2 or later versions. Start the iSCSI initiator, go to the iSCSI Initiator Property window, select a target connection, click the Connect button, go to the Connect to Target window, and click the Advanced button. The following window is displayed. If Enable CHAP log on is selected, record the CHAP user name.
Figure 3-15 CHAP information on Windows Server 2008 R2 or later
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3.1.2.19  Deleting and Record iSCSI Configurations (Only Applicable to iSCSI SAN)
Start the iSCSI initiator and go to the configuration GUI.
35. On the Persistent Targets tab page, select the target that you want delete and click Remove.
Figure 3-16 Removing Persistent Targets
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36. On the Discovery tab page, select Target Portals.
[image: image72.png]



· Record all IP addresses and port information in Target Portals, which will be used in restoring IP address and port information after the upgrade is complete.
· Click Remove to remove all connections.
Figure 3-17 Removing Target Portals
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37. Click the Targets tab, select the target portal that you want to view and click Detail. In the dialog box that is displayed, select all sessions and click Log off.
Figure 3-18 Logging off Target
[image: image74.jpg]CSI Ini

or Properties
Gererel| Dissovety | Tatgels | ot Taigets | Bourdvo

Select  target and cick Log O o access the storage device
target. Cick detas to ses infomation abou the sessions, corn
devices for that targel.

Tagets

o |

Target Properties

sesirs |oavices | propates |

This target has the follawing sessions:

Idertfier

s

[-Session Properties

Target Portal Group: 1
Status: Comnected
Connertion Court; 1

[-Session Cannections

To configure how the connections within
this session are load balanced, clik.
Connections.

Comectons

ok | Con

oo |




[image: image75.png]



· In Windows Server 2003, the initiator may fail to be disconnected. In this case, you need to manually stop the iSCSI initiator service. Choose Start > Management Tool > Services, and go to the Services Page. Find Microsoft iSCSI Initiator Service, right-click it and choose Stop, as shown in the following figure. Disconnection is not necessary after the initiator service is stopped. Note that after the system is rebooted, check whether iSCSI initiator service automatically starts. If not, right-click it and choose Start.  
Figure 3-19 Stopping iSCSI Initiator Service
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3.1.3  Upgrade Scheme
3.1.3.20  Uninstalling the UltraPath Software
Description
To upgrade UltraPath software, you must first uninstall the earlier version to make the new version take effect.
Precautions
Check all items specified in section 3.1.2 

REF _EN-US_TOPIC_0120429067-chtext \h
Preparing for the Upgrade. In an SCSI-2 cluster environment, you must transfer cluster resources before uninstalling UltraPath. Do not open related programs during the uninstallation, and restart the host after the uninstallation is complete.
Prerequisites
Make sure that UltraPath software is installed on the host. If UltraPath software is not installed on the host, go to section 3.1.3.2 

REF _EN-US_TOPIC_0120429349-chtext \h
Installing the UltraPath Software.
Procedure
Step 1 Uninstall UltraPath software of the earlier version. Click Add or Remove Programs on the control panel. Click UltraPath software to be removed, and click Remove, as shown in the following Figure 3-20.
Figure 3-20 Uninstalling the UltraPath on the control panel
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Step 2 As the uninstalling process begins, execute the InstallShield Wizard first, as shown in the following Figure 3-21.
Figure 3-21 Wizard for uninstalling UltraPath for Windows
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Step 3 Ready to Uninstall the Program page is displayed. Click Uninstall, as shown in the following Figure 3-22.
Figure 3-22 Prompt for uninstalling
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Step 4 Uninstalling drivers and files begins. The uninstalling progress is displayed, as shown in the following Figure 3-23.
Figure 3-23 Progress of uninstalling UltraPath for Windows
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Step 5 A message is displayed indicating you need to restart host. Choose Yes, I want to restart my computer now and click Finish, as shown in the following Figure 3-24.
Figure 3-24 Prompt for restarting
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Step 6 If multiple users have logged in to the host, the host does not restart after you click the Restart button. In this case, you must manually restart the host. You can check whether multiple users have logged in to the host in the Windows task manager.
Figure 3-25 Viewing multiple users
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----End
Verification
After the host restarts, the shortcut of UltraPath is not displayed on the desktop and UltraPath disappeared from Add or Remove Programs in the control panel.
Troubleshooting
In case that the system fails to start after the host restarts, restart the system again manually and press F8 repeatedly during the restart process to enter the system startup options list. Select Last Known Good Configuration from the list to access the system.
3.1.3.21  Installing the UltraPath Software
Task Description
Install the new version of UltraPath software.
Precautions
Check all items specified in section 3.1.2 

REF _EN-US_TOPIC_0120429067-chtext \h
Preparing for the Upgrade. Do not perform other operations during the installation. Restart the host after the installation is complete.
Operation Procedure
Step 1 Double-click the installation package to start the installation. Execute the InstallShield Wizard first, as shown in the following Figure 3-26.
Figure 3-26 Wizard for installing UltraPath for Windows
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Step 2 Click Next, as shown in the following Figure 3-27.
Figure 3-27 Welcome page of UltraPath for Windows installation wizard
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Step 3 Enter your user name and company name and click Next, as shown in the following Figure 3-28.
Figure 3-28 Prompt for input of user information
[image: image86.png][V1traPath ~ InstallShield Wizard

Customer Information -

Flease enter yourinformation.

Please enter yout name and the name of the companyfor which you wark.

User Name:

[Wrdows el

Company Name:

InsalSHeld

<ok Cance





Step 4 Click Install to start the installation, as shown in the following Figure 3-29.
Figure 3-29 Starting installation of UltraPath for Windows
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Step 5 The installing progress is displayed, as shown in the following Figure 3-30.
Figure 3-30 Progress of installing UltraPath for Windows 1
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Figure 3-31 Progress of installing UltraPath for Windows 2
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Step 6 Click Finish to complete the installation, as shown in the following Figure 3-32.
Figure 3-32 Completing the installation of UltraPath for Windows
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Step 7 Click Next, and the system restarts automatically, as shown in the following Figure 3-33.
Figure 3-33 Prompt for restart
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----End
Result Verification
The shortcut of UltraPath software is displayed on the desktop. Double-click the icon and the UltraPath management interface is displayed without an anomaly prompt. Check the version in CLI which matches the current version.
Troubleshooting
In case that the system fails to start after the host restarts, restart the system again manually and press F8 repeatedly during the restart process to enter the system startup options list. Select Disable Driver Signature Enforcement to access the system. Uninstall UltraPath software and install the earlier version.
3.1.4  Verification and Restoring After the Upgrade
3.1.4.22  Verification Checklist
Table 3-3 Verification checklist for UltraPath for Windows
	No.
	Item
	Operation Command
	Standard

	1
	Check the version.
	Open UltraPath Console, choose Help ->about UltraPath Console, and the version information of the UltraPath is displayed; or, run the upadm show version command on the CLI.
	The returned version information matches the upgrade target version.

	2
	Restore iSCSI Initiator Configurations.
	Start the iSCSI initiator and go to the configuration page. Click the Discovery tab. On the tab page, click Add. In the dialog box that is displayed, enter the IP address of the iSCSI port recorded before the upgrade.
Click the Targets page. In the Targets: area, select the target recorded before the upgrade. Click Log On…. In the dialog box that is displayed, click OK.
	The configurations of iSCSI Initiators are restored according to the records.

	3
	Properly generate physical and virtual disks.
	Right-click My Computer and choose Manage from the shortcut menu. The Computer Management page is displayed.
Choose Device Manager > Disk drives, and right-click on the page and choose scan for hardware changes from the shortcut menu.
	The number of physical disks equals the number of virtual disks multiplied by the number of paths.

	4
	Check that the cluster can work.
	Ask the customer engineer to check whether the Cluster can run normally.
	The cluster function works.

	5
	Check that services that are stopped before the upgrade are running.
	Check that the system services, whose states are manually changed before upgrade, are recovered.
	The system services state manually changed before the upgrade are recovered.

	6
	Check that applications are normally running.
	Ask the customer engineer to check whether the applications (such as database) can run normally on the server.
	The applications (such as database) can run normally.


3.1.4.23  Checking the Version
Description
Check whether the current version is consistent with the one described in the release notes.
Precautions
The version information is available only after the installation is successfully complete.
Procedure
Step 1 Run the upadm show version command.
Step 2 Confirm that the version number displayed in step 1 is the same as the target version number.
----End
Result Verification
The returned UltraPath version is the desired one.
Troubleshooting
If failure occurs when querying the version, it indicates that the driver does not function. In this case, uninstall UltraPath software and install it again.
3.1.4.24  Restoring iSCSI Initiator Configurations (Only Applicable to iSCSI SAN)
Description
If the host iSCSI initiator configurations are deleted before the upgrade, perform the following operations to restore iSCSI configurations and to establish service connection between the host and the storage system. If the host iSCSI initiator configurations are not deleted, skip this section.
Precautions
The host iSCSI initiator configurations are deleted before the upgrade.
Procedure
38. Start the iSCSI initiator and go to the configuration GUI. Click the Discovery tab, click Add.The Add Target Portal dialog box is displayed.
Figure 3-34 Adding Target Portal 1
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39. Enter the iSCSI IP address recorded before the upgrade in the IP address or DNS name text box.
40. After confirming that the settings are correct, click OK. The information about the added target port can be viewed in the Target Portals group box.
Figure 3-35 Adding Target Portal 2
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41. Click the Targets tab, and the Status for the target added in the preceding step is Inactive.
Figure 3-36 Logging in to Target 1
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42. In the Targets group box, select the target that is recorded before the upgrade and click Log On... The Log On to Target dialog box is displayed.
Figure 3-37 Logging in to Target 2
[image: image95.png]Target name:

[1an:2006-05.comRmm—21 0000e0FcO00004:rokcorfia

IV Autometicallytestore this connection when the system boots

I™ Enable milioath

8 Orlyseect this option F SCST mukipath software i aeady Instaled
on you computer.

et L= =





[image: image96.png]



To enable the application server to continually access the storage system through this target port, select Automatically restore this connection when the system boots. Because once UltraPath is installed, Enable multi-path cannot be selected.
43. If CHAP information needs to be configured, go to the CHAP dialog box by following the steps in pre-upgrade preparations, enter the recorded CHAP user name and password, and click OK to go back to the Log On to Target dialog box.
44. Click OK to go back to the iSCSI Initiator Properties dialog box.
45. Click the Targets tab, and check whether Connected is displayed in Status. (If the connection is not successful, check whether the service cables are correctly connected, and repeat step 5 and step 7.)
Figure 3-38 Logging in to Target 3
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Verification
The configurations of iSCSI Initiators are restored according to the records.
Troubleshooting
If the iSCSI Initiator service is stopped before the upgrade, start this service.
3.1.4.25  LUNs Are Normally Presented
Description
Check whether the current UltraPath software can manage the disks to which the storage device maps.
Precautions
Recover all links and ensure that all links are normal.
Procedure
Step 1 In Device Manager, check whether the quantity of virtual disks and physical disks are the same with the quantity recorded before. (The following figure is used as an example only.)
Figure 3-39 Checking LUNs in Device Manager
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Step 2 Click LUN in UltraPath Console to check whether the quantity of virtual disks and the number of corresponding paths are the same with those recorded before upgrade.
Figure 3-40 Checking LUNs in UltraPath Console
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----End
Result Verification
Virtual disks are successfully generated. The quantity and capacity of virtual disks are consistent with those of LUNs mapped by storage devices.
Troubleshooting
If the quantity of virtual disks is incorrect or the status is abnormal, remove cables connecting the host and storage devices. Manually scan for disk drives. After all virtual disks are deleted, plug the cables and check the reported information.
3.1.4.26  Cluster Running Normally (Only Applicable to Cluster)
Ask the customer engineer to check whether the Cluster can run normally.
3.1.4.27  SystemServices' States Are Restored
Check whether the system services' states, which are manually changed before the upgrade, are restored.
3.1.4.28  Applications (such as Database) Are Running Normally
Ask the customer engineer to check whether the applications (such as database) can run normally on the server.
3.1.5  Rolling Back to the Source Version
3.1.5.29  Uninstalling the UltraPath Software
Description
In case that the newly-installed UltraPath software is unusable because of anomalies, uninstall it and install the earlier version.
Precautions
For details, see section 3.1.3.1 

REF _EN-US_TOPIC_0120429080-chtext \h
Uninstalling the UltraPath Software.
Operation Procedure
For details, see section 3.1.3.1 

REF _EN-US_TOPIC_0120429080-chtext \h
Uninstalling the UltraPath Software.
Result Verification
For details, see section 3.1.3.1 

REF _EN-US_TOPIC_0120429080-chtext \h
Uninstalling the UltraPath Software.
Troubleshooting
For details, see section 3.1.3.1 

REF _EN-US_TOPIC_0120429080-chtext \h
Uninstalling the UltraPath Software.
3.1.5.30  Installing the UltraPath Software of the Earlier Version
Description
Install UltraPath software of the earlier version.
Precautions
For details, see section 3.1.3.2 

REF _EN-US_TOPIC_0120429349-chtext \h
Installing the UltraPath Software.
Operation Procedure
For details, see section 3.1.3.2 

REF _EN-US_TOPIC_0120429349-chtext \h
Installing the UltraPath Software.
Result Verification
For details, see section 3.1.3.2 

REF _EN-US_TOPIC_0120429349-chtext \h
Installing the UltraPath Software.
Troubleshooting
For details, see section 3.1.3.2 

REF _EN-US_TOPIC_0120429349-chtext \h
Installing the UltraPath Software.
3.2  UltraPath for Windows V100R005 and Following Versions Upgrade Guide
3.2.1  Upgrade Process Overview
3.2.1.31  Upgrade Scheme 1 : Offline Upgrade
3.2.1.31.2  Indirect upgrade : Uninstall First, and then Install
Figure 3-41 Upgrade flowchart of UltraPath for Windows
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Table 3-4 Procedure and required time for upgrading UltraPath for Windows
	No.
	Upgrade Procedure
	Required Time
	Impact
	Remarks

	1
	Check whether the upgrade conditions are met.
	System services.
	About 2 minutes
	None
	Mandatory

	
	
	Environment variables.
	About 1 minute
	None
	Mandatory

	
	
	Running programs.
	About 1 minute
	None
	Mandatory

	
	
	User account.
	
	None
	Mandatory

	
	
	Installation files.
	
	None
	Mandatory

	
	
	Rollback versions.
	
	None
	Mandatory

	2
	Uninstall UltraPath software.
	About 3minutes
	None
	Mandatory

	3
	Install UltraPath software.
	About 3 minutes
	None
	Mandatory

	4
	Verify the upgrade.
	About 1 minute
	None
	Mandatory


The upgrade takes about 11 minutes.
3.2.1.31.3  Direct upgrade : Upgrade the software using the installation package
Figure 3-42 Upgrade flowchart of UltraPath for Windows
[image: image101.jpg]start

Upgrade conditions

See section 3.2.2

Yes

Upgrade Wizard

See section 3.2.4.1

Copy files

See section 3.2.4.1

L1

No

[ Check kernel version to make

‘whether need restart

See section 3.2.4.1

Restart host

See section 3.2.4.1

T
Yes
v

No

Whether install success

See section 3.2.6

No»|

Roll back

See section 3.2.7

Yes

e

End

D





Table 3-5 Procedure and required time for upgrading UltraPath for Windows
	No.
	Upgrade Procedure
	Required Time
	Impact
	Remarks

	1
	Check whether the upgrade conditions are met.
	System services.
	About 2 minutes
	None
	Mandatory

	
	
	Running programs.
	About 1 minute
	None
	Mandatory

	
	
	User account.
	
	None
	Mandatory

	
	
	Installation files.
	
	None
	Mandatory

	
	
	Rollback versions.
	
	None
	Mandatory

	2
	Upgrade the UltraPath.
	About 2 minutes
	None
	Mandatory

	3
	Verify the upgrade.
	About 1 minute
	None
	Mandatory


The upgrade takes about 6 minutes.
3.2.1.32  Upgrade Scheme 2 : Online Upgrade
Figure 3-43 Upgrade flowchart of the UltraPath using the new version
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Table 3-6 Procedure and required time for upgrading UltraPath for Windows
	No.
	Upgrade Procedure
	Required Time
	Impact
	Mandatory or Not

	1
	Check whether the upgrade conditions are met.
	System services.
	About 2 minutes
	Yes
	Mandatory

	
	
	Running programs.
	About 1 minute
	None
	Mandatory

	
	
	User account.
	
	None
	Mandatory

	
	
	Installation files.
	
	None
	Mandatory

	
	
	Rollback versions.
	
	None
	Mandatory

	2
	Upgrade the UltraPath.
	About 2 minutes
	None
	Mandatory

	3
	Activate the new version
	About 1-10 minutes
	Yes
	Mandatory

	4
	Verify the upgrade.
	About 1 minute
	None
	Mandatory


The whole upgrade process takes about 7 to 16 minutes.
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Online upgrade can only be performed for upgrading a previous version of UltraPath for Windows V100R008C00 or V100R008C20 or V100R008C30 to the latest version of UltraPath for Windows V100R008C30 or Windows V100R008C00 or V100R008C20 or V100R008C30 or V100R008C50 or 21.0.1 or 21.0.2 or 21.1.0 or 21.2.0 or 21.3.RCx (x is an integer starting from 1 and the version number is 21.3.RCx for short.) to the latest version of UltraPath for Windows 21.3.0.
3.2.2  Preparing for the Upgrade
3.2.2.33  Prerequisites
· The operator has the Windows operation experience.
· The operator has the administrator account and password of Windows.
· The hardware that runs the server program meets the basic requirements on UltraPath software (128 MB memory and 600 MB available disk space).
· The target 21.3.0 version supports the online upgrade from the current V100R008C00/V100R008C20/V100R008C30/V100R008C50/21.0.1/21.1.0 /21.2.0/21.3.RCx version.
· All links are normal before the upgrade, and faulty or degraded paths do not exist.
· Upgrade the software at off-peak hours.
· Do not perform online upgrade when the CPU is running with full load.
· Do not perfrom online upgrade when the host has the single controller alarm.
· The takeover-online environment cannot support the online upgrade.
3.2.2.34  Obtaining the Installation Package of the UltraPath Software
· Log in to http://support.huawei.com/enterprise/ to obtain the UltraPath installation package.
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Log in to http://support.huawei.com/enterprise/ and choose Support > Software Download > Cloud Storage > Tools and Platform > UltraPath to obtain the installation package.
· Use a digital signature verification tool to verify the integrity of the installation package.
[image: image105.png]



To ensure the integrity of the software you obtained, use a software digital signature validation tool to verify it. To obtain the tool, log in to http://support.huawei.com/enterprise and choose Support > Tools. Search for software digital signature validation tool. Download the tool and start the verification. For details about how to verify software, see the guides released with the tool.
3.2.2.35  Obtaining the Installation Documents of the UltraPath Software
Table 3-7 Reference document
	Document
	Description

	OceanStor UltraPath 21.3.0 Release Notes
	Adjust the document based on site condition and deliver the document to the customer.


You can obtain the document by logging in to http://support.huawei.com/enterprise/ and choosing Support > Software Download > Cloud Storage > Tools and Platform > UltraPath.
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You must apply for the permission to obtain documentation from the website. If you are using http://support.huawei.com/enterprise/ for the first time, first register with the website. For details, see the website and FAQs.
3.2.2.36  Obtaining the Version Number of UltraPath for Windows
Double-click  [image: image107.png]trsPath
Console



 on the desktop. The UltraPath for Windows Manager GUI is displayed. Click Help on the menu bar and click About UltraPath Console (A). For example, as shown in the following figure, 5.01.048 is the version number.
Figure 3-44 UltraPath V100R005 Version
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Product version is displayed for UltraPath for Windows V100R008C50. For example, as shown in the following figure, V100R008C50 is the product version.
Figure 3-45 UltraPath V100R008C50 Product Version
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3.2.2.37  Preparing the Installation Package for Version Rollback
Prepare the installation package of the UltraPath that has been installed before the upgrade. If the upgrade fails, roll back to the previous version and quickly recover services.
3.2.2.38  Checking Windows Service Pack
For Windows Server 2003, Service Pack 2 has been installed.
Right-click My computer and choose Properties to check whether the system is 2003 SP2.
Figure 3-46 Windows 2003 Service Pack
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For Windows 7, Service Pack 1 has been installed.
Right-click My computer and choose Properties to check whether the system is Windows 7 SP1.
Figure 3-47 Windows 7 Service Pack
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You are not required to check Service Pack for other system versions.
3.2.2.39  Checking Environment Variables
Variable name: Path
The variable must contain the following: %SystemRoot%\system32 or C:\windows\system32.
3.2.2.40  Checking HBA Models (Only Applicable to FC SAN)
For a Fibre Channel environment, make sure that the HBAs installed on one server are with the same model and are from the same manufacturer.
Choose Device Manager > SCSI and RAID controllers, and double-click the corresponding HBA to check its model information:
Figure 3-48 HBA Model
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3.2.2.41  Disable HBA's Failover Feature (Only Applicable to FC SAN)
For a Fibre Channel environment, make sure that the functions of failover and failback on HBA are disabled.
Use the management software provided by HBA manufacturer to check the status of the two functions. For example, use SANsurfer to check the QLogic that supports failover function (Please log on to the QLogic website, download the corresponding software based on your operating system), and choose Fibre Channel Configuration > File to check the function status. (If the HBA does not support the failover function, the Enable Failover Configuration option does not exist.)
Figure 3-49 Disabling the HBA failover feature
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3.2.2.42  Checking iSCSI Initiator (Only Applicable to iSCSI SAN)
For an iSCSI environment and in Windows Server 2003, make sure that the iSCSI initiator is installed. For Windows Server 2008 (R2) or later versions, the system is equipped with an iSCSI initiator by default. This check is not necessary.
Choose Uninstall or Remove Programs in Control Panel.
Figure 3-50 Checking iSCSI Initiator
[image: image114.png]



3.2.2.43  Checking iSCSI Initiator Version (Only Applicable to iSCSI SAN)
For an iSCSI environment, make sure that the version of the iSCSI initiator is 2.08 or later. (Please log on to the Microsoft website, choose the corresponding version based on your operating system.)
Choose Start > All Programs > Microsoft iSCSI Initiator > Release Notes.
Figure 3-51 Obtaining the information about the version of the iSCSI initiator
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In the text that is displayed, you can check the iSCSI version information.
Figure 3-52 Checking iSCSI Initiator Version
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If the iSCSI initiator version is not 2.08, the iSCSI initiator must be uninstalled and version 2.08 should be installed. During the installation process, do not select Microsoft MPIO MultiPathing Support for iSCSI.
Figure 3-53 Reinstalling the new iSCSI Initiator
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For Windows Server 2008 (R2) or later versions, the preceding operation is not necessary.
3.2.2.44  Stop Applications
Ask the customer engineer to stop all applications (such as database) on the server.
[image: image118.png]



This procedure is applicable to two service upgrade modes requiring service interruption in solution 1, not applicable to solution 2 that requires online upgrade and no service interruption.
3.2.2.45  Transferring Cluster Resources (Only Applicable to SCSI-2 Cluster)
The Microsoft Clustering Service delivered with Windows Server 2003 is SCSI-2 cluster and that delivered with Windows Server 2008 or later is SCSi-3 cluster. In addition, there are other clusters. For details about cluster types, refer to their respective documents.
In an SCSI-2 cluster environment, before uninstalling UltraPath, transfer the disk resources on the node that you want to upgrade to the peer node in either of the following two fashions:
46. Obtain the customer's approval. Restart the local node (all disk resources on this node will be transferred to the peer node), and upgrade UltraPath on the local node. After that, restart the peer node (all disks resources will be transferred back to the local node), and then upgrade UltraPath on the remote node.
47. Ask the customer's engineers to transfer all the disk resources on the local node to the peer node in the cluster using cluster management software, and then upgrade UltraPath on the local end. Before uninstalling UltraPath on the peer node, transfer all the disk resources on the peer node to the local end. When transferring resources using cluster management software, you are advised to stop the cluster service on the local end first, wait the disk resources to be transferred to the remote peer node, start the cluster service on the local end again, and then upgrade UltraPath. This can ensure that all disk resources including quorum disks can be transferred to the peer node.
[image: image119.png]



In an SCSI-2 cluster environment, if you uninstall UltraPath without transferring cluster resources first, after uninstalling UltraPath, you need to run the clear persistent reserve command on the storage device so that the cluster service can work normally.
3.2.2.46  Recording LUN Information
48. Record the quantity of LUNs in the disk drive.
Right-click My Computer and choose Manage. The Computer Management window is displayed. Enable Device manager on the View menu, click Show hidden devices, and record the quantity of virtual disks and physical disks. UltraPath_Disk is the virtual disk for V100R008 UltraPath management, and disks with the word Multi_Path in their names are MPIO management virtual disks, whose quantity is the same with that of UltraPath_Disk.
Figure 3-54 LUNs in Device Manager
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49. Record the number of LUNs in UltraPath
Double-click the icon [image: image121.png]trsPath
Console



 to enable UltraPath Console. The following dialog box is displayed. Click LUN in the navigation tree on the left, and record the quantity of active virtual disks and the quantity of corresponding paths.
Figure 3-55 LUNs in UltraPath Console
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3.2.2.47  Closing Running Programs
You need to stop the services related to UltraPath before the uninstallation or upgrade, for example, the UltraPath management page.
3.2.2.48  Recording CHAP Information (Only Applicable to iSCSI SAN)
In Windows Server 2003, start the ISCSI initiator, go to the ISCSI Initiator Property window, select a target connection, click the LogOn button, go to the Log On to Target window, and click the Advanced button. The following window is displayed. If CHAP logon information is selected, record the CHAP user name.
Figure 3-56 CHAP information on WIndows Server 2003
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Operate in Windows Server 2008 R2 or later versions. Start the iSCSI initiator, go to the iSCSI Initiator Property window, select a target connection, click the Connect button, go to the Connect to Target window, and click the Advanced button. The following window is displayed. If Enable CHAP log on is selected, record the CHAP user name.
Figure 3-57 CHAP information on WIndows Server 2008 R2 or later
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3.2.3  Upgrade Scheme 1 : Offline Upgrade
3.2.3.49  Indirect upgrade : Uninstall First, and then Install
3.2.3.49.4  Uninstalling the UltraPath Software
Description
To upgrade UltraPath software, you must first uninstall the earlier version to make the new version take effect.
Precautions
Check all items specified in section 3.2.2 

REF _EN-US_TOPIC_0120429389-chtext \h
Preparing for the Upgrade. In an SCSI-2 cluster environment, you must transfer cluster resources before uninstalling UltraPath. Do not open related programs during the uninstallation, and restart the host after the uninstallation is complete.
Prerequisites
Make sure that UltraPath software is installed on the host. If UltraPath software is not installed on the host, go to section 3.2.3.1.2 

REF _EN-US_TOPIC_0120429264-chtext \h
Installing the UltraPath Software.
Operation Procedure
Step 1 Uninstall UltraPath software of the earlier version. Click Add or Remove Programs on the control panel. Click UltraPath software to be removed, and click Remove.
Figure 3-58 Uninstalling the UltraPath on the control panel
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Step 2 As the uninstalling process begins, execute the InstallShield Wizard first.
Figure 3-59 Wizard for uninstalling UltraPath for Windows
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Step 3 A message is displayed stating "Do you want to completely remove the selected application and all of its features?" Click "Yes."
Figure 3-60 Prompt for uninstalling
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Step 4 Uninstall drivers and files. The uninstalling progress is displayed.
Figure 3-61 Progress of uninstalling UltraPath for Windows 1
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Figure 3-62 Progress of uninstalling UltraPath for Windows 2
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Step 5 After InstallShield Wizard has finished uninstalling the UltraPath, click Finish.
Figure 3-63 Uninstalling complete
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Step 6 A message is displayed indicating the host needs to be restarted. Select Yes, I want to restart my computer now. and click Next.
Figure 3-64 Prompt for restarting
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Step 7 If multiple users have logged in to the host, the host does not restart after you click the Restart button. In this case, you must manually restart the host. You can check whether multiple users have logged in to the host in the Windows task manager.
Figure 3-65 Multiple Users
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----End
Verification
After the host restarts, the shortcut of UltraPath is not displayed on the desktop and UltraPath disappeared from Add or Remove Programs in the control panel.
Troubleshooting
In case that the system fails to start after the host restarts, restart the system again manually and press F8 repeatedly during the restart process to enter the system startup options list. Select Last Known Good Configuration from the list to access the system.
3.2.3.49.5  Installing the UltraPath Software
Description
Install the new version of UltraPath software.
Precautions
Check all items specified in section 3.2.2 

REF _EN-US_TOPIC_0120429389-chtext \h
Preparing for the Upgrade. Do not do other operations during the installation. Restart the host after the installation is complete.
Procedure
Step 1 Double-click the installation package to start the installation. Execute the InstallShield Wizard first.
Figure 3-66 Wizard for installing UltraPath for Windows
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Step 2 Click Next.
Figure 3-67 Welcome page of UltraPath for Windows installation wizard
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Step 3 Enter your user name and company name and click Next.
Figure 3-68 Prompt for input of user information
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Step 4 Click Install.
Figure 3-69 Starting installation of UltraPath for Windows
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Step 5 The installing progress is displayed.
Figure 3-70 Progress of installing UltraPath for Windows 1
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Figure 3-71 Progress of installing UltraPath for Windows 2
[image: image138.png]UltraPath

instaliShield Wizard

Setup Status

The InstalShield Wizard s insaling UlraPath

Instaling rsup divers, please waiting.

IstalSHeld





Step 6 Click Finish to complete the installation.
Figure 3-72 Completing the installation of UltraPath for Windows
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Step 7 Click Next. The system restarts automatically.
Figure 3-73 Prompt for restarting
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----End
Verification
The shortcut of UltraPath software is displayed on the desktop. Double-click the icon. The UltraPath management interface is displayed without an anomaly prompt. Check the version in CLI which matches the current version.
Troubleshooting
In case that the system fails to start after the host restarts, restart the system again manually and press F8 repeatedly during the restart process to enter the system startup options list. Select Disable Driver Signature Enforcement to access the system. Uninstall UltraPath software and install the earlier version.
3.2.3.50  Direct upgrade : Upgrade the software using the installation package
3.2.3.50.6  Upgrading the UltraPath Software from V100R008C00 or V100R008C20 or V100R008C30 or V100R008C50 or 21.0.1 or 21.0.2 or 21.1.0 or 21.2.0 or 21.3.RCx to this version
Description
The major assignment to upgrade the UltraPath is to replace previous files and make the new files take effect.
Precautions
Check all items specified in section 3.2.2 

REF _EN-US_TOPIC_0120429389-chtext \h
Preparing for the Upgrade. In an SCSI-2 cluster environment, you must transfer cluster resources before upgrading UltraPath. Do not open related programs during the upgrade. Restart the host as prompted.
Prerequisites
Make sure that UltraPath software is installed on the host.
Operation Procedure
Step 1 Double-click the package andclick Yes.
Figure 3-74 Setup will perform an upgrade of 'UltraPath'
[image: image141.png]UltraPath - InstallShield Wizard

0 This setup will perform an upgrade of ‘UltraPath’. Do you want to
continue?





Step 2 As the upgrading process begins, execute the InstallShield Wizard first.
Figure 3-75 Wizard for upgrading UltraPath for Windows
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Step 3 Click Next.
Figure 3-76 Starting the upgrade of UltraPath
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Figure 3-77 Progress of upgrading UltraPath
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Step 4 Setup will perform offline upgrade and click Yes, as shown in Figure 3-78. (This step is necessary only when you need to upgrade from a V100R008, 21.0.1, 21.0.2, 21.1.0, 21.2.0 or 21.3.RCx version to 21.3.0 version.)
Figure 3-78 Upgrading step 3 for Windows UltraPath
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Step 5 After the upgrade is complete, click Finish.
Figure 3-79 Upgrading complete
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Step 6 If drivers need to be upgraded, you are prompted to restart the host. Choose Yes, I want to restart my computer now and click Next.
Figure 3-80 Prompt for restarting
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----End
Verification
After the upgrade, the shortcut of UltraPath is not displayed on the desktop and UltraPath disappeared from Add or Remove Programs in the control panel.
Troubleshooting
In case that the system fails to start after the host restarts, restart the system again manually and press F8 repeatedly during the restart process to enter the system startup options list. Select Last Known Good Configuration from the list to access the system.
3.2.3.50.7  Upgrading the UltraPath Software from V100R005/V100R006 Version to this Version
Description
The major assignment to upgrade the UltraPath is to replace previous files and make the new files take effect. This section introduces the function to upgrade from V100R005/V100R006 version to this version.
Precautions
Check all items specified in section 3.2.2 

REF _EN-US_TOPIC_0120429389-chtext \h
Preparing for the Upgrade. Do not open related programs during the upgrade. Restart the host as prompted.
Prerequisites
Make sure that UltraPath software is installed on the host. If UltraPath software is not installed on the host, go to "Installing the UltraPath Software" of the section 3.2.3.1.2 

REF _EN-US_TOPIC_0120429264-chtext \h
Installing the UltraPath Software.
Procedure
Step 1 Double-click package and click Next.
Figure 3-81 Installing InstallShield Wizard
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Step 2 Enter the company name and click Next.
Figure 3-82 Entering the company name
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Step 3 Click Install.
Figure 3-83 Starting the upgrade of UltraPath
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Figure 3-84 Progress of upgrading UltraPath
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Step 4 After the upgrade is complete, click Finish.
Figure 3-85 Upgrading complete
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Step 5 If drivers need to be upgraded, you are prompted to restart the host. Choose Yes, I want to restart my computer now and click Next.
Figure 3-86 Prompt for restarting
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----End
Verification
After the upgrade, the shortcut of UltraPath is not displayed on the desktop and UltraPath disappeared from Add or Remove Programs in the control panel.
Troubleshooting
In case that the system fails to start after the host restarts, restart the system again manually and press F8 repeatedly during the restart process to enter the system startup options list. Select Last Known Good Configuration from the list to access the system.
3.2.4  Upgrade Scheme 2 : Online Upgrade
3.2.4.51  Upgrading the UltraPath Software
Description
If a non-disruptive upgrade is performed, new files replace existing files and take effect. Besides, the original UltraPath configuration is inherited.
Precautions
Check all items specified in section 3.2.2 

REF _EN-US_TOPIC_0120429389-chtext \h
Preparing for the Upgrade. Do not open related programs during the upgrade. Only V100R008C00 and V100R008C20 and V100R008C30 and V100R008C50 and 21.0.1 and 21.0.2 and 21.1.0 and 21.2.0 and 21.3.RCx can be upgraded to this version non-disruptively. Ensure that the installation package and the Upgrade folder are under the same directory.
Prerequisites
Make sure that UltraPath software is installed on the host. If UltraPath software is not installed on the host, go to "Installing the UltraPath Software" of the section 3.2.3.1.2 

REF _EN-US_TOPIC_0120429264-chtext \h
Installing the UltraPath Software.
Procedure
Step 1 Check whether there are physical disks that UltraPath does not take control of. If there is a physical disk that UltraPath does not take control of, refer to OceanStor UltraPath X.X.X Version Configuration Information Form 01.xls to check whether the disk is in the UltraPath support list. If the disk is in the list, stop its services, remove its mapping relationship with the host, and then perform online upgrade. The following provides a detailed method:
1 Right-click My Computer and choose Manage. The Computer Management window is displayed. Open Device Manager. In the Disk drives list, check whether there are physical disks that UltraPath does not take control of. (UltraPath_Disk indicates a virtual disk that UltraPath manages. See Figure 3-87. If there is no UltraPath_Disk, right-click a physical disk, choose Properties, and click the Details tab. Select Device Instance Path and check whether the value contains UPIO before the first slash (\) and ULTRAPATH before the second slash. If the value contains these two key words, the disk is an UltraPath virtual disk; otherwise, the disk is not the virtual disk. See Figure 3-88. If UltraPath takes control of all physical disks, go to step 2 to perform online upgrade.
[image: image154.png]



Before checking for the physical disks, right-click My Computer and choose Manage. The Computer Management Window is displayed. Open Device Manager, and in the View menu, check whether the Show hidden devices option is selected. If it is selected, deselect it.
Figure 3-87 Checking for UltraPath physical disks
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Figure 3-88 Checking for UltraPath virtual disks
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2 If there is a physical disk that UltraPath does not take control of, right-click the disk and choose Properties. On the Details tab page, select Device Instance Path,and record the Vendor ID and Product ID of the disk. (Vendor ID is the parameter after VEN_ and Product ID is the parameter after PROD_. In Figure 3-86, Vendor ID is HUAWEI and Product ID is S2600T.
Figure 3-89 Vendor ID and product ID of physical disk
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3 Refer to OceanStor UltraPath X.X.X Version Configuration Information Form 01.xls to check whether Vendor ID and Product ID are in the UltraPath support list If they are in the support list, stop the services between the host and physical disk, disconnect the link between them, and then perform online upgrade.
Step 2 Run package in cmd with parameter of online upgrade. For example, run package in cmd:
UltraPath-21.01.003.exe /z"UPMODE:NDU | CPU:cpuvalue | MEMORY:memoryvalue | SPACE:spacevalue"
Table 3-8 Parameters that can be specified by users during the online upgrade
	Optional Parameter Name
	Parameter Function
	Description

	UPMODE:NDU
	Enables the online upgrade mode.
	None.

	CPU:cpuvalue
	Set the maximum CPU usage for an online upgrade.
	The value ranges from 0 to 100.
Default value:80

	MEMORY:memoryvalue
	Set the minimum system memory for an online upgrade.
	Unit: MB.
Default value:200

	SPACE:spacevalue
	Set the minimum system disk capacity for an online upgrade.
	Unit: MB.
Default value:1024


Step 3 Double-click package and click Yes, as shown in the following Figure 3-90.
Figure 3-90 Setup will perform an upgrade of 'UltraPath'
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Step 4 As the upgrading process begins, execute the InstallShield Wizard first, as shown in the following .Figure 3-91
Figure 3-91 Wizard for upgrading UltraPath for Windows
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Step 5 Click Yes to confirm the upgrade, as shown in the following Figure 3-92.
Figure 3-92 Setup will perform a non-disruptive upgrade of  'UltraPath'
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Step 6 Click Next.
Figure 3-93 Start the upgrading of UltraPath
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Figure 3-94 Progress of upgrading UltraPath
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Step 7 Click Finish to complete the upgrade, as shown in Figure 3-95. By this step, the whole online upgrade process is complete.
Figure 3-95 Upgrading complete
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Step 8 If there is a physical disk that UltraPath does not take control of, and the disk is in the UltraPath support list (see OceanStor UltraPath X.X.X Version Configuration Information Form 01.xls), add the physical device that has been disconnected from the host in step 1 to the host again.
----End
Verification
After the upgrade, the shortcut of UltraPath is not displayed on the desktop and UltraPath disappeared from Add or Remove Programs in the control panel.
Troubleshooting
In case that the system fails to start after the host restarts, restart the system again manually and press F8 repeatedly during the restart process to enter the system startup options list. Select Last Known Good Configuration from the list to access the system.
3.2.5  Verifying and Restoring after Upgrade
3.2.5.52  Verification Checklist
Table 3-9 Verification checklist for UltraPath for Windows
	No.
	Item
	Operation Command
	Standard

	1
	Check the version.
	Open UltraPath Console,choose Help ->about UltraPath Console, and the version information of the UltraPath is displayed; or, run the upadm show version command on the CLI.
	The returned version information matches the upgrade target version.

	2
	Properly generate physical and virtual disks.
	Right-click My Computer and choose Manage from the shortcut menu. The Computer Management page is displayed.
Choose Device Manager > Disk drives, and right-click on the page and choose scan for hardware changes from the shortcut menu.
	The number of physical disks equals the number of virtual disks multiplied by the number of paths.

	3
	Check that the Cluster can work properly.
	Ask the customer engineer to check whether the Cluster can run normally.
	The Cluster Function Works.

	4
	Check that system services are running.
	Checking whether the system services, whose states are manually changed before upgrade, are restored.
	The system services state manually changed before upgrade are restored.

	5
	Check that applications are normally running.
	Ask the customer engineer to check whether the applications (such as database) can run normally on the server.
	The applications (such as database) can run normally.


3.2.5.53  Checking the Version
Description
Check whether the current version is consistent with the one described in the release notes.
Precautions
The version information can be viewed only after the installation succeeds.
Procedure
Step 1 Run the upadm show version command.
Step 2 Confirm that the version number displayed in step 1 is the same as the target version number.
----End
Verification
The returned UltraPath version is the desired one.
Troubleshooting
If failure occurs when querying the version, it indicates that the driver does not function. In this case, uninstall UltraPath software and install it again.
3.2.5.54  LUNs Are Normally Presented
Description
Check whether the current UltraPath software can manage the disks to which the storage device maps.
Precautions
Recover all links and ensure that all links are normal.
Procedure
Step 1 In Device Manager, check whether the quantity of virtual disks and physical disks are the same with the quantity recorded before. (The following Figure 3-96 is used as an example only.)
Figure 3-96 Checking LUNs in Device Manager
[image: image164.png]
Step 2 Click LUN in UltraPath Console to check whether the quantity of virtual disks and the number of corresponding paths are the same with those recorded before upgrade.
Figure 3-97 Checking LUNs in UltraPath Console
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----End
Verification
Virtual disks are successfully generated. The quantity and capacity of virtual disks are consistent with those of LUNs mapped by storage devices.
Troubleshooting
If the quantity of virtual disks is incorrect or the status is abnormal, remove cables connecting the host and storage devices. Manually scan for disk drives. After all virtual disks are deleted, plug the cables and check the reported information.
3.2.5.55  Cluster Running Normally (Only Applicable to Cluster)
Ask the customer engineer to check whether the Cluster can run normally.
3.2.5.56  SystemServices' States Are Restored
Check whether the system services' states, which are manually changed before the upgrade, are restored.
3.2.5.57  Applications (such as Database) Are Normally Running
Ask the customer engineer to check whether the applications (such as database) can run normally on the server.
3.2.6  Rolling Back to the Source Version
3.2.6.58  Uninstalling the UltraPath Software
Description
In case that the newly-installed UltraPath software is unusable because of anomalies, uninstall it and install the earlier version.
Precautions
For details, see section 3.2.3.1.1 

REF _EN-US_TOPIC_0120429452-chtext \h
Uninstalling the UltraPath Software.
Operation Procedure
For details, see section 3.2.3.1.1 

REF _EN-US_TOPIC_0120429452-chtext \h
Uninstalling the UltraPath Software.
Result Verification
For details, see section 3.2.3.1.1 

REF _EN-US_TOPIC_0120429452-chtext \h
Uninstalling the UltraPath Software.
Troubleshooting
For details, see section 3.2.3.1.1 

REF _EN-US_TOPIC_0120429452-chtext \h
Uninstalling the UltraPath Software.
3.2.6.59  Installing the UltraPath Software of the Earlier Version
Description
Install UltraPath software of the earlier version.
Precautions
For details, see section 3.2.3.1.2 

REF _EN-US_TOPIC_0120429264-chtext \h
Installing the UltraPath Software.
Operation Procedure
For details, see section 3.2.3.1.2 

REF _EN-US_TOPIC_0120429264-chtext \h
Installing the UltraPath Software.
Result Verification
For details, see section 3.2.3.1.2 

REF _EN-US_TOPIC_0120429264-chtext \h
Installing the UltraPath Software.
Troubleshooting
For details, see section 3.2.3.1.2 

REF _EN-US_TOPIC_0120429264-chtext \h
Installing the UltraPath Software.
4  UltraPath for Solaris Upgrade Guide
UltraPath for Solaris only supports offline upgrade. Offline upgrade includes two schemes: indirect upgrade and direct upgrade.
4.1  Upgrade Scheme 1 : Indirect upgrade
4.2  Upgrade Scheme 2 : Direct upgrade
4.1  Upgrade Scheme 1 : Indirect upgrade
Uninstall the UltraPath in the operating system first, restart the server, and then install UltraPath of the new version.
4.1.1  Upgrade Process Overview
4.1.1.1  Flowchart
Figure 4-1 Flowchart of upgrading UltraPath for Solaris
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4.1.1.2  Upgrade Procedure and Required Time
Table 4-1 Upgrade procedure and required time
	No.
	Operation
	Required Time
	Impact
	Remarks

	1
	Uninstall the current version of UltraPath software.
	About 3 minutes
	The system services are interrupted.
	Mandatory

	2
	Install the new version of UltraPath software.
	About 3 minutes
	The upgrade takes effect only after the system is restarted.
	Mandatory

	3
	Verify that the upgrade is successful.
	About 3 minutes
	None.
	Mandatory


4.1.2  Preparing for the Upgrade
4.1.2.3  Prerequisites
· The operator has experience in handling the SUN Solaris operating system.
· The operator has the super user (root) permission on the Solaris operating system and must be the one predefined in the system instead of being created by users.
· The operating system is the Solaris 10 or Solaris11 based on the SPARC architecture.
4.1.2.4  Obtaining Upgrade Tools
The following table lists the tools required for upgrading UltraPath.
	Name
	Download Address
	Remarks

	Secure Shell (SSH)
	http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
	You can use this tool to remotely log in to the server on which you want to upgrade UltraPath.

	Secure File Transfer Protocol (SFTP) tool
	http://www.coreftp.com/server/download/msftpsrvr.exe
	You can use this tool to upload the UltraPath software package.
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If copyright is involved, obtain tools by yourself. For details, contact Huawei technical support engineers.
4.1.2.5  Obtaining Reference Documents for the Upgrade
Table 4-2 Reference document
	Document
	Description

	OceanStor UltraPath 21.3.0 Release Notes
	Adjust the document based on site condition and deliver the document to the customer.


You can obtain the document by logging in to http://support.huawei.com/enterprise/ and choosing Support > Software Download > Cloud Storage > Tools and Platform > UltraPath.
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You must apply for the permission to obtain documentation from the website. If you are using http://support.huawei.com/enterprise/ for the first time, first register with the website. For details, see the website and FAQs.
4.1.2.6  Obtaining Upgrade Software
· Log in to http://support.huawei.com/enterprise/ to obtain the UltraPath installation package.
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Log in to http://support.huawei.com/enterprise/ and choose Support > Software Download > Cloud Storage > Tools and Platform > UltraPath to obtain the installation package.
· Use a digital signature verification tool to verify the integrity of the installation package.
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To ensure the integrity of the software you obtained, use a software digital signature validation tool to verify it. To obtain the tool, log in to http://support.huawei.com/enterprise and choose Support > Tools. Search for software digital signature validation tool. Download the tool and start the verification. For details about how to verify software, see the guides released with the tool.
4.1.2.7  Preparing the Installation Package for Version Rollback
Prepare the installation package of the UltraPath that has been installed before the upgrade. If the upgrade fails, roll back to the previous version and quickly recover services.
4.1.2.8  Checking the Environment Before the Upgrade
Purpose
Verify that the environment meets the requirement before the upgrade.
Precautions
None.
Procedure
Step 1 Verify that the current operating system is UltraPath for Solaris and its functions work properly.
Step 2 Verify that the /opt directory on the server has 200 MB free space at least.
#df -h   
Filesystem     MB blocks   Free %Used   Iused %Iused Mounted on  /dev/hd10opt    2048.00    1852.50   10%  2333   1%   /opt
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If the free space is insufficient, run the chfs -a size=+10M /opt command to expand the capacity of the /opt directory.
----End
4.1.3  Performing the Upgrade
This section provides the procedure for upgrading UltraPath for Solaris.
4.1.3.9  Stopping Services
Task Description
The upgrade process needs to restart the host. This interrupts the services. In order to prevent the loss of service data, upgrade the UltraPath at off-peak hours or migrate services to other servers before the upgrade.
Precautions
If you run the database, stop the database services. If the host link exists to the storage device, and unloading multipathing software will cause drive letter changes, which may affect the upper application, it is recommended that all links are disconnected in the process of upgrading . After the uninstallation and before the new UltraPath is installed, do not install any other drives. Otherwise, the UltraPath drive number may be occupied and drive letters may change.
Prerequisites
Upgrade the UltraPath when no service data available or customers agree to temporarily interrupt the service data.
Procedure
Step 1 Stop host services.
Step 2 Close the database.
----End
Verification
No anomalies occur during the service interruption.
Troubleshooting
Close all windows related to the services and stop the services again.
4.1.3.10  Uninstalling the UltraPath Software
Task Description
Before the upgrade, you need to uninstall the current version of UltraPath for Solaris.
Precautions
You need to uninstall the current version of UltraPath for Solaris and restart the system before you upgrade UltraPath for Solaris.
Prerequisites
The current operating system is UltraPath for Solaris and its functions work properly.
Procedure
Step 1 Log in to the system as user root.
Step 2 Run the pkgrm UltraPath command to uninstall the current UltraPath for Solaris installation package.
Step 3 Run the reboot command to restart the system.
----End
Troubleshooting
None.
4.1.3.11  Installing the UltraPath Software
Task Description
Install the new version of UltraPath for Solaris.
Precautions
You need to uninstall the current version of UltraPath for Solaris and restart the system before you upgrade UltraPath for Solaris.
Prerequisites
· The original UltraPath for Solaris has been uninstalled and the system has been restarted.
· Run the pkginfo UltraPath command to check whether the original UltraPath for Solaris has been uninstalled.
Procedure
Step 1 Log in to the system as user root.
Step 2 Run the sh install.sh command to install the new UltraPath for Solaris installation package at the directory of package.
Step 3 Run the reboot command to restart the system.
----End
Troubleshooting
None.
4.1.4  Verifying the Upgrade
After UltraPath for Solaris is upgraded and the system is restarted, check whether the software version is correct and the software functions work properly.
4.1.4.12  Verification Checklist
Table 4-3 Checklist for verification
	No.
	Verification Item
	Expected Result
	Operation Command

	1
	Query the version of UltraPath for Solaris.
	The queried version is correct.
	On the CLI of UltraPath, run the show version command.

	2
	Check whether the
functions work properly after the upgrade.
	All functions work properly.
	None.


4.1.4.13  Verification Task 1
Task Description
Verify that UltraPath for Solaris is upgraded to the correct version.
Precautions
To perform any operations, ensure that you have restarted the system after the upgrade.
Procedure
Step 1 Log in to the system as user root. Run the upadm command to enter the UltraPath command mode.
Step 2 Run the show version command to query the version of UltraPath for Solaris.
----End
Result Verification
The returned UltraPath version is the desired one.
Troubleshooting
None.
4.1.4.14  Verification Task 2
Task Description
Verify that all functions of UltraPath for Solaris work properly after the upgrade.
Precautions
To verify the functions, ensure that you have restarted the system after the upgrade.
Procedure
Perform the same operations as those before the upgrade to verify that all functions work properly.
Result Verification
All functions work properly.
Troubleshooting
None.
4.1.5  Rolling Back to the Source Version
4.1.5.15  Uninstalling the UltraPath Software
For details, see section 4.1.3.2 

REF _EN-US_TOPIC_0120429229-chtext \h
Uninstalling the UltraPath Software "Uninstalling the UltraPath Software."
4.1.5.16  Installing the UltraPath Software of the Earlier Version
For details, see section 4.1.3.3 

REF _EN-US_TOPIC_0120429430-chtext \h
Installing the UltraPath Software "Installing the UltraPath Software."
4.2  Upgrade Scheme 2 : Direct upgrade
You do not need to uninstall the UltraPath in the operating system. Use the install.sh script of UltraPath to perform an upgrade.
4.2.1  Upgrade Process Overview
4.2.1.17  Flowchart
Figure 4-2 Flowchart of upgrading UltraPath for Solaris
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4.2.1.18  Upgrade Procedure and Required Time
Table 4-4 Upgrade procedure and required time
	No.
	Procedure
	Required Time
	Impact
	Mandatory or Not

	1
	Uninstall the current version of UltraPath software.
	About 3 minutes
	The system services are interrupted.
	Mandatory

	2
	Install the new version of UltraPath software.
	About 3 minutes
	The upgrade takes effect only after the system is restarted.
	Mandatory

	3
	Verify that the upgrade is successful.
	About 3 minutes
	None.
	Mandatory


4.2.2  Preparing for the Upgrade
4.2.2.19  Prerequisites
· The operator has experience in handling the Solaris operating system.
· The operator has the super user (root) permission on the Solaris operating system and must be the one predefined in the system instead of being created by users.
· The operating system is the Solaris 10 or Solaris 11 based on the SPARC architecture.
4.2.2.20  Obtaining Upgrade Tools
The following table lists the tools required for upgrading UltraPath.
	Name
	Remarks

	Secure Shell (SSH)
	You can use this tool to remotely log in to the server on which you want to upgrade UltraPath.

	Secure File Transfer Protocol (SFTP) tool
	You can use this tool to upload the UltraPath software package.
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If copyright is involved, obtain tools by yourself. For details, contact Huawei technical support engineers.
4.2.2.21  Obtaining Reference Documents for the Upgrade
	Document
	Description

	OceanStor UltraPath 21.3.0 Release Notes
	Adjust the document based on site condition and deliver the document to the customer.


You can obtain the document from the CD-ROM or by logging in to http://support.huawei.com/enterprise/ and choosing Support > Software Download > Cloud Storage > Tools and Platform > UltraPath.
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You must apply for the permission to obtain documentation from the website. If you are using http://support.huawei.com/enterprise/ for the first time, first register with the website. For details, see the website and FAQs.
4.2.2.22  Obtaining Upgrade Software
· Obtain the UltraPath installation package from the CD-ROM.
· Log in to http://support.huawei.com/enterprise/ to obtain the UltraPath installation package.
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Log in to http://support.huawei.com/enterprise/ and choose Support > Software Download > Cloud Storage > Tools and Platform > UltraPath to obtain the installation package.
· Use a digital signature verification tool to verify the integrity of the installation package.
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To ensure the integrity of the software you obtained, use a software digital signature validation tool to verify it. To obtain the tool, log in to http://support.huawei.com/enterprise and choose Support > Tools. Search for software digital signature validation tool. Download the tool and start the verification. For details about how to verify software, see the guides released with the tool.
4.2.2.23  Preparing the Installation Package for Version Rollback
Prepare the installation package of the UltraPath that has been installed before the upgrade. If the upgrade fails, roll back to the previous version and quickly recover services.
4.2.2.24  Checking the Environment Before the Upgrade
Purpose
Verify that the environment meets the requirement before the upgrade.
Precautions
None.
Procedure
Step 1 Verify that the current operating system is UltraPath for Solaris and its functions work properly.
Step 2 Verify that the /opt directory on the server has 200 MB free space at least.
#df -h   
Filesystem     MB blocks   Free %Used   Iused %Iused Mounted on  /dev/hd10opt    2048.00    1852.50   10%  2333   1%   /opt
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If the free space is insufficient, run the chfs -a size=+10M /opt command to expand the capacity of the /opt directory.
----End
4.2.3  Upgrade Procedure
Task Description
Before the upgrade, you need to uninstall the current version of UltraPath for Solaris.
Precautions
Check all items specified in section 4.2.2 

REF _EN-US_TOPIC_0120429404-chtext \h
Preparing for the Upgrade. Do not open related programs during the upgrade. Restart the host as prompted.
Prerequisites
Make sure that the UltraPath software is installed on the host. If the UltraPath software is not installed on the host, go to "Installing the UltraPath Software" of the section 4.1.3.3 

REF _EN-US_TOPIC_0120429430-chtext \h
Installing the UltraPath Software.
Procedure
Step 1 Run install.sh installation script:
-bash-3.2# sh install.sh   
Checking free space of /opt ...  
Transferring <UltraPath> package instance  
UltraPath upgrade may affect business. Please stop the business before upgrading the UltraPath.  
* Are you sure you want to continue the UltraPath upgrade? [y,n,?]: y
Stop services as prompted and enter y.
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At this point enter n to cancel the upgrade.
Step 2 Enter y as prompted to continue:
Install nxup core service  ...  
Install CLI ...  
Install upservice ...   
updating /platform/sun4v/boot_archive  
* Succeeded in upgrading the UltraPath.  
* You must restart your system for the configuration  
* changes made to OceanStor UltraPath to take effect.  
* do you want to reboot now? (y or n):y
Step 3 Enter y to restart the system. The kernel takes effect after the upgrade:
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50. If you enter n, the system is not restarted after the upgrade. However, the UltraPath does not take effect so that it cannot be used.
51. If only the user mode is upgraded, you can use the UltraPath without restarting the system.
----End
Result Verification
The queried version is correct.
Troubleshooting
None.
4.2.4  Verifying the Upgrade
After UltraPath for Solaris is upgraded and the system is restarted, check whether the software version is correct and the software functions work properly.
4.2.4.25  Verification Checklist
Table 4-5 Checklist for verification
	No.
	Verification Item
	Expected Result
	Operation Command

	1
	Query the version of UltraPath for Solaris.
	The queried version is correct.
	On the CLI of UltraPath, run the show version command.

	2
	Check whether the functions work properly after the upgrade.
	All functions work properly.
	None.


4.2.4.26  Verification Task 1
Purpose
Verify that UltraPath for Solaris is upgraded to the correct version.
Precautions
To perform any operations, ensure that you have restarted the system after the upgrade.
Procedure
Step 1 Log in to the system as user root. Run the upadm command to enter the UltraPath command mode.
Step 2 Run the show version command to query the version of UltraPath for Solaris.
----End
Result Verification
The queried version is correct.
Troubleshooting
None.
4.2.4.27  Verification Task 2
Purpose
Verify that all functions of UltraPath for Solaris work properly after the upgrade.
Precautions
To verify the functions, ensure that you have restarted the system after the upgrade.
Procedure
Perform the same operations as those before the upgrade to verify that all functions work properly.
Result Verification
All functions work properly.
Troubleshooting
None.
4.2.5  Rolling Back to the Source Version
UltraPath for Solaris of the target version needs to be uninstalled and the source version needs to be installed because the target version cannot be used.
4.2.5.28  Uninstalling the UltraPath Software
For details, see section 4.1.3.2 

REF _EN-US_TOPIC_0120429229-chtext \h
Uninstalling the UltraPath Software "Uninstalling the UltraPath Software."
4.2.5.29  Installing the UltraPath Software of the Earlier Version
For details, see section 4.1.3.3 

REF _EN-US_TOPIC_0120429430-chtext \h
Installing the UltraPath Software "Installing the UltraPath Software."
5  UltraPath for Linux Upgrade Guide
5.1  Upgrade Process
5.2  Preparing for the Upgrade
5.3  Offline Upgrade Procedure
5.4  Online Upgrade Procedure
5.5  Verifying the Upgrade
5.6  Rolling Back to the Source Version
5.7  Appendix1, start the operating system in lilo mode
5.8  Appendix2, start the operating system in grub2 mode
5.1  Upgrade Process
5.1.1  Upgrade Flowchart
Figure 5-1 Flowchart for upgrading UltraPath for Linux
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5.1.2  Required Steps and Their Durations
Table 5-1 Required steps and their durations
	No.
	Step
	Duration
	Impact
	Remarks

	1
	Check the installation package and the information about the operating system.
	About 3 minutes
	None
	Mandatory

	2
	Offline upgrade or online upgrade the new UltraPath.
	About 5 minute
	None
	Mandatory

	3
	Verify the upgrade.
	About 4 minutes
	None
	Mandatory


The upgrade takes about 12 minutes.
5.2  Preparing for the Upgrade
5.2.1  Prerequisites
The following conditions must be met for the upgrade:
· The operator has the Linux operation experience.
· The operator has the super user (root) permission on the Linux operating system..
· The hardware that runs the server program meets the basic requirements on UltraPath software (128 MB memory and 200 MB available disk space).
· The joint takeover check is passed. For details about how to perform joint takeover check, see section 5.2.7.2 

REF _EN-US_TOPIC_0134747160-chtext \h
Checking Joint Takeover.
Besides the basic requirements, online upgrade must meet the following requirements:
· The target 21.3.0 version supports the online upgrade from the current V100R008C00/V100R008C20/V100R008C30/V100R008C50/21.0.1/21.0.2/21.1.0/21.2.0/21.3.RCx version.
· All links are normal before the upgrade, and faulty or degraded paths do not exist.
· Upgrade the software at off-peak hours.
· Do not perform online upgrade when the CPU is running with full load.
· Do not perform online upgrade when the host has the storage single controller alarm.
5.2.2  Obtaining Upgrade Tools
The following table lists the tools required for upgrading UltraPath.
	Name
	Remarks

	Secure Shell (SSH)
	You can use this tool to remotely log in to the server on which you want to upgrade UltraPath.

	Secure File Transfer Protocol (SFTP) tool
	You can use this tool to upload the UltraPath software package.
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If copyright is involved, obtain tools by yourself. For details, contact Huawei technical support engineers.
5.2.3  Obtaining Upgrade Reference
Table 5-2 Reference document
	Document
	Description

	OceanStor UltraPath 21.3.0 Release Notes
	Adjust the document based on site condition and deliver the document to the customer.


You can obtain the document by logging in to http://support.huawei.com/enterprise/ and choosing Support > Software Download > Cloud Storage > Tools and Platform > UltraPath.
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You must apply for the permission to obtain documentation from the website. If you are using http://support.huawei.com/enterprise/ for the first time, first register with the website. For details, see the website and FAQs.
5.2.4  Obtaining Upgrade Software
· Log in to http://support.huawei.com/enterprise/ to obtain the UltraPath installation package.
[image: image183.png]



Log in to http://support.huawei.com/enterprise/ and choose Support > Software Download > Cloud Storage > Tools and Platform > UltraPath to obtain the installation package.
· Use a digital signature verification tool to verify the integrity of the installation package.
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To ensure the integrity of the software you obtained, use a software digital signature validation tool to verify it. To obtain the tool, log in to http://support.huawei.com/enterprise and choose Support > Tools. Search for software digital signature validation tool. Download the tool and start the verification. For details about how to verify software, see the guides released with the tool.
Table 5-3 Installation packages of UltraPath for Linux
	No.
	File Name
	Description

	1
	RHEL
	Red Hat, CentOS, and Oracle Linux

	2
	SLES
	SUSE

	3
	LinuxOther
	Red Flag Linux, LINX-TECH, Kylin, NeoShine, and Deepin


5.2.5  Obtaining the Current UltraPath Version
Task Description
Obtain the current UltraPath version to determine whether an upgrade is necessary.
Procedure
On the command line interface (CLI), run the upadmin show version command and view the returned UltraPath version.
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· The upadmin show version command is inapplicable to certain earlier versions of UltraPath. As a compensation, run the upTools -V or rpm -qa | grep ^U command for them.
· You can run upadmin show version verbose to query product version about V100R008C50 and later versions.
· If no output appears after running the rpm -qa | grep ^U command, the UltraPath is not yet installed.
· If multiple version numbers appear after running the rpm -qa | grep ^U command, different versions of UltraPath are already installed.
Verification
Example 1
129-41-213:~ # upTools -V 
Linux UltraPath Driver Version:11.01.11
Example 2
linux-a6n4:~ # upTools -V 
Version: V100R002 
UltraPath for Linux: 2.02.005
Example 3
Linux-a6n4:~ # rpm -qa | grep ^U 
UltraPath-2.02.005-1
Example 4
linux-fh5t:/ # upTools -V 
Version: V100R003 
UltraPath for Linux: 3.01.037
Example 5
linux:~ # upadmin show version 
Software Version : 5.01.046 
Driver Version : 5.01.046
Example 6
linux:~ # upadmin show version 
Software Version   : 6.01.001 
Driver   Version   : 6.01.001
Example 7
linux:~ # upadmin show version 
Software Version   : 8.01.007 
Driver   Version   : 8.01.007
Example 8
linux:~ # upadmin show version 
Software Version   : 8.03.028 
Driver   Version   : 8.03.028
Example 9
linux:~ # upadmin show version 
Software Version   : 8.05.008 
Driver   Version   : 8.05.008
Example 10
linux:~ # upadmin show version verbose 
Software Version   : 8.06.063 
Driver   Version   : 8.06.063 
Product  Version   : V100R008C50SPC500
5.2.6  Obtaining the Rollback Installation Package
Prepare the installation package of the UltraPath that has been installed before the upgrade. If the upgrade fails, roll back to the previous version and quickly recover services.
5.2.7  Checking the Upgrade Environment
5.2.7.2  Checking the Disk Information of the Server
Task Description
Obtain the information about the host for post-upgrade verification.
Precaution
The lsscsi command is not applicable to certain operating systems such as RedHat. For such systems, obtain the command installation packages on their respective installation CD-ROMs.
Procedure
Back up the current information about the host for post-upgrade verification by logging in to the host, running the lsscsi command, and recording the output (Figure 5-2). The virtual disk information will be checked after the upgrade.
Figure 5-2 Disk letter mapping list
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(0:0:0:0]  ca/avd hp DVD D DSED3SH  HHE7 /dev/sr0
(2:0:0:0]  disk  HUAUEI  S5500T 2105 -
(2:0:0:1]  disk  HUAUEI  SS500T 2105 -
(2:0:0:2]  disk  HUAUEI  S5500T 2105 -
(2:0:0:3]  disk  HUAUEI  S5500T 2105 -
(3:0:0:0]  disk  HURUEI  S5500T 2105 -
(3:0:0:1]  disk  HUAUEI  S5500T 2105 -
(3:0:0:2]  disk  HURUEI  S5500T 2105 -
(3:0:0:3]  disk  HUAUEI  S5500T 2105 -
[5:0:0:0]  disk  up upaisk 2108
[5:0:0:1]  disk  wp upaisk 2108
[5:0:0:2]  disk  up upaisk 2108
(5:0:0:3]  disk  up updisk 2105





5.2.7.3  Checking Joint Takeover
Task Description
Check whether disks are jointly taken over by the universal multipathing software and UltraPath. If yes, the upgrade is not allowed.
Precautions
Log in to the server as the root user.
Procedure
Log in to the server and run the following command:
multipath -ll
If any of the following command outputs is displayed, the joint takeover check is passed.
 [root@localhost ~]# multipath -ll 
-bash: multipath: command not found
[root@localhost ~]# multipath -ll 
Sep 28 03:42:24 | DM multipath kernel driver not loaded
[root@localhost ~]# multipath –ll 
[root@localhost ~]#
If other outputs are displayed, use the InfoGrab tool to collect host information for upgrade review. The upgrade can be continued only after the review is passed.
For example:
[root@localhost ~]# multipath -ll 
367079901003ff8e00f341fe100000053 dm-1 up      ,updisk           
size=4.0G features='0' hwhandler='0' wp=rw 
`-+- policy='service-time 0' prio=1 status=active 
  `- 15:0:2:2 sdo   8:224  active ready  running
5.3  Offline Upgrade Procedure
Task Description
The system or UltraPath service will be restarted after the offline upgrade of UltraPath. Therefore, you must stop services or migrate them to another server before performing the offline upgrade.
5.3.2  Upgrading the UltraPath in a boot-from-SAN Setup
To upgrade the UltraPath in a boot-from-SAN setup, go through this section. To upgrade the UltraPath in a boot-from-local setup, see section 5.3.2 

REF _EN-US_TOPIC_0120429464-chtext \h
Upgrading the UltraPath in a boot-from-local Setup "Upgrading the UltraPath in a boot-from-local Setup" in this document.
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· UltraPath V100R005C01 and later versions, Perform command as follows.
cat /etc/UltraPath.packages.info | grep "SanBoot"
If g30s_isSanBoot=1, then UltraPath in a boot-from-SAN Setup; else if g30s_isSanBoot=0, then UltraPath in a boot-from-local Setup.
· Others before V100R005C01: boot-from-SAN.
5.3.2.4  Stopping Host Services
Task Description
The upgrade requires restarting the host, and this interrupts services.
Precautions
To prevent service data loss, perform the upgrade when no service is running or after migrating services to other hosts.
Procedure
Step 1 Customer's engineers stop host services.
Step 2 (Optional) Customer's engineers stop database services, if any.
----End
Verification
No exception occurs during the service termination.
Troubleshooting
Try to stop those services again.
5.3.2.5  Performing the Pre-Upgrade Check
Task Description
Check that the working kernel is consistent with the default value in the bootloader (/boot/grub/menu.lst in grub startup mode) file.
Procedure
The following example explains how to view the content of bootloader file (/boot/grub/menu.lst) in grub startup mode.
Assume that the content of /boot/grub/menu.lst is:
default 0 
... 
title SUSE(default) 
 root (hd0,1) 
 kernel /boot/vmlinuz-2.6.27.19-5-default ... 
 initrd /boot/initrd-2.6.27.19-5-default 
title SUSE(XEN) 
 root (hd0,1) 
 kernel /boot/vmlinuz-2.6.27.19-5-xen ... 
 initrd /boot/initrd-2.6.27.19-5-xen 
...
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· The host has two kernels: 2.6.27.19-5-default and 2.6.27.19-5-xen.
· The default system kernel is 2.6.27.19-5-default.
· Check whether the working kernel is 2.6.27.19-5-default by running the uname -r command. If yes, proceed with the UltraPath upgrading. If no, change the default value in /boot/grub/menu.lst to be consistent with the working kernel.
· If host is grub2, Check that the working kernel is consistent with the default value (the saved_entry value in /boot/grub2/grubenv file)in the bootloader (/boot/grub2/grub.cfg in grub startup mode) file
Verification
The working kernel is consistent with the default value in bootloader (/boot/grub/menu.lst in grub startup mode) file.
Troubleshooting
If the working kernel is inconsistent with the default value, change the value for consistency.
5.3.2.6  Upgrading UltraPath for Linux
Task Description
Upgrade the UltraPath. This section exemplifies how to upgrade the UltraPath from V100R003 to this version.
Precaution
52. Do not copy the UltraPath installation package to a directory whose path contains a space, for example /home/Bad Dir/. Otherwise, you may not be able to execute the install.sh script correctly.
53. Do not copy the UltraPath installation package to the directory for an earlier version of UltraPath that was installed on the host.
Procedure
Step 1 Copy the UltraPath installation package to the host.
Figure 5-3 UltraPath for Linux installation package directories
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Step 2 Run the following commands one by one:
chmod +x install.sh 
./install.sh
The following output appears:
complete iscsi checking.  
complete FC checking.  
Verify the UltraPath existence.  
[WARNING] An old UltraPath version lower than R5 has been detected.  
Do you want to remove it now?  
<Y|N>:y  
The UltraPath uninstallation starts  
The UltraPath startup guide items are deleted successfully.  
Preparing to uninstall UltraPath driver...  
UltraPath driver package has been successfully removed from your system.  
[Note]: It's highly recommended to reboot your system.  
UltraPath driver uninstalled successfully  
Modify system configuration.[file:/etc/iscsi/iscsid.conf,item:node.startup ,value:  automatic]  
Modify system configuration.[file:/etc/iscsi/iscsid.conf,item:node.session.timeo.replacement_timeout ,value:  1]  
Modify system configuration.[file:/etc/modprobe.conf,module:qla2xxx,item:qlport_down_retry,value:5]  
Modify system configuration.[file:/etc/modprobe.conf,module:lpfc,item:lpfc_nodev_tmo,value:5]  
If the operating system is installed on a local drive of the server, you are advised 
to choose boot from local; if the operating system is installed on a SAN storage 
system, you must choose boot from san. Please choose the boot type of your system: 
<1>--boot-from-Local  
<2>--boot-from-SAN  
please input your select:2  
Preparing...                ##################################################  
UltraPath                   ##################################################  
User configuration is saved successfully.  
The UltraPath start items are added successfully.  
The mirror is updated successfully.  
append UltraPath title to bootloader successfully.[/boot/grub/menu.lst]  
The running service is installed successfully.  
*********************************************************************************  
* UltraPath will use the system hostname for alarm generation and automatic host*  
* registration. Make sure that the system hostname is correctly configured..    *  
*********************************************************************************  
The installation is complete. Whether to restart the system now?  
<Y|N>:
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If the universal multipathing software and UltraPath jointly take over disks, the following alarm is generated and service continuity may be affected. In this case, enter N to exit the upgrade, contact Huawei technical support to rectify the fault, and then perform the upgrade.
[WARNING] It is detected that the universal multipathing software and UltraPath jointly take over LUNs on the host, which may affect service continuity.  
Therefore, you are advised to rectify the risk before upgrading UltraPath. If you do not rectify the risk and continue to upgrade UltraPath,  
UltraPath will notify the disk array of the risk and you need to determine whether to continue the upgrade or not. 
<Y|N>:N
Step 3 After the command is run, UltraPath is uninstalled. Restart the system to enable the latest UltraPath to take effect.
----End
Verification
Restart the system to make the upgraded UltraPath effective. Then, run the lsmod | grep nxup command to check whether the nxup module has been loaded.
Figure 5-4 Multipathing module information
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Troubleshooting
If you encounter exceptions during the installation or cannot correctly restart the system after the installation is complete, contact Huawei R&D engineers for troubleshooting.
5.3.3  Upgrading the UltraPath in a boot-from-local Setup
To upgrade the UltraPath in a boot-from-local setup, go through this section. To upgrade the UltraPath in a boot-from-SAN setup, see section 5.3.1 

REF _EN-US_TOPIC_0120429311-chtext \h
Upgrading the UltraPath in a boot-from-SAN Setup "Upgrading the UltraPath in a boot-from-SAN Setup" in this document.
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· UltraPath V100R005C01 and later versions, Perform command as follows:
cat /etc/UltraPath.packages.info | grep "SanBoot"
If g30s_isSanBoot=0, then UltraPath in a boot-from-local Setup; else if g30s_isSanBoot=1, then UltraPath in a boot-from-SAN Setup.
· Others before V100R005C01: boot-from-SAN.
5.3.3.7  Stopping Host Services
Task Description
The upgrade requires restarting the host or UltraPath service, and this interrupts services.
Precautions
To prevent service data loss, customer's engineers perform the upgrade when no service is running or after migrating services to other hosts.
Procedure
Step 1 Customer's engineers stop host services.
Step 2 (Optional) Customer's engineers stop database services, if any.
Step 3 Unmount all the volumes and file systems from the storage system.
Step 4 Disconnect all the service cables between the storage system and the host.
Step 5 Run the service nxup stop or /etc/init.d/nxup stop command to stop the UltraPath service.
· In the following example, the service nxup stop command is used. If the following command output is displayed for UltraPath V100R005C01 and UltraPath V100R006C00, the UltraPath service is stopped successfully. Otherwise, the UltraPath service fails to be stopped.
[root@localhost ~]# service nxup stop 
stop Ultrapath successfully.
· In the following example, the service nxup stop command is used. If the following command output is displayed for UltraPath V100R008C00 and later versions, the UltraPath service is stopped successfully. Otherwise, the UltraPath service fails to be stopped.
linux:~ # service nxup stop 
The UltraPath service is stopped successfully.
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For UltraPath V100R008C50 in SUSE 12 series and deepin operating systems, run the /etc/init.d/nxup stop command
----End
Verification
No exception occurs during the service termination.
Troubleshooting
If the UltraPath service fails to be stopped in step 5 and the retry fails, restart the operating system to enable UltraPath to take effect after upgrading UltraPath in offline mode.
5.3.3.8  Upgrading the UltraPath
Task Description
Upgrade the UltraPath. This section exemplifies how to upgrade the UltraPath from V100R006 to this version.
Precaution
54. Do not copy the UltraPath installation package to a directory whose path contains a space, for example /home/Bad Dir/. Otherwise, you may not be able to execute the install.sh script correctly.
55. Do not copy the UltraPath installation package to the directory for an earlier version of UltraPath that was installed on the host.
Procedure
Step 1 Copy the UltraPath installation package to the host.
Figure 5-5 UltraPath for Linux installation package directories
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Step 2 Run the following commands one by one:
chmod +x install.sh 
./install.sh
The following output appears:
complete iscsi checking. 
complete FC checking. 
Verify the UltraPath existence. 
[WARNING] The UltraPath driver has been detected. 
Do you want to uninstall it now? 
<Y|N>:y  
The UltraPath uninstallation starts. 
remove run-service successfully. 
remove boot-service successfully. 
remove UltraPath files 
UltraPath driver package has been sucessfully removed from your system. 
Modify system configuration.[file:/etc/iscsi/iscsid.conf,item:node.startup ,value:automatic] 
Modify system configuration.[file:/etc/iscsi/iscsid.conf,item:node.session.timeo.replacement_timeout ,value:1] 
Modify system configuration.[file:/etc/modprobe.d/nxupmodules.conf,module:qla2xxx,item:qlport_down_retry,value:5] 
Modify system configuration.[file:/etc/modprobe.d/nxupmodules.conf,module:lpfc,item:lpfc_nodev_tmo,value:5] 
If the operating system is installed on a local drive of the server, you are advised 
to choose boot from local; if the operating system is installed on a SAN storage 
system, you must choose boot from san. Please choose the boot type of your system: 
<1>--boot-from-Local 
<2>--boot-from-SAN 
please input your select:1 
Preparing...                ################################################## 
UltraPath                   ################################################## 
User configuration is saved successfully. 
The boot service is installed successfully. 
The running service is installed successfully. 
************************************Attention************************************ 
* UltraPath would modify some parameters of HBA cards for better performace. If * 
* UltraPath is installed for the first time, you may need to update the initrd* 
* image before system reboot to make the modification take effect.* 
********************************************************************************* 
********************************************************************************* 
* UltraPath will use the system hostname for alarm generation and automatic host* 
* registration. Make sure that the system hostname is correctly configured..* 
********************************************************************************* 
The installation is complete. Whether to restart the system now? 
 
<Y|N>:
After the command is run, UltraPath is uninstalled.Select N. The host is not restarted temporarily.
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If the universal multipathing software and UltraPath jointly take over disks, the following alarm is generated and service continuity may be affected. In this case, enter N to exit the upgrade, contact Huawei technical support to rectify the fault, and then perform the upgrade.
[WARNING] It is detected that the universal multipathing software and UltraPath jointly take over LUNs on the host, which may affect service continuity.  
Therefore, you are advised to rectify the risk before upgrading UltraPath. If you do not rectify the risk and continue to upgrade UltraPath,  
UltraPath will notify the disk array of the risk and you need to determine whether to continue the upgrade or not. 
<Y|N>:N
Step 3 Enable the UltraPath software to take effect in either of the following ways:
· Method one:
If the UltraPath service is stopped successfully in section 5.3.2.1 

REF _EN-US_TOPIC_0120429431-chtext \h
Stopping Host Services, run the service nxup start or /etc/init.d/nxup start command to start the UltraPath service to enable it to take effect.
The service nxup start command is used as an example.
#service nxup start 
this kernel is 2.6.39-200.24.1.el6uek.x86_64 
begin load nxup 
Begin to delete LUNs whose mappings do not exist 
Begin to delete LUNs whose mappings are changed. 
begin scan host0 
begin scan host1 
begin scan host2 
begin scan host3 
begin scan host4 
begin scan host5 
begin scan host6 
The device scanning is complete. 
start upservice 
The UltraPath starts successfully.
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For UltraPath in SUSE 12 series and deepin operating systems, run the /etc/init.d/nxup start command.
· Method two:
Restart the host to enable UltraPath to take effect.
----End
Verification
On the CLI, run the lsmod | grep nxup command to check whether the nxup module exists.
Figure 5-6 Multipathing module information
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Troubleshooting
If you encounter exceptions during the installation or cannot correctly restart the system after the installation is complete, contact Huawei R&D engineers for troubleshooting.
5.4  Online Upgrade Procedure
5.4.1  Upgrading UltraPath Online
Task Description
Install a new version of UltraPath after uninstalling the early version and activate the UltraPath service module without interrupting services.
Precautions
56. The current V100R008C00/V100R008C20/V100R008C30/V100R008C50/21.0.1/21.0.2/21.1.0 /21.2.0/21.3.RCx version can be online upgraded to the target 21.3.0 version.
57. An online upgrade cannot be performed when the CPU usage is high.
58. The device where the server program is running meets the minimum hardware requirements of the UltraPath upgrade (200 MB of memory, 200 MB of remaining disk space).
59. An online upgrade cannot be performed if there is an alarm indicating a single controller about the host.
60. Do not copy the UltraPath installation package to a directory that contains a space in its name, such as /home/Dad Dir/. Otherwise, the install.sh script may not be executed properly.
61. If the UltraPath has been installed on the host and its installation package directory is still in the host, do not copy the installation package of the new UltraPath to the directory of the previous UltraPath.
62. Check the UltraPath information before the upgrade.
63. The UVP can not support the online upgrade.
64. The takeover-online environment cannot support the online upgrade.
65. Contact Huawei R&D engineers for help when you upgrade UltraPath from V100R008C00/V100R008C20/V100R008C30/V100R008C50/V100R008C50SPC100.
Procedure
Step 1 Copy the UltraPath installation package to the host (with the example of the RHEL directory)
Figure 5-7 UltraPath for Linux installation package directories
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Step 2 Run the following commands one by one:
chmod +x install.sh 
./install.sh -ndu [ndu_free_mem_size=xxx] [ndu_used_cpu_percent=yyy] [ndu_free_disk_space=zzz]
Table 5-4 Parameters that can be specified by users during the online upgrade
	Optional Parameter Name
	Parameter Function
	Description

	ndu_free_mem_size
	Check the minimum memory capacity required by UltraPath before online upgrade.
	Unit:MB.
Default value:200

	ndu_idle_cpu_percent
	Check the percentage of used CPU before online upgrade.
	The value ranges between 0 and 100.
Default value:80

	ndu_free_disk_space
	Check the free capacity of the root directory before online upgrade.
	Unit:MB.
Default value:200


The following output appears:
The non-disruptive upgrade starts 
Check environment successfully 
The UltraPath uninstallation starts. 
The running service is deleted successfully. 
The boot service is removed successfully. 
The UltraPath files are deleted successfully. 
UltraPath driver package has been successfully removed from your system. 
Modify system configuration.[file:/etc/iscsi/iscsid.conf,item:node.startup ,value:  automatic] 
Modify system configuration.[file:/etc/iscsi/iscsid.conf,item:node.session.timeo.replacement_timeout ,value:  1] 
Modify system configuration.[file:/etc/modprobe.conf,module:qla2xxx,item:qlport_down_retry,value:5] 
Modify system configuration.[file:/etc/modprobe.conf,module:lpfc,item:lpfc_nodev_tmo,value:5] 
Preparing...                ################################################## 
UltraPath                   ################################################## 
User configuration is saved successfully. 
The boot service is installed successfully. 
The running service is installed successfully. 
The non-disruptive upgrade succeeded
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If the universal multipathing software and UltraPath jointly take over disks, the following alarm is generated and service continuity may be affected. In this case, enter N to exit the upgrade, contact Huawei technical support to rectify the fault, and then perform the upgrade.
[WARNING] It is detected that the universal multipathing software and UltraPath jointly take over LUNs on the host, which may affect service continuity.  
Therefore, you are advised to rectify the risk before upgrading UltraPath. If you do not rectify the risk and continue to upgrade UltraPath,  
UltraPath will notify the disk array of the risk and you need to determine whether to continue the upgrade or not. 
<Y|N>:N
----End
Verification
66. Run the upadmin show version command to check whether the version is new.
67. Run the lsmod command to check that the nxup module is loaded properly.
For example, the following figure shows the pre-upgrade module information:
Figure 5-8 Pre-upgrade module information
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The following figure shows the post-upgrade module information:
Figure 5-9 Post-upgrade module information
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Troubleshooting
If you encounter exceptions during the installation, contact Huawei R&D engineers for troubleshooting.
5.5  Verifying the Upgrade
5.5.1  Completing the Verification Checklist
Table 5-5 UltraPath for Linux verification checklist
	No.
	Item 
	Criterion
	Expected Result

	1
	Check the version of the current UltraPath.
	The returned version is the desired one.
	The returned version is the same as the expected one.

	2
	Check whether the startup file has been correctly updated in a boot-from-SAN setup.
	1. The Linux with ultrapath startup item has been added.
2. The initrd boot file under the startup item has been changed to a file whose name starts with ultrapath, and the file is in the /boot/ directory.
3. The default value is the ID of the added startup item.
	The startup file has been updated successfully.

	3
	Check whether the multipathing service exists in a boot-from-local setup.
	Run the chkconfig --list | grep nxup command to check.
	The nxup service exists.

	4
	Check whether the mapping of drive letters is the same as that before the upgrade.
	The returned disk letters and LUN mapping are the same as those before the upgrade.
	The pre- and post-upgrade drive letters are identical.

	5
	Check whether failover is unavailable for the QLogic driver.
	The failover function of the QLogic driver is unavailable.
	The failover function of the QLogic driver is disabled.

	6
	Check with the customer whether the services are working correctly after the upgrade.
	All the services are running correctly.
	Each service is working correctly.


5.5.2  Verifying UltraPath Version Information
Task Description
Check that the upgraded UltraPath version is the expected one.
Procedure
Run the upadmin show version command to check.
Verification
The returned UltraPath version is the desired one.
Troubleshooting
If the returned UltraPath version is not the target version, check whether the used UltraPath upgrade package is correct.
5.5.3  Verifying UltraPath Information
5.5.3.9  Verifying UltraPath Information in a boot-from-SAN Setup
If you have upgraded the UltraPath in a boot-from-SAN setup, go through this section. If you have upgraded the UltraPath in a boot-from-local setup, see section 5.5.3.2 

REF _EN-US_TOPIC_0120429365-chtext \h
Verifying UltraPath Information in a boot-from-Local Setup Verifying UltraPath Information in a boot-from-Local Setup" in this document.
Task Description
Check that the default value is the ID of the UltraPath startup item.
Precaution
This section exemplifies how to verify the /boot/grub/menu.lst configuration file on a server using the grub boot program.
· For information about verify the /etc/lilo.conf configuration file on a server using the lilo boot, see 5.7 

REF _EN-US_TOPIC_0120429240-chtext \h
Appendix1, start the operating system in lilo mode in this document.
· For information about verify the /boot/grub2/grub.cfg configuration file on a server using the grub2 boot, see 5.8 

REF _EN-US_TOPIC_0120429148-chtext \h
Appendix2, start the operating system in grub2 mode in this document.
Procedure
Step 1 Check that the /boot/grub/menu.lst file exists.
Step 2 Check that the startup configuration file cat /boot/grub/menu.lst has been correctly updated.
Step 3 Check that a file whose name starts with ultrapath exists in the /boot/ directory.
----End
Verification
Step 1 Check that the /boot/grub/menu.lst file exists.
Step 2 Check that the title Linux with ultrapath startup item has been added into the /boot/grub/menu.lst file.
Step 3 Check that the initrd boot file under the title Linux with ultrapath item in the /boot/grub/menu.lst file has been changed to another file whose name starts with ultrapath.
Step 4 Check that the default value in the /boot/grub/menu.lst file is the ID of the title Linux with ultrapath item.
Step 5 Check that a file whose name starts with ultrapath exists in the /boot/ directory.
----End
Troubleshooting
If any of the preceding steps fails, contact Huawei R&D engineers for troubleshooting.
5.5.3.10  Verifying UltraPath Information in a boot-from-Local Setup
If you have upgraded the UltraPath in a boot-from-Local setup, go through this section. If you have upgraded the UltraPath in a boot-from-SAN setup, see section 5.5.3.1 

REF _EN-US_TOPIC_0120429233-chtext \h
Verifying UltraPath Information in a boot-from-SAN Setup Verifying UltraPath Information in a boot-from-SAN Setup" in this document.
Task Description
Check whether the upgraded UltraPath service exists.
Precautions
The name of the UltraPath service is nxup. This section describes how to check whether the UltraPath service exists with the example of system SUSE.
Procedure
Step 1 In the /etc/init.d directory, check whether the nxup file exists.
Step 2 Check whether the chkconfig --list | grep nxup service exists.
----End
Verification
Step 1 Check that the /etc/init.d/nxup file exists.
Step 2 Check that the chkconfig --list | grep nxup service exists.
----End
Troubleshooting
If any step failed, contact Huawei R&D engineers for troubleshooting.
5.5.4  Checking the Consistency Between the Pre- and Post-Upgrade Disk Letter Mapping Lists
Task Description
To ensure service health, check that the pre- and post-upgrade disk letter mapping lists are consistent.
Procedure
Run the lsscsi command to check.
Verification
The returned disk letters and LUN mapping are the same as those before the upgrade.
Troubleshooting
If inconsistency occurs, contact Huawei R&D engineers for troubleshooting.
5.5.5  Checking that the Failover Function of the QLogic Driver is Disabled
Task Description
To ensure system stability, the failover function of the QLogic driver must be disabled to allow the UltraPath to implement this function by itself.
Precaution
Skip this section if you are not using a QLogic driver.
Procedure
The files that are available for checking the failover status vary depending on the operating system version. Currently, you can check the failover status using the following files:
68. /sys/module/qla2xxx/parameters/qla2xfailover
69. /proc/scsi/qla2xxx/x, where x stands for a numeral which can be queried by running the ls /proc/scsi/qla2xxx/ command.
Verification
70. If you check the failover status using the /sys/module/qla2xxx/parameters/ql2xfailover file, view its content by running the cat command. If you can see 1 in the output, the failover function has been enabled.
71. If you check the failover status using the /proc/scsi/qla2xxx/x file, view its content by running the cat command as well. If you can see fo in the Driver version field, the failover function has been enabled.
Troubleshooting
Step 1 If the QLogic driver has enabled failover, append a line saying options qla2xxx ql2xfailover=0 to the /etc/modprobe.conf.local (for SUSE), /etc/modprobe.conf, or /etc/modprobe.d/nxupmodules.conf file to disable that function.
Step 2 Update initrd by running the upadm start updateimage command.
Step 3 Restart the system.
----End
5.5.6  Checking Service Running
Task Description
Check that no post-upgrade impact occurs on the services running on the system.
Verification
All the services are running correctly after the upgrade.
Troubleshooting
If the services are not working properly, contact Huawei R&D engineers for troubleshooting.
5.6  Rolling Back to the Source Version
5.6.1  Uninstalling the Upgraded UltraPath
Purpose
If the upgraded UltraPath cannot work correctly, uninstall it to roll back to the source version.
Procedure
Uninstall the UltraPath by running the rpm -e UltraPath or dpkg -r UltraPath command.
Verification
Step 1 The command of uninstallation is executed successfully.
Step 2 Reboot the host.
----End
Troubleshooting
If you encounter exceptions during the uninstallation, contact Huawei R&D engineers for troubleshooting.
5.6.2  Installing the Source UltraPath
Task Description
Reinstall the source version of UltraPath if the latest version cannot work properly.
Procedure
Obtain the rollback package described in section 5.2.6 

REF _EN-US_TOPIC_0120429325-chtext \h
Obtaining the Rollback Installation Package "Obtaining the Rollback Installation Package" and install the source UltraPath by referring to its user guide.
Verification
You can correctly reinstall and operate the source version of UltraPath.
Troubleshooting
If you encounter exceptions during the rollback, contact Huawei R&D engineers for troubleshooting.
5.7  Appendix1, start the operating system in lilo mode
This section describes how to check the /etc/lilo.conf file on a server using the Lilo Boot Program.
Performing the Pre-Installation Check
Step 1 Check that the lilo.conf configuration file exists in the /etc/ directory.
Step 2 Check that the /etc/lilo.conf file does not contain an ultrapath item.
Step 3 Check that the working system is consistent with the default value in the /etc/lilo.conf file.
The content of the /etc/lilo.conf file before the UltraPath installation is:
default = linux 
image = /boot/vmlinuz-2.6.16.60-0.54.5-default 
###Don't change this comment - YaST2 identifier: Original name: linux### 
label = linux 
append = "splash=silent " 
description = Linux 
initrd = /boot/initrd-2.6.16.60-0.54.5-default 
root = /dev/disk/by-id/scsi-35000c50012afd6cf-part6 
image = /boot/vmlinuz-2.6.16.60-0.54.5-default 
###Don't change this comment - YaST2 identifier: Original name: failsafe### 
label = failsafe 
append = "ide=nodma nohalt noresume 3 " 
description = Failsafe 
initrd = /boot/initrd-2.6.16.60-0.54.5-default 
root = /dev/disk/by-id/scsi-35000c50012afd6cf-part6
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· The default system kernel is initrd-2.6.16.60-0.54.5-default.
· Verify that the working kernel is initrd-2.6.16.60-0.54.5-default by running the uname -r command. If this is false, change the default value to be consistent with the working kernel in the /etc/lilo.conf file.
----End
Verifying the Installation Procedure
Step 1 Check that the /etc/lilo.conf file exists.
Step 2 Check that the ultrapath startup item has been added into the /etc/lilo.conf file.
Step 3 Check that the initrd boot file under the ultrapath item in the /etc/lilo.conf file has been changed to a file whose name starts with ultrapath.
Step 4 Check that the default value is the ID of the ultrapath item in the /etc/lilo.conf file.
The content of the /etc/lilo.conf file after the UltraPath installation is:
default = ultrapath 
image = /boot/vmlinuz-2.6.16.60-0.54.5-default 
###Don't change this comment - YaST2 identifier: Original name: linux### 
 label = linux 
 append = "splash=silent " 
 description = Linux 
 initrd = /boot/initrd-2.6.16.60-0.54.5-default 
 root = /dev/disk/by-id/scsi-35000c50012afd6cf-part6 
image = /boot/vmlinuz-2.6.16.60-0.54.5-default 
###Don't change this comment - YaST2 identifier: Original name: failsafe### 
 label = failsafe 
 append = "ide=nodma nohalt noresume 3 " 
 description = Failsafe 
 initrd = /boot/initrd-2.6.16.60-0.54.5-default 
 root = /dev/disk/by-id/scsi-35000c50012afd6cf-part6 
image = /boot/vmlinuz-2.6.16.60-0.54.5-default 
 label = ultrapath 
 append = "splash=silent " 
 initrd = /boot/ultrapath-2.6.16.60-0.54.5-default.img 
root = /dev/disk/by-id/scsi-35000c50012afd6cf-part6
----End
5.8  Appendix2, start the operating system in grub2 mode
This section describes how to check the /boot/grub2/grub.cfg file on a server using the Lilo Boot Program.
Performing the Pre-Installation Check
Step 1 Check that the grub.cfg configuration file exists in the /boot/grub2 directory.
Step 2 Check that the /boot/grub2/grub.cfg file does not contain an ultrapath item.
Step 3 Check that the working system is consistent with the default value in the /boot/grub2/grub.cfg file.
The content of the /boot/grub2/grubenv file before the UltraPath installation is:
# GRUB Environment Block 
# WARNING: Do not edit this file other than by grub2-editenv 
env_block=512+1 
saved_entry=0
The content of the /boot/grub2/grub.cfg file before the UltraPath installation is:
menuentry 'SLES12, with Linux 3.12.28-4-default' --hotkey=2 --class sles12 --class gnu-linux --class gnu --class os $menuentry_id_option 'gnulinux-3.12.28-4-default-advanced-e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85' { 
  load_video 
  set gfxpayload=keep 
  insmod gzio 
  insmod part_msdos  
  insmod btrfs 
  set root='hd0,msdos2' 
 
  echo?'Loading Linux 3.12.28-4-default ...' 
  linux?/boot/vmlinuz-3.12.28-4-default root=UUID=e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85  ${extra_cmdline}  resume=/dev/sda1 splash=silent quiet crashkernel=216M-:108M  showopts 
  echo?'Loading initial ramdisk ...' 
  initrd?/boot/initrd-3.12.28-4-default 
} 
menuentry 'SLES12, with Linux 3.12.28-4-default (recovery mode)' --hotkey=3 --class sles12 --class gnu-linux --class gnu --class os $menuentry_id_option 'gnulinux-3.12.28-4-default-recovery-e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85' { 
  load_video 
  set gfxpayload=keep 
  insmod gzio 
  insmod part_msdos  
  insmod btrfs 
  set root='hd0,msdos2' 
  echo?'Loading Linux 3.12.28-4-default ... 
  linux?/boot/vmlinuz-3.12.28-4-default root=UUID=e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85  ${extra_cmdline} showopts apm=off noresume edd=off powersaved=off nohz=off highres=off processor.max_cstate=1 nomodeset x11failsafe crashkernel=216M-:108M 
  echo?'Loading initial ramdisk ...' 
  initrd?/boot/initrd-3.12.28-4-default 
}
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· The default system kernel is initrd-3.12.28-4-default.
· Verify that the working kernel is initrd-3.12.28-4--default by running the uname -r command. If this is false, change the default value to be consistent with the working kernel in the /boot/grub2/grub.cfg file.
----End
Verifying the Installation Procedure
Step 1 Check that the /boot/grub2/grub.cfg file exists.
Step 2 Check that the ultrapath startup item has been added into the /boot/grub2/grub.cfg file.
Step 3 Check that the initrd boot file under the ultrapath item in the /boot/grub2/grub.cfg file has been changed to a file whose name starts with ultrapath.
Step 4 Check that the default value is the ID of the ultrapath item in the /boot/grub2/grub.cfg file.
The content of the /boot/grub2/grubenv file after the UltraPath installation is:
# GRUB Environment Block 
# WARNING: Do not edit this file other than by grub2-editenv 
env_block=512+1 
saved_entry=2
The content of the /boot/grub2/grub.cfg file after the UltraPath installation is:
menuentry 'SLES12, with Linux 3.12.28-4-default' --hotkey=2 --class sles12 --class gnu-linux --class gnu --class os $menuentry_id_option 'gnulinux-3.12.28-4-default-advanced-e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85' { 
  load_video 
  set gfxpayload=keep 
  insmod gzio 
  insmod part_msdos  
  insmod btrfs 
  set root='hd0,msdos2' 
 
  echo?'Loading Linux 3.12.28-4-default ...' 
  linux?/boot/vmlinuz-3.12.28-4-default root=UUID=e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85  ${extra_cmdline}  resume=/dev/sda1 splash=silent quiet crashkernel=216M-:108M  showopts 
  echo?'Loading initial ramdisk ...' 
  initrd?/boot/initrd-3.12.28-4-default 
} 
menuentry 'SLES12, with Linux 3.12.28-4-default (recovery mode)' --hotkey=3 --class sles12 --class gnu-linux --class gnu --class os $menuentry_id_option 'gnulinux-3.12.28-4-default-recovery-e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85' { 
  load_video 
  set gfxpayload=keep 
  insmod gzio 
  insmod part_msdos  
  insmod btrfs 
  set root='hd0,msdos2' 
  echo?'Loading Linux 3.12.28-4-default ... 
  linux?/boot/vmlinuz-3.12.28-4-default root=UUID=e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85  ${extra_cmdline} showopts apm=off noresume edd=off powersaved=off nohz=off highres=off processor.max_cstate=1 nomodeset x11failsafe crashkernel=216M-:108M 
  echo?'Loading initial ramdisk ...' 
  initrd?/boot/initrd-3.12.28-4-default 
} 
###ultrapath-t51s begin,don't change this!### 
menuentry 'title Linux with ultrapath' { 
load_video 
set gfxpayload=keep 
insmod gzio 
insmod part_msdos 
insmod btrfs 
set root='hd0,msdos2' 
if [ x$feature_platform_search_hint = xy ]; then 
search --no-floppy --fs-uuid --set=root --hint-bios=hd0,msdos2 --hint-efi=hd0,msdos2 --hint-baremetal=ahci0,msdos2 --hint='hd0,msdos2' e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85 
else 
search --no-floppy --fs-uuid --set=root e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85 
fi 
echo 'Loading Linux 3.12.28-4-default ...' 
linux /boot/vmlinuz-3.12.28-4-default root=UUID=e3c54bf7-9d85-4f25-9d12-1e07fd9b5b85 ${extra_cmdline} resume=/dev/sda1 splash=silent quiet crashkernel=216M-:108M showopts 
echo 'Loading initial ramdisk ...' 
initrd /boot/ultrapath-3.12.28-4-default.img 
} 
###ultrapath-t51s end,don't change this!### 

----End
6  UltraPath for vSphere Upgrade Guide
6.1  Upgrade Process
6.2  Preparing for the Upgrade
6.3  Procedure of Upgrading UltraPath for ESXi
6.4  Procedure of Upgrading UltraPath for vCenter Plug-In
6.5  Verifying Upgrade Result
6.6  Version Rollback
6.1  Upgrade Process
6.1.1  Upgrade Flowchart
Figure 6-1 Flowchart of upgrading UltraPath for ESXi offline
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Figure 6-2 Flowchart of upgrading UltraPath for ESXi online
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Figure 6-3 Flowchart for upgrading the UltraPath for vCenter plug-in
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6.1.2  Upgrade Steps and Required Time
Table 6-1 Upgrade UltraPath for ESXi steps and required time
	No.
	Procedure
	Time Required
	Impact
	Remarks

	1
	Check the system information and installation package before the upgrade.
	About 3 minutes
	None
	Mandatory

	2
	Upgrade UltraPath for ESXi online using the new version.
	About 2 minutes
	None
	Mandatory

	3
	Upgrade UltraPath for ESXi offline using the new version.
	About 3 minutes
	None
	Mandatory

	4
	Verify the upgrade result.
	About 4 minutes
	None
	Mandatory


The online upgrade and offline upgrade  each takes about 10 minutes .
Table 6-2 Upgrade UltraPath for vCenter 5.x steps and required time
	No.
	Procedure
	Time Required
	Impact
	Remarks

	1
	Check the system information and installation package before the upgrade.
	About 3 minutes
	None
	Mandatory

	2
	Upgrade UltraPath for ESXi offline using the new version.
	About 5 minutes
	None
	Mandatory

	3
	Verify the upgrade result.
	About 2 minutes
	None
	Mandatory


The offline upgrade takes about 10 minutes about UltraPath for vCenter 5.x.
Table 6-3 Upgrade UltraPath for vCenter 6.0 steps and required time
	No.
	Procedure
	Time Required
	Impact
	Remarks

	1
	Check the system information and installation package before the upgrade.
	About 3 minutes
	None
	Mandatory

	2
	Upgrade UltraPath for ESXi offline using the new version.
	About 8 minutes
	None
	Mandatory

	3
	Verify the upgrade result.
	About 2 minutes
	None
	Mandatory


The offline upgrade takes about 13 minutes about UltraPath for vCenter 6.0.
.
6.2  Preparing for the Upgrade
6.2.1  Prerequisites
Prerequisites for upgrading UltraPath for ESXi:
· The upgrade operator has the permission to operate the ESXi operating system.
· The operator has the super user (root) permission on the ESXi operating system.
· The hardware of the host meets the minimum requirements of UltraPath (memory: 1GB, free disk space: 200 MB).
· Before performing an offline upgrade, you must close all VMs on the ESXi host.
· Before the upgrade, there must be a minimum of 50 MB, 10 MB, and 10 MB free space in the tmp, root, and etc directories on the server respectively.
During the upgrade, the hostd service on ESXi hosts will be restarted and vCenter will be disconnected temporarily. This will affect the services (clone, migration, or snapshot) running on vCenter. To avoid this situation, users will be prompted to check whether there are services running on vCenter during the upgrade.
· To upgrade a script offline, you must disable the performance report exporting function.
Prerequisites for upgrading the UltraPath for vCenter plug-in:
· The upgrade operator has the permission to operate the vCenter operating system.
· The upgrade operator has the super user (Administrator) permission on the vCenter operating systemthe (root permission for VCSA6.x).
· The hardware of the host meets the minimum requirements of the UltraPath for vCenter plug-in (free disk space: 200 MB).
· The VMware VirtualCenter Management Webservices in the server of vCenter 5.x
· The VMware vSphere Web Client in vCenter 6.x can be restarted if the UltraPath for vCenter is downgrade to an older version.
· For scenarios where platform service controllers (PSCs) are configured externally and manage multiple vCenter servers. For vCenter 6.x, the VMware vSphere Web Client in vCenter 6.x can be restarted.
6.2.2  Obtaining Upgrade Tools
The following table lists the tools required for upgrading UltraPath.
	Name
	Remarks

	Secure Shell (SSH)
	You can use this tool to remotely log in to the server on which you want to upgrade UltraPath.

	Secure File Transfer Protocol (SFTP) tool
	You can use this tool to upload the UltraPath software package.
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If copyright is involved, obtain tools by yourself. For details, contact Huawei technical support engineers.
6.2.3  Obtaining Upgrade Reference Documents
Table 6-4 Reference document
	Document
	Description

	OceanStor UltraPath 21.3.0 Release Notes
	Adjust the document based on site condition and deliver the document to the customer.


You can obtain the document by logging in to http://support.huawei.com/enterprise/ and choosing Support > Software Download > Cloud Storage > Tools and Platform > UltraPath.
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You must apply for the permission to obtain documentation from the website. If you are using http://support.huawei.com/enterprise/ for the first time, first register with the website. For details, see the website and FAQs.
6.2.4  Obtaining Upgrade Software
· Log in to http://support.huawei.com/enterprise/ to obtain the UltraPath installation package.
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Log in to http://support.huawei.com/enterprise/ and choose Support > Software Download > Cloud Storage > Tools and Platform > UltraPath to obtain the installation package.
· Use a digital signature verification tool to verify the integrity of the installation package.
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To ensure the integrity of the software you obtained, use a software digital signature validation tool to verify it. To obtain the tool, log in to http://support.huawei.com/enterprise and choose Support > Tools. Search for software digital signature validation tool. Download the tool and start the verification. For details about how to verify software, see the guides released with the tool.
6.2.5  Obtaining the UltraPath Version Number
Task Description
Obtain the version number of UltraPath for ESXi in use and determine whether an upgrade is needed.
Procedure
· Check the version number of UltraPath for ESXi:
On the CLI, run the esxcli upadm show version command and collect the version number of the UltraPath displayed in command output. You can run upadm show version verbose to query product version about V100R008C50 and later versions. If no information is displayed after you run the esxcli software vib list |grep ultrapath command, UltraPath is not installed.
· Check the version number of UltraPath for the vCenter plug-in:
Log in to the UltraPath for vCenter plug-in and click Version Information on the About page.
Verification
Version number of UltraPath for ESXi:
Example 1:
~ # esxcli upadm show version 
Software Version   : 21.01.003 
Driver   Version   : 21.01.003
Example 2:
~ # esxcli upadm show version -v 
Software Version   : 8.06.063 
Driver   Version   : 8.06.063 
Product  Version   : V100R008C50SPC500
Example 3:
~ # esxcli software vib list |grep ultrapath 
ultrapath.cim  21.01.003-00    HUAWEI   VMwareAccepted   2017-01-23   
ultrapath.cli  21.01.003-00    HUAWEI   VMwareAccepted   2017-01-23   
ultrapath.mpp  21.01.003-00    HUAWEI   VMwareAccepted   2017-01-23  
Version number of UltraPath for vCenter plug-in:
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6.2.6  Obtaining the Rollback Package
Prepare the installation package of the UltraPath that has been installed before the upgrade. If the upgrade fails, roll back to the previous version and quickly recover services.
6.2.7  Checking the Pre-upgrade Environment
Task Description
Obtain host information for upgrade verification.
Precautions
· Use vmware -v to check that the versions of the operating system are ESXi 5.0, ESXi 5.1, ESXi 5.5, ESXi 6.0, ESXi 6.5 and ESXi 6.7.
· Use VMware vSphere Client to check that the versions of vCenter Server are 5.0, 5.1, 5.5, 6.0, 6.5 and 6.7.
· In an active-active VIS environment where the version of UltraPath is V100R008C00 and local and remote controllers have been successfully configured, if you need to enable the conversion of APD into PDL after the version of UltraPath is upgraded to this version, you need to run esxcli upadm set apdtopdl -m on -t value on the UltraPath CLI to enable the conversion of APD into PDL and set the timeout of the conversion.
· If the operating system version of the ESXi host is ESXi 5.5, check whether ESXi 5.5 Patch 1 (Patch Release ESXi550-201312001 (2063795) )is installed. If the patch is not installed, vCenter VM console may fail to be accessed after the hostd service is restarted due to known issues of ESXi 5.5 in PR 1119481 of VMware KB 2063788. An error "Unable to connect to the MKS : the operation is not allowed in the current state" is displayed.
Note: Run the vmware -v command to check the ESXi version. If the version is earlier than VMware ESXi 5.5.0 build-1474528, ESXi 5.5 Patch 1 is not installed on the ESXi 5.5 host.
Procedure
Check the information about the operating system of the ESXi host.
Log in to the ESXi host and run the vmware -v command to display the version information.
~ # vmware -v
VMware ESXi 5.0.0 build-469512
Check vCenter Server.
Log in to vCenter using VMware vSphere Client and click About VMware vSphere on the Help menu to display the vCenter version number,as shown in the following figure:
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6.2.8  Pre-upgrade Module Check
Check the module before upgrading UltraPath for ESXi:
Before performing the upgrade, run the vmkload_mod -l |grep nxup command to check the kernel module loaded by the current kernel.
For example, the module before the upgrade is nxup-ext-a:
~ # vmkload_mod -l |grep nxup
nxup-ext-a               32   1420
6.3  Procedure of Upgrading UltraPath for ESXi
For details about upgrading UltraPath for EXSi offline, see section 6.3.1 

REF _EN-US_TOPIC_0120429174-chtext \h
Upgrading UltraPath for ESXi Offline "Upgrading UltraPath for ESXi Offline."
For details about upgrading UltraPath for EXSi online, see section 6.3.2 

REF _EN-US_TOPIC_0120429382-chtext \h
Procedure for Upgrading UltraPath for ESXi Online "Procedure for Upgrading UltraPath for ESXi Online."
6.3.1  Upgrading UltraPath for ESXi Offline
6.3.1.2  Stopping Services Running in the Host
Task Description
During the scripts-based upgrade, disks are discovered again. For the CLI-based upgrade, you must restart the host.
Precautions
· To avoid service data loss, customer's engineers upgrade the software when there is no service running or when services have been migrated to other servers.
· If the database service is running, customer's engineers stop it first.
· After upgrading UltraPath for ESXi, upgrade UltraPath for vCenter.
Prerequisites
After obtaining the customer's approval for interrupting services, shut down all the virtual machines on the ESXi host, enter the maintenance mode, and perform the offline upgrade.
Procedure
Step 1 In a cluster environment, migrate the virtual machines to other nodes. In a non-cluster environment, stop the services running on the virtual machines and shut down the virtual machines.
Step 2 Enter the maintenance mode.
In the vCenter list, right-click an ESXi host and choose Enter Maintenance Mode.
Figure 6-4 Entering the maintenance mode
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In the dialog box that is displayed, click Yes.
Figure 6-5 Confirming the maintenance mode
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Verify that the ESXi host has entered the maintenance mode.
Figure 6-6 Verifying the maintenance mode the ESXi host has entered
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----End
Result Verification
No errors occur when the host was entering the maintenance mode.
Troubleshooting
Close all service-related windows and enter the maintenance mode again.
6.3.1.3  Upgrading UltraPath on the CLI
Task Description
Upgrade the UltraPath on the CLI.
Users need to perform either CLI- or script-based upgrade.
Precautions
Make sure that the version in use is earlier than the target one. Otherwise, an error message will be displayed and the upgrade will fail.
The host must be restarted after the CLI-based upgrade so that UltraPath can take effect.
Prerequisites
None.
Procedure
Step 1 Log in to the system as user administrator.
Step 2 Copy the UltraPath installation package to the host.
Step 3 Run the following commands:
~ # esxcli software vib install -d /opt/UltraPath-XX.XX.XXX-ESXi6.x-offline-bundle.zip
Installation Result
Message: The update completed successfully, but the system needs to be rebooted for the changes to be effective.
Reboot Required: true
VIBs Installed: HUAWEI_bootbank_ultrapath.cim_XX.XX.XXX-00, HUAWEI_bootbank_ultrapath.cli_XX.XX.XXX-00, HUAWEI_bootbank_ultrapath.mpp_XX.XX.XXX-00
VIBs Removed: HUAWEI_bootbank_ultrapath.cim_XX.XX.XXX-00, HUAWEI_bootbank_ultrapath.cli_XX.XX.XXX-00, HUAWEI_bootbank_ultrapath.mpp_XX.XX.XXX-00
VIBs Skipped:
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1./opt is the path in which the installation package is saved.
2.VMware stops providing signature authentication for the software packages of ESXi 5.0 and 5.1 operating systems, so the software packages are not authenticated with signatures. Therefore, run the esxcli software vib install -d /opt/UltraPath-XX.XX.XXX-ESXi5.0-offline-bundle.zip --no-sig-check command when the ESXi version is 5.0 or 5.1.
Step 4 Restart the system.
Run the reboot command to restart the system.
----End
Troubleshooting
None.
6.3.1.4  Upgrading the Script
Task Description
Upgrade the UltraPath on the CLI.
Users need to perform either CLI- or script-based upgrade.
Precautions
Make sure that the version in use is earlier than the target one. Otherwise, an error message will be displayed and the upgrade will fail.
You need to restart the host upon the scripts-based upgrade in SAN Boot or PE LUNs token by UltraPath, but do not need to restart the host in non-SAN Boot.
Prerequisites
The upgrade script and the installation package are saved in the same directory.
Procedure
Step 1 Log in to the system as user administrator.
Step 2 Save the upgrade package and the installation script in a directory.
Run the following command:
~ # sh /opt/install.sh 
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/opt is the path in which the installation package is saved.
Step 3 If the upgrade is performed successfully, the following output will be displayed. Otherwise, the upgrade fails. Perform operations as instructed in the prompt information.
UltraPath upgrade may affect business. Please stop the business before upgrading the UltraPath.
* Are you sure that you want to continue the UltraPath upgrade? [y,n,?] : y
Note:During the upgrade, the hostd service on ESXi hosts will be restarted and vCenter will be disconnected temporarily. This will affect the services (clone,migration, or snapshot) running on vCenter.
To avoid this situation, do not perform any management task during the upgrade, and you will be prompted to check whether there are services running on vCenter during the upgrade.
Are there no services running on vCenter?If yes, continue with the upgrade. If no, exit the upgrade. [y,n,?]: y
Host is rescanning, please wait......
The update completed successfully.
Note:The output of the esxcli software vib list command shows that the UltraPath version is the pre-upgrade one. Run the esxcli upadm show version command to check the version of the current UltraPath.
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VMware stops providing signature authentication for the software packages of ESXi 5.0 and 5.1 operating systems, so the software packages are not authenticated with signatures. Therefore, when the ESXi version is 5.0 or 5.1, the following prompt information will be displayed at the beginning of command output after command execution:
Because VMware stops providing signature authentication for the software package
of the ESXi 5.0/ESXi 5.1 system, the software package is not certified and signed
by VMware. An alarm will be reported in vCenter if an unsigned package is used.
----End
Troubleshooting
Proceed as prompted.
6.3.2  Procedure for Upgrading UltraPath for ESXi Online
6.3.2.5  Upgrading UltraPath for ESXi Online
Task Description
The online upgrade installs the new version after the old version is uninstalled and activates the UltraPath module without interrupting services.
Precautions
1.Do not copy the UltraPath installation package to a directory that contains a space in its name, such as /home/Dad Dir/. Otherwise, the install.sh may not be executed properly.
2.Before the upgrade, there must be a minimum of 50 MB, 10 MB, and 10 MB free space in the tmp, root, and etc directories on the server respectively.
3.If UltraPath was installed on the host and the old UltraPath installation package directory still exists, do not copy the new UltraPath installation package to this directory, or you may find it difficult to distinguish the two packages.
4.Before performing the upgrade, check that information about the paths is correct.
5.During the upgrade, the hostd service on ESXi hosts will be restarted and vCenter will be disconnected temporarily. This will affect the services (clone, migration, or snapshot) running on vCenter. To avoid this situation, do not perform any management task during the upgrade, and you will be prompted to check whether there are services running on vCenter during the upgrade.
6.After the online upgrade is complete, the latest UltraPath takes effect immediately. Run the esxcli upadm show version command to check whether the new version is correct. Output of the esxcli software vib list command still displays the old vib version number. The new version will be displayed in the output after the host restarts.
7.After the online upgrade is complete, manually upgrade UltraPath for vCenter offline to the latest version to manage UltraPath for ESXi.
8.If the operating system is ESXi 6.0, UltraPath V100R008C20 cannot be upgraded online to the UltraPath for this version.
9.The SSD property of a disk cannot be updated after an online upgrade. Reclaim the disk or restart the host to update the SSD property.
The procedure of reclaiming the disk:
Step1. Stop services running on the disk, and power off VMs using the disk.
Step2. Run the esxcli storage core claiming reclaim --device device_name command to reclaim the disk.
Step3. Run the esxcli storage core device list -d device_name command to check whether the SSD property is updated.
Procedure
Step1.Copy the UltraPath installation package and installation script to the host.
Step2.Run the following command:
~ # sh install.sh -ndu [ndu_free_disk_space=xxx]
Table 6-5 Parameters that can be specified by users during the online upgrade
	Parameter
	Function
	Description

	ndu_free_disk_space
	Free root directory space required by the online upgrade check.
	Unit: MB.
Default value:10


After the online upgrade is complete, the following messages are displayed:
~ # sh /opt/install.sh -ndu  
Start the online upgrade. 
Step 1: Perform the pre-upgrade check. 
Note: The SSD property of a disk cannot be updated after an online upgrade. Reclaim the disk or restart the host to update the SSD property. 
Note: During the upgrade, the hostd service on ESXi hosts will be restarted and vCenter will be disconnected temporarily. This will affect the services (clone, migration, or snapshot) running on vCenter. 
      To avoid this situation, do not perform any management task during the upgrade, and you will be prompted to check whether there are services running on vCenter during the upgrade. 
      Are there no services running on vCenter? If yes, continue with the upgrade. If no, exit the upgrade. [y,n,?] : y 
Step 2: Update install UltraPath 8.06.002. 
Step 3: Activate UltraPath 8.06.002 online. 
The online upgrade is complete. 
Note: The output of the esxcli software vib list command shows that the UltraPath version is the pre-upgrade one. Run the esxcli upadm show version command to check the version of the current UltraPath.
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VMware stops providing signature authentication for the software packages of ESXi 5.0 and 5.1 operating systems, so the software packages are not authenticated with signatures. Therefore, when the ESXi version is 5.0 or 5.1, the following prompt information will be displayed at the beginning of command output after command execution:
Because VMware stops providing signature authentication for the software package
of the ESXi 5.0/ESXi 5.1 system, the software package is not certified and signed
by VMware. An alarm will be reported in vCenter if an unsigned package is used.
----End
Verification
72. Run the esxcli upadm show version command to check whether the UltraPath version is the latest.
~ # esxcli upadm show version
Software Version   : 21.01.003
Driver   Version   : 21.01.003
73. Run the vmkload_mod -l command to check whether the nxup module has been replaced.
For example, the module before the upgrade is nxup-ext-a:
~ # vmkload_mod -l |grep nxup
nxup-ext-a               32   1420
The module after the upgrade is nxup-ext-b.
~ # vmkload_mod -l |grep nxup
nxup-ext-b               32   1420
Troubleshooting
If faults occur during the upgrade, contact Huawei R&D engineers for troubleshooting.
6.4  Procedure of Upgrading UltraPath for vCenter Plug-In
6.4.1  Upgrading UltraPath for vCenter Plug-In 5.x
Task Description
Run the .exe file of the new version to upgrade UltraPath for vCenter.
Precautions
During the upgrade, the VMware VirtualCenter Management Webservices service must be restarted. When the VMware VirtualCenter Management Webservice service is being restarted, none of the vCenter plug-ins can be used.
Prerequisites
· Confirm that the current version is not the latest.
· Restart the VMware VirtualCenter Management Webservices service.
The vCenter Server version is 5.0, 5.1, 5.5.
Procedure
Step 1 If you have opened vCenter installation directories or the files in the directory, close all vCenter installation directories and files.
Step 2 Double-click the new version of UltraPath for vCenter to start the upgrade.
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Step 3 Remove UltraPath for vCenter.
[image: image221.jpg]C

= Ultra iguratio

Configuration Details

Remove the software from the vCenter.

vCenter IP address: 100.112.19.79
vCenter Web Service port 443
vCenter usernarme: administrator
vCenter password. sssesssses
B
Verification code ‘ rvdn| ‘ -

Remove Close





Step 4 Register UltraPath for vCenter.
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----End
Troubleshooting
Check whether you can log in to UltraPath for vCenter properly and whether the version information is correct.
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6.4.2  Upgrading UltraPath for vCenter Plug-In 6.x
Task Description
Install the new version to upgrade UltraPath for vCenter.
Precautions
· vCenter 6.x:
During the upgrade, If the UltraPath for vCenter is downgrade to an older version,the VMware vSphere Web Client service must be restarted. When the VMware vSphere Web Client service is being restarted, the vCenter can not be used.
· vCenter 6.5:
After the upgrade, the VMware vSphere Web Client service must be restarted. When the VMware vSphere Web Client service is being restarted, the vCenter can not be used.
· For scenarios where platform service controllers (PSCs) are configured externally and manage multiple vCenter servers. For vCenter 6.x, restart VMware vSphere Web Client service after UltraPath for vCenter is upgraded.
Prerequisites
· Confirm that the current version is not the latest.
· Restart the VMware vSphere Web Client service if the UltraPath for vCenter is downgrade to an older version.
· Restart the VMware vSphere Web Client service if the vCenter Server version is 6.5.
· For scenarios where platform service controllers (PSCs) are configured externally and manage multiple vCenter servers. For vCenter 6.x, restart VMware vSphere Web Client service after UltraPath for vCenter is upgraded.
The vCenter Server version is 6.x.
Procedure
Method 1: Uninstalling the old version,then installing the new version of UltraPath for vCenter
Step 1 Uninstalling the old version of UltraPath for vCenter 6.x.
For details about how to Uninstalling UltraPath for vCenter 6.x,
see "3.3.2.2.1 Uninstalling UltraPath for vCenter (for vCenter 6.X deployed on Windows)" or "3.3.2.2.2 Uninstalling UltraPath for vCenter (Applicable to vCenter 6.X on VCSA 6.X)" in OceanStor UltraPath for vSphere 21.3.0 User Guide.
Step 2 Installing the new version of UltraPath for vCenter 6.x.
For details about how to Installing UltraPath for vCenter 6.x,
see "2.4.2 Installing UltraPath for vCenter (for vCenter 6.X)"  in OceanStor UltraPath for vSphere 21.3.0 User Guide.
----End
Method 2: Deregister the old version,upgrade the new version of UltraPath for vCenter,then register the new version of UltraPath for vCenter.
Step 3 Deregister the old version of UltraPath for vCenter 6.x.
For details about how to deregister the UltraPath for vCenter 6.x,
see "3.3.2.2.1 Uninstalling UltraPath for vCenter (for vCenter 6.X deployed on Windows) step 2" or "3.3.2.2.2 Uninstalling UltraPath for vCenter (Applicable to vCenter 6.X on VCSA 6.X) step 2" in OceanStor UltraPath for vSphere 21.3.0 User Guide.
Step 4 Upgrade the new version of UltraPath for vCenter 6.x.
1. for vCenter 6.X deployed on Windows:
(1).Decompress the UltraPath installation package and copy Windows under /VMware_vCenter/Packages/VMware_vSphere_6.X to any directory of the vCenter server.
Log in to the vCenter server.
Open the Windows file folder and double-click the UltraPath-XX.XX.XXX-vCenter6.exe icon. The UltraPath for vCenter upgrade dialog box are displayed.
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(2).Click Yes. The UltraPath for vCenter installation page is displayed.
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(3).Click next to start the upgrade.
The installation is complete, as shown:
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(4).Click Finish.After UltraPath for vCenter is installed, the dialog box for registering UltraPath for vCenter is displayed, as shown
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2.Applicable to vCenter 6.X on VCSA 6.X:
For details about how to upgrade UltraPath for vCenter 6.x,
see "2.4.2.2 Installing UltraPath for vCenter (Applicable to vCenter 6.X on VCSA 6.X)"  in OceanStor UltraPath for vSphere 21.3.0 User Guide.
The only difference lies the following command output after sh install.sh is executed in step 3:
root@vcsa163 [ /VCSA6.x ]# chmod +x install.sh
root@vcsa163 [ /VCSA6.x ]# sh install.sh
[WARNING] An earlier UltraPath version has been detected.
------------begin-----------YES or NO box---------------------------
Do you want to remove it now?
------------end-------------YES or NO box---------------------------
<Y|N>:Y
The UltraPath for vCenter uninstallation starts.
Uninstalling UltraPath for vCenter of an earlier version succeeded.
Preparing...                          ########################################
Updating / installing...
UltraPath-for-vCenter-21.05.30-2        ########################################
UltraPath for vCenter has been successfully installed.Please make sure register the
UltraPath for vCenter plug-in to make the UltraPath for vCenter plug-in effective.
Step 5 Register the new version of UltraPath for vCenter 6.x.
For details about how to register UltraPath for vCenter 6.x,
see "2.4.2.1 Installing UltraPath for vCenter (for vCenter 6.X deployed on Windows) step 8" or "2.4.2.2 Installing UltraPath for vCenter (Applicable to vCenter 6.X on VCSA 6.X) step 4" in OceanStor UltraPath for vSphere 21.3.0 User Guide.
----End
Note:If the UltraPath for vCenter is downgrade to an older version:
Step 6 Uninstalling the old version of UltraPath for vCenter 6.x.
For details about how to Uninstalling UltraPath for vCenter 6.x,
see "3.3.2.2 Uninstalling UltraPath for vCenter (for vCenter 6.X)" in OceanStor UltraPath for vSphere 21.3.0 User Guide.
Restart VMware vSphere Web Client service.
Step 7 Installing the new version of UltraPath for vCenter 6.x.
For details about how to Uninstalling UltraPath for vCenter 6.x,
see "2.4.2 Installing UltraPath for vCenter (for vCenter 6.X)" in OceanStor UltraPath for vSphere 21.3.0 User Guide.
----End
Troubleshooting
Check whether you can log in to UltraPath for vCenter properly and whether the version information is correct.
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6.5  Verifying Upgrade Result
6.5.1  Verification Checklist
Table 6-6 UltraPath for ESXi verification checklist
	No.
	Verification Item
	Criterion
	Command

	1
	Check the version of UltraPath for ESXi.
	The displayed version is the target one.
	Run esxcli upadm show version on the ESXi CLI.

	2
	Query disk devices.
	Disk devices are generated successfully.
	After running the esxcfg-rescan -A and esxcli storage core device list commands, disk devices can be queried successfully.

	3
	Restore UltraPath configurations.
	On the UltraPath Console, restore the work mode and global configuration based on the values recorded before the upgrade.
	On UltraPath Console, verify the work mode and global configuration according to the values recorded before the upgrade.

	4
	Check that services on the server are running properly.
	Ask the customer's engineer to confirm that services are running properly.
	Services on the server are running properly.

	5
	Check the version number of UltraPath for vCenter.
	The displayed version is the target one.
	Click Version Information on the About page.


6.5.2  Verifying UltraPath for ESXi Version Information
Task Description
Make sure that the post-upgrade UltraPath version is consistent with the target version.
Procedure
On the CLI, run the esxcli upadm show version command.
~ # esxcli upadm show version
Software Version   : 21.01.003
Driver   Version   : 21.01.003
Result Verification
Verify that the output version number is consistent with the target version number.
Troubleshooting
If the output version number is inconsistent with the target version number, check whether the UltraPath upgrade package is correct.
6.5.3  Generating Disk Information Normally
Task Description
Check that the UltraPath in use can manage the disks that are mapped to the storage system.
Precautions
All links have been restored and are working properly.
Procedure
Run the following command on the CLI to check disk information:
~ # esxcli storage core device list  
naa.600e0fc1000000504d9df5d000000021  
   Display Name: HUAWEI Fibre Channel Disk (naa.600e0fc1000000504d9df5d000000021)  
   Has Settable Display Name: true  
   Size: 100  
   Device Type: Direct-Access   
   Multipath Plugin: MP_PLUGIN_ULTRAPATH  
   Devfs Path: /vmfs/devices/disks/naa.600e0fc1000000504d9df5d000000021  
   Vendor: HUAWEI    
   Model: S5500             
   Revision: 1     
   SCSI Level: 4  
   Is Pseudo: false  
   Status: on  
   Is RDM Capable: true  
   Is Local: false  
   Is Removable: false  
   Is SSD: false  
   Is Offline: false  
   Is Perennially Reserved: false  
   Queue Full Sample Size: 0  
   Queue Full Threshold: 0  
   Thin Provisioning Status: unknown  
   Attached Filters:   
   VAAI Status: unknown  
   Other UIDs: vml.0200020000600e0fc1000000504d9df5d000000021533535303020  
   Is Local SAS Device: false  
   Is Boot USB Device: false  
   No of outstanding IOs with competing worlds: 32
----End
Verification
Disks are successfully detected by the server. The number of disks is the same with that of the LUNs that are mapped to the storage system, and the disk capacity is consistent with LUN capacity.
Troubleshooting
If the disk quantity is incorrect or the status is abnormal, delete the mappings and add the mappings again.
6.5.4  Verifying UltraPath for vSphere Configuration
Task Description
Verify the UltraPath for vSphere configuration according to the configuration information recorded before the upgrade.
Precautions
UltraPath for vSphere has been installed successfully.
Procedure
Verify the UltraPath for vSphere configuration according to the configuration information recorded before the upgrade.
Verification
Configuration of UltraPath for vSphere is the same as that recorded before the upgrade.
Troubleshooting
If you fail to run UltraPath for vCenter, check whether the UltraPath for vCenter plug-in is installed successfully.
6.5.5  Checking that Services on the Server Are Running Properly
Task Description
Check that all services can run properly after UltraPath for vSphere is upgraded.
Precautions
After the upgrade, you need to restart the system to verify the service functions.
Procedure
74. Perform the same operations before and after the upgrade to check that all services can be processed in the same way.
Verification
All services can be processed properly before and after the upgrade in the same way.
Troubleshooting
None
6.5.6  Verifying UltraPath for vCenter Version Information
Task Description
Make sure that the post-upgrade plug-in version is consistent with the target one.
Procedure
Log in to UltraPath for vCenter and click Version Information on the About page to check the client version number.
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Result Verification
Verify that the output version number is consistent with the target version number.
Troubleshooting
If the post upgrade version number is inconsistent with the target version number, check whether the upgrade package is correct.
6.6  Version Rollback
6.6.1  Uninstalling the New UltraPath
Task Description
If the new version does not work properly, uninstall it before installing the previous version.
Procedure
Step 1 Run the following commands to uninstall UltraPath for ESXi.
esxcli software vib remove -n ultrapath.cli;
esxcli software vib remove -n ultrapath.cim;
esxcli software vib remove -n ultrapath.mpp
After the uninstallation is complete, need to restart the host for install the UltraPath with the early version.
~ # esxcli software vib remove -n ultrapath.cli  
Removal Result  
   Message: The update completed successfully, but the system needs to be rebooted for the changes to be effective.  
   Reboot Required: true  
   VIBs Installed:   
   VIBs Removed: HUAWEI_bootbank_ultrapath.cli_21.01.003-00  
   VIBs Skipped:   
~ # esxcli software vib remove -n ultrapath.cim  
Removal Result  
   Message: The update completed successfully, but the system needs to be rebooted for the changes to be effective.  
   Reboot Required: true  
   VIBs Installed:   
   VIBs Removed: HUAWEI_bootbank_ultrapath.cim_21.01.003-00  
   VIBs Skipped:   
~ # esxcli software vib remove -n ultrapath.mpp  
Removal Result  
   Message: The update completed successfully, but the system needs to be rebooted for the changes to be effective.  
   Reboot Required: true  
   VIBs Installed:   
   VIBs Removed: HUAWEI_bootbank_ultrapath.mpp_21.01.003-00  
   VIBs Skipped:
Step 2 Uninstall the UltraPath for vCenter plug-in.
----End
Result Verification
Run the esxcli software vib list | grep ultrapath command. No UltraPath version information is displayed.
UltraPath for vCenter Plug-In 5.x,Refresh the control panel to see whether UltraPath for vCenter is still there.UltraPath for vCenter Plug-In 6.x,should check the plugin in the vsphere vCenter's plugin manage.
Troubleshooting
If the UltraPath uninstallation is unsuccessful, ask Huawei R&D contact for help.
6.6.2  Installing the Original UltraPath
Task Description
Install the original UltraPath.
Procedure
Based on the User Guide of the original UltraPath, use the rollback packages provided in section 6.2.6 

REF _EN-US_TOPIC_0120429465-chtext \h
Obtaining the Rollback Package "Obtaining the Rollback Package" to install the original UltraPath.
Result Verification
The original UltraPath is installed successfully.
Troubleshooting
If anomalies occur in the rollback process, ask Huawei R&D contact for help.

